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Introduction

What's New

What’s New Since RMMSoft™ version 2.

If you upgraded to this new version of RMMSoft, you might wonder what has changed since
then. What new features does RMMSoft offer?

Many of the changes are due to feedback from customers. At AIL Systems we strive to be
responsive to your ideas and needs so that we can continue to make RMMSoft the premier
Open-Path FTIR software application.

Windows 95/98 Conversion

The main RMMSoft program has been converted to a 32 bit Windows 95/98 application. This
provides the following benefits:

1. Faster execution — If you own a previous version of RMMSoft you will notice a
marked increase in the speed of algorithmic execution. In some cases as much
as 3X faster.

2. Use of standard Windows 95/98 Displays and Controls.

3. File Location Support — Now you can specify default directories for many of the
RMMSoft generated files using a standard Windows File Location dialog.

4. Long Filename support — Filenames are no longer limited to 8 characters. Full
Windows 95/98 long filenames can be used.

Automatic start setup

RMMSoft now provides the ability to setup for automatic start from within the program. Use the
Automatic Start Dialog to specify how to start and the macro file to use.

New Percent Of Trigger Display

The old Percent of Trigger display has been replaced with an improved display. This display is
patterned after a Flow Meter indicator typically found in control rooms. The display indicates
the concentration of a chemical as a percent of its Trigger level against a backdrop of its
Detection (Green), Warning (Yellow) and Trigger (Red) levels. This provides the benefit that
an operator can quickly tell how far into an alarm level a chemical is at a glance.
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Improved Signal Processing

The program has been updated to perform an improved Interferogram alignment routine. This
will provide an improved input signal for processing by the system.

Automated Peak Amplitude Search

An automated FTIR Peak amplitude search capability has been added. This feature provides
an automated capability to find the best azimuth and elevation for pointing the FTIR.

Year 2000 Compliance

The RAM 2000 system including the RMMSoft program has been tested and verified to be fully
Y2K compliant.

Time displays

The program has been modified to display time zone information along with the display of
dates and times. The time zone displayed is normally the time zone associated with the data,
but can be changed using the Time Zone Dialog .

Windows 98 Help

The RMMSoft Help file (this document) has been upgraded to provide full Windows 98 help
capabilities.




Improved Software Licensing

The program has been modified to use a software licensing techniques instead of the hardware
lock (dongle) that was previously required to prevent unauthorized usage. This makes
registration easier and requires less hardware resources to manage.

Weather Data Averaging

The ability to average (summarize) weather data has been added to the Daily, Weekly, Monthly
data summarization tool.

New Chemical Sorting Methods
Three new sorting methods have been added to the program. The new sorting methods are:

1) Percent of Trigger.
2) Alphabetic.
3) Default Order (order by which chemicals are listed in the SPI file).

These methods have been added to all the sortable concentration displays. The capability to
sort by any of the sort methods has also been added to the Concentration Text View.

Improved Display Controls

New controls have been added to the Concentration History Graphic View and the
Concentration Rose view that provide the ability to cycle through the list of chemicals, or a sub-
set of the list of chemicals, with a single button.

Improved File Opening Capabilities

The program now allows multiple files to be open from any of the Open File dialogs (see New
File Options ). This provides a faster method of opening multiple files.

Overview

The RAM 2000 System

The Remote Air Monitor-2000 (RAM 2000) system is a complete Open-Path Fourier Transform
Infrared (FTIR) Spectroscopy system. It consists of a FTIR spectrometer, a Retroreflector, a
computer system, the RMMSoft analysis software, Spectral reference libraries and a Chemical
Database. Optionally, the user may also purchase a Meteorological Station (METS) and a
Positioner attachment, which allows the FTIR to point to multiple retroreflectors.

The RAM 2000 software package (RMMSoft) provides the user with an easy to use Windows
based Graphical User Interface (GUI) for controlling the system. The program allows you to
perform multiple operations simultaneously through the use of the Windows multiple document
Interface. The software provides an integrated File System that maintains all data pertinent to
collected spectra in a set of coordinated files. This allows you to “Play-Back” the data later with
full fidelity.



The RMMSoft program provides the user with a number of different Modes of operation. Each
document opened can be run in a different mode. This provides the user flexibility in the
processing of data, including real-time and non-real-time processing, and execution of the
program through Macros.

Open-Path FTIR Theory

The open-path FTIR system can be likened to a “particle counter” which sums up the total amount
of energy that a target chemical absorbs between the FTIR and the retroreflector. The FTIR itself
can not distinguish where along the beampath the burden of the concentration lies, nor can it
distinguish between a narrow concentrated plume or a broad dilute plume that is contained within
its beampath. This can be resolved by combining meteorological data with the FTIR data. By
properly collecting and interpreting the FTIR data, a broad range of applications can be achieved.

The principle of RAM 2000 operation is energy measurement within selected spectral regions.
The regions are usually expressed as wavenumbers, cm™. A wavenumber is actually defined as
1/wavelength, where wavelength is measured in centimeters. Chemical species will absorb
energy at particular wavelengths. The structure of the chemical determines what wavelength of
energy will be absorbed.

To quantify concentrations of a chemical, two spectra are required. The first spectrum, (the
Background spectrum), is collected in absence of the target chemicals. The second spectrum,
(Data or Signal Spectrum) contains the target chemicals. In FTIR spectroscopy, resultant spectra
are formed by computing an absorbance spectra, which is the inverse log of the background
spectrum (in the form of a Single-Beam spectrum) divided by the signal spectrum (also as in the
form of a Single-Beam spectrum). Patterns in this absorbance spectrum are then compared to a
reference spectrum by using multi-component regression techniques.

Concentrations calculated by the system may be reported as either “path-averaged” or “path-
integrated”. A path-averaged concentration is computed by dividing the measured amount of the
chemical by the path distance. Typically path-averaged concentrations are reported in the units
Parts Per Million (PPM) and Parts Per Billion (PPB). A path integrated concentration does not
average the measured chemical over the pathlength and are typically reported as Parts Per Million
* Meters (PPM*M) or Part Per Billion * Meters (PPB*M).
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FTIR

AIL Systems’ Fourier Transform Infrared (FTIR) Spectrometer is the prime hardware component
of the RAM 2000 system. The FTIR has been ruggedized for 24-hour a day performance in
ordinary ambient conditions, thus doing away with costly HVAC environmental requirements.

AIL Systems’ FTIR is comprised of a IR source, a Detector / Beamsplitter assembly, a Telescope
and a QA gas cell used in Quality Assurance Techniques.

Distributed Control System

A Distributed Control System (DCS) is used for plant process control. A distributed control system
can be described as a control system with distributed processor capacity (nodes). The
communication between different nodes in a distributed control system consists of both data
messages (from gauges etc.), and different kinds of administrative messages. The signals
generated from the nodes can be analog or digital.

The RAM 2000 system has an optional DCS interface capability. The RAM 2000 system DCS
interface can transmit the status of any combination of chemicals, the summary of the highest
chemical alarm threshold exceeded or the overall system status. A total of eight statuses can be
monitored, one per channel. The interface used is an 4 - 20 ma analog signal.



When monitoring a chemical's status on the DCS system, the RAM 2000 system transmits the
analog signal as a function of each monitored chemical’s state; that is, whether the chemical is:
(1) Below Detection Level (BDL), (2) Detected, (3) above the Warning Alarm threshold, or (4)
above the Trigger Alarm threshold. The values assigned to each of these states are as follows:

Below Detection Level - 0.0 ma

Detected - 6.6ma
Above the Warning Alarm threshold - 13.3 ma
Above the Trigger Alarm threshold - 20.0 ma

When monitoring the overall system status, the following states are used:

No Hardware attached or responding - 0.0 ma

All Hardware in Green condition - 6.6 ma
One or more Hardware items in a Yellow condition - 13.3 ma
One or more Hardware items in a Red condition -20.0 ma

Liquid Nitrogen Refill System

The Liquid Nitrogen (LN2) Refill system is a RAM 2000 system option that provides an automated
method for refilling the dewar in the RAM 2000 FTIR unit from an external large capacity supply
dewar. This provides the capability for long term unattended operations.

The LN2 Refill System is fully integrated into the RAM 2000 system. It requires no manual action
on the part of the user for operations besides that of initially commanding the system to use the
LN2 refill system on the Site Setup menu. The RAM 2000 system does provide the capability to
manually command a LN2 refill at any time via the Start Liquid Nitrogen Fill command on the
Control Menu .

Meteorological Station

The RAM 2000 system has an optional Meteorological Station (METS or Weather Station) that
can be used to collect weather data in a time co-incident manner with the collection of Signal data.
This is useful in the generation of Concentration Rose plots or performing plume dispersion
analysis.

The Meteorological Station is fully integrated into the RAM 2000 system and can be control by just
a single user command.

Positioner System

The RAM 2000 has an optional positioner system that provides the capability to point the FTIR at
different retroreflectors over the course of a day. The Positioner system is fully integrated into the
RAM 2000 system and provides the ability to cover more paths of a plant with fewer RAM 2000
systems; Of course this means that there is less coverage time for each path monitored.



Gas Calibration

The RAM 2000 system provides the user with a 15-cm Gas Cell in the beampath to allow the
accurate measurement of a gas at a known concentration. By comparing the known
concentration of the gas being flowed into the gas cell to the value computed by the RMMSoft
program, the user can validate the accuracy of the gases being measured in the atmosphere. The
gas mixture used should be traceable to NIST standards for precise calibration checks.

Gas Calibration is an auxiliary mode of the Collect Data and Process mode. It requires a canister
of a gas at a known concentration to be flowed into the Gas Cell while measurements are being
taken. The calibration gas must be added to the list of selected chemicals in the Signal
Processing dialog prior to entering the Gas Calibration mode. Once this has been accomplished,
the user enters the Gas Calibration mode by selecting the Gas Calibration command on the
Setup menu. The user then must select the calibrating gas(es) and their associated
concentrations.

Calibration Gas Selection m
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Delete

See the RAM 2000 Operators Documentation manual, Section 1, paragraph 6.0 for FTIR / gas
setup and safety requirements prior to performing gas calibration.

Remote Connectivity

The RAM 2000 system provides an option for remote operations of the system via modem and
remote connectivity software. This provides the capability to: Remotely view RAM 2000 system
operations and results; Remotely change the operations of the RAM 2000 system; Download /
Upload files from / to a remote computer.
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The items needed to prepare the RAM 2000 system for remote connectivity are:

1. High speed modem (33.6K or higher).

2. Remotely Possible® remote connectivity software from Computer Associates
International.

3. Independent telephone connection.

Once the remote connectivity equipment has been installed into the RAM 200 system, Remotely
Possible® must be activated and set into the Listen mode. This allows it to answer telephone
calls to the RAM 2000 system and perform the functions requested by the user.

For further information concerning the use of Remotely Possible® or remote connectivity, see the
Remotely Possible® Users Guide.

File System

The RMMSoft program provides a coordinated file system that records all pertinent data
associated with the collection and processing of spectra. This provides the user with complete
traceability of all events occurring at the site being monitored. RMMSoft also provides an
automated file sizing and filename generation capability for all RMMSoft file types. This provides
the ability to limit the magnitude of files to a manageable size when performing long duration
monitoring without starting and stopping the program. The RMMSoft program also automatically
monitors the amount of free disk space on your system and alerts you when the amount of disk
space for storing data becomes too low.

There are three primary files associated with the RMMSoft program. These are Spectrum files,
Processing Results files and the Signal Processing Information files. The data stored in these
files completely describe the conditions under which data was collected, the chemicals being
processed, the collected signal spectra and the computed processing results. In other words, a
complete picture of all conditions and results during a collection.

Spectrum files are used to store Signal Spectrum and Background Spectrum data produced by
the system. The spectra collected by the RAM 2000 system is stored in AlL’s proprietary
RMMSoft file format. This file format stores all data that is pertinent to the collection of the spectra
so as to provide a complete picture of the collected data. Spectra may be saved in one or all of the
following spectral types, Interferogram, Single Beam, Absorbance or Transmittance. The program
provides the capability of saving spectral data in any, all or none of these spectral types during a
collection. The specific types of formats that the spectral data can be saved in are dependent
upon the mode of operation that the system will be used in.

Processing results computed by RMMSoft are stored in a separate Results file (.RLT). This
proprietary file format stores the processing results (summary and detailed) for all chemicals and
for all algorithms enabled. The Results file structure is such that there is a one-to-one record
correlation between itself and the spectral data used as input to the processing. For each record
in the spectral file used in processing, there is an associated Result record in the Results file with
the same Frame number.



Signal Processing set up information, such as the chemicals selected for processing, the spectral
regions used, and algorithms to perform, are stored in a Signal Processing Information file (SPI
File). This file is automatically generated by RMMSoft and is linked to all Results files in which it
was used for later use in the re-processing or playback of data. SPI files can be generated
through the Chemical Setup capability. The RMMSoft program supplies a chemical database that
simplifies the selection of chemicals for processing. The chemical database is an Access
database named chembase2.mdb. The program uses this database during the selection of
chemical for analysis and as interferents.

There are a number of ancillary files that are used by the program. These include Chemical
Averaging files, Log files and Macro files.

RMMSoft provides the capability to average data over time using the program’s Concentration
Averaging feature. You may save this data into an Averaging file for later review or further
processing in a spreadsheet program.

User messages generated by RMMSoft can be automatically stored to a Log file (.LOG) for later
review. The Log file can be enabled / disabled on the Diagnostics Dialog.

Many of the RMMSoft functions can be activated automatically through the use of Macros.
Macros are stored and executed from a Macro File (.(MAC).

Archiving Data

The RMMSoft program, when used as a continuous monitor, can generate a large amount of data
on your hard disk drive. This data takes the form of Interferograms stored in Signal files,
Processing results stored in Results files, concentration averages stored in Averaging files and the
record of program events stored in Log files . These data files are an important asset in
documenting the conditions at your facility for any given day; therefore management of your data
is an important aspect of monitoring your facility.

There are two aspects to managing the data generated from the RMMSoft program. What to save
and When to save it. Both are important issues.

What to save

All files generated by the RMMSoft program are needed to provide effective playback of events
that have occurred. The processing results, stored in the Results file, need the Signal file
generated for effective traceability compliance. Therefore these files need to be kept together at
all times. But the data actually saved on these files can be minimized, based upon your unique
situation.

Typically all signal data and processing results are stored during program operations. If your
situation requires only saving of data when certain activation levels have been exceeded, then
running the RMMSoft program and specifying either Save Data Above Warning Level or Save
Data Above Trigger Level options, provided that each chemical has been given the correct
Warning and Trigger action values, reduces the amount of data stored to hard disk. See File
Saving Options for further details.

When to save

The RMMSoft program, by default, will save all signal data and processing results each into their
own individual files. These files will grow very large if the data being collected has not been
limited by selecting certain File Saving Options (such as Above Warning or Trigger Level).
Extremely large files are hard to archive (especially if they are currently active, since you will need
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to stop the program to archive them), and to restore to the hard disk when needed for later
reference. Therefore it makes sense to limit your files to a manageable size.

This can be accomplished by using the RMMSoft automatic file renaming options. Using this
option, you can specify when the program should close currently active files and begin using new
files (with automatically generated filenames) in their place. In this way files are limited in size and
can be archived when they are no longer in use without interrupting continuous monitoring. You
can specify to automatically change files in the units Seconds, Minutes, Hours, Days or Frames.
See File Saving Options for further details.

Archiving data

Periodically the data saved by the program will have to be archived and removed from the
computer to allow the storage of new data. Typically, based upon how much data is being saved
by the system, this function can be performed weekly or monthly. The RMMSoft program will
indicate when disk space is becoming low (10% or less of the disk size) as an indication that the
archiving of data is required.

To archive RMMSoft data you will need a backup system such as a tape drive, CD ROM writer, or
removable disk cartridge system to store the data. The procedure to archive RMMSoft data is as
follows:

1. Run the backup software program.

2. Select the data files that are to be backed-up onto the backup media. DO NOT select files
that are currently being used by the RMMSoft program.

3. Perform the backup. If the RMMSoft program is running concurrently, expect the backup
program to run slowly. Some degradation in the performance of the RMMSoft program may
also be expected.

4. When the backup has successfully completed, store the data in a controlled manner for future reference.

5. Delete the files that have been backed-up from the computer system.

Definitions

Background Spectrum

A Background spectrum (Background) is a Interferogram that is used as the reference spectrum (
Io ) for Classical Least Squares (CLS) processing. Background spectra can be saved in a
Background File for later use.

Co-Addition
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Co-Addition is the process in which multiple interferograms are added together to form a single
Interferogram. In this process, the resultant interferogram is equal to the sum of all interferograms
divided by the number of interferograms co-added. Specify the number of interferograms to co-
add during a collection on the FTIR Setup dialog.

Document

The RMMSoft program allows you to process multiple files and/or collections simultaneously.
Each file opened or collection started is contained in what is referred to as a document. Data from
each document is wholly contained unto itself. Data or actions from one document will not affect
data or actions performed on another document.

Multiple views (windows) of the data in a document may be displayed at a single time. The
standard views displayed when a document is created depends on the kind of document created:

Document type Default views
Results document* Status, Concentration, Concentration History (graphic) views.
Spectrum document Status and appropriate Spectrum view.

Chemical Setup document Chemical Setup view.

* A Results document is one in which either a Results file is created or used.
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Frame Number

The RMMSoft programs’ method of indicating the position of a data set (spectra, results) in a run
is the Frame. The Frame number is equivalent to the record number in a multiple record file
(multi-file). The Frame number is used by all RMMSoft program commands to advance / rewind
data records and data summation commands.

Another data set indicator is the Scan number. The Scan number will not always be equivalent to
the Frame number. The Scan number represents the spectra’s original position in the data set.

Mainframe

RMMSoft is a standard Windows program that allows for multiple document execution. When the
program is first started, the Mainframe menu, toolbar and view is displayed. From the Mainframe,
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the user creates a document by either running a macro, opening a file for viewing or editing, or
creating a new file for collection and/or processing.

IL Systems Inc. - RMMSoft
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Minimum Detection Limit

The minimum concentration of a chemical that can be detected by an instrument with a given
statistical probability. Usually the detection limit is given as 3 times the standard deviation of the
noise of the system. In this case, the minimum concentration can be detected with a probability of
99.7%.

Interferents

An interferent is a chemical in the environment that has an overlapping spectral region with
another chemical that you wish to analyze for a concentration. These Interferents can cause
erroneous concentration readings for the desired chemical unless they are mathematically
removed from the analysis. This removal is specified in the RMMSoft program via the Signal
Processing dialog.

Reference File

A Reference File is a file that contains an absorbance spectrum of a specific chemical at a known
concentration that is used by the CLS algorithm in the determination of a chemical’s detection and
concentration.

Scan

A scan is a single interferogram collected by the system which is intended to be Co-added to other
scans to form the Interferogram spectrum which will be processed by the RAM 2000 system. A
Scan is collected via a single throw of the FTIRs moving mirror.
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Scan Number

The Scan Number indicates the original position of a spectrum (Interferogram, Single Beam,
Transmittance, or Absorbance spectra) from its’ data set. The Scan number remains constant
regardless of the number of spectra in the file.

For example:

If Frames 15 - 20 of a file are copied into a new spectral file, the Frame numbers would be from 1

through 6, but the Scan numbers would remain 15 - 20. This indicates to the user whether the
spectra being viewed is from a larger data set or is a part of a complete data set.

Signal Spectrum

A Signal spectrum is spectral data used as input to RMMSoft program for analysis. It can be
either as an Interferogram, Single Beam or an Absorbance spectrum. A Signal Spectrum collected
from the FTIR is always in the form of an Interferogram but can be saved as either a Single-Beam,
Absorbance, Transmittance, or as an Interferogram. Signal spectra are stored in Signal files.

Modes Of Operation

Analysis Modes

There are two Analysis modes available to the user. One is an on-line processing mode and the
other is an off-line processing mode. The latter mode involves the processing of spectra or results
from data files previously created. The modes are:

Collect Data and Process

Process from File Mode
The Collect Data and Process mode is the standard on-line processing mode of the system. It
allows you to see processing results in real time.
The Process from File mode is an off-line mode that provides the capability to reprocess a signal
spectrum stored in a file. This provides the capability to reprocess signal spectra for additional
chemicals that may not have been previously selected for processing.
The results of an analysis can be “played back” by opening a Results File by opening a document.

This provides the capability to review previously processed results from file. This is especially
useful when quick verification of chemical concentrations' values for specific dates is needed.

Playback Mode
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The Playback mode provides the user with a means of reviewing spectra or processing results of
previously collected and/or processed data. The Playback Mode is entered via one of two
methods.

One method is Opening a Document for an existing Results file or spectral file. You do this by
using the Open command on the File menu and selecting the file of choice.

The second method of entering the Playback mode is by pressing the END button on the toolbar
when you have completed collecting or processing data in one of the program’s Collection or
Processing modes. Pressing the END button will cause the program to exit its current mode of
operation and to enter the Playback mode.

When in the playback mode, the program will display the views that are appropriate to the file
being processed. If you open a Results file, the program will display the standard document views
(the Status view, the Concentration view and the Concentration Vs Time view ) for the first frame
of the data in the Results file. If a spectral file is opened, then the Status view and the appropriate
spectral view (Absorbance, Interferogram, Single Beam, Transmittance) will be displayed.

You can control the frame being displayed via a number of commands available on the Control
and View menus, and on the toolbar. These controls are:

Go
Continuously step through the data until stopped by the user or until the last frame of data is
reached.

Step Forward
Step forward to the next sequential frame of data.

Step Backward
Step backward to the previous frame of data.

Fast Forward
Rapidly step forward until stopped by the user or until the last frame of the data is reached.

Rewind
Rapidly step backward until stopped by the user or until the first frame of the data is
reached.

Frame
Jump to a specific frame number (located on the View menu).

Stop
Stop the current action.

Process from File mode

The Process from File mode is the similar to the Collect Data and Process mode with the
exception that the data source for the spectra to be processed is from a RMMSoft formatted file
or SPC file instead of the FTIR. You can select saving the input spectra into another spectral
format in this mode of operation. The input spectra can be converted and saved to the following
spectral formats: Single Beam, Absorbance or Transmittance depending upon the type of spectra
used as input. For each spectral format selected, the program will save the associated data into a
separate spectral file. You may also choose to enable or disable the saving of processing results
into a Results file. All File Saving Options are available in this mode of operation.
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Because RMMSoft is processing data from a previously collected set of spectra, you will not need
to perform FTIR Setup or Site Setup since these parameters have been stored in the spectral
Signal file (if the RMMSoft file format had been used for spectral data storage). This feature
provides complete traceability between the processing results and the time and place at which the
data was collected, (instead of when it was processed).

Remote Viewer mode

The RMMSoft™ program provides a Remote Viewer mode capability that allows remotely viewing
of data from any RAM 2000 system connected onto a network from any other PC connected to the
same network. When a user starts a copy of the RMMSoft™ program in Remote Viewer mode
that program can view any and all data from the remote system.

When running in the Remote Viewer mode the local PC is effectively viewing a copy of the remote
PC’s data in the Playback Mode . This means that the local PC can step to any frame of data and
perform any other operations available normally in Playback mode.

Multiple RAM 2000 systems can be monitored from a local PC running in the Viewer mode. This is
accomplished by opening the Remote Access Definition File for each remote RAM 2000 system to
be monitored. When monitoring multiple RAM 2000 systems, an additional toolbar (Remote
Hardware State) will be displayed. This tool bar displays the network node name, and the
hardware status for each remotely monitored system. Pressing the button for one of the remotely
monitored systems will cause the RMMSoft™ program to update the Status bar hardware
indicators and the Liquid Nitrogen Controller and Positioner pop-up windows with the current data
for the selected system.

Alignment Mode

The FTIR - Retroreflector Alignment Mode allows you to maximize ( “peak-up” ) the signal being
returned from the retroreflector. Peaking-up the signal provides the system with the most
sensitivity by improving the systems Signal To Noise (SNR) ratio.

FTIR - Retroreflector Alignment (Alignment mode) can be run either from the Run menu item on
the Mainframe menu, or from any Document which has been opened in a Collection mode (by the
New commands from the File menu). The processing capabilities are different based upon how
the Alignment mode has been activated.

Run Menu ltem Execution

When activated from the Run menu item, a collection will be started in Alignment mode. The
program will automatically configure the RAM 2000 system to collect data at 4 cm™ wavenumber
resolution. The steps to start the Alignment mode operation are as follows:

1) Start the RMMSoft program.
2) From the Run menu on the Mainframe menu bar select Alignment. The program will display
the Status View , the Single Beam and Interferogram spectrum views and the Alignment View

. There is no capability to modify the FTIR Setup or Site Setup data. Collection of data
begins automatically.
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3) When you have completed aligning the system, terminate the collection by depressing the
Stop button. No data will be saved to file when executed from the redefined macro.

Execution in a Collection mode

You can run the RMMSoft program in Alignment mode in either the Collect Data and Process or
Collect Data without Processing modes. You should note that it is not recommended that the
Alignment mode be executed from the Collect Data and Process mode since no normal RMMSoft
data validity checks are performed on the incoming Interferograms and therefore the
concentrations computed may be erroneous. The steps to perform the Alignment mode in a
Collection mode of operation are as follows:

1) Start the RMMSoft program.

2) From the File menu on the Mainframe menu bar select New.

3) Select the mode of operation for collection. See the topic Collecting Signal Data for more
information on selection of a Collection mode and the steps to activate the program in those

modes.

4) Perform Site Setup and FTIR Setup processing. When in the FTIR Setup dialog, you will
need to set the FTIR mode to “Alignment mode” instead of “Normal”.

5) Begin data collection by pressing the Go button on the toolbar.
6) When you have completed aligning the system, terminate the collection by depressing the

Stop button.

Alignment mode performance

When started via the Go button, the program will collect data from the FTIR continually until the
Stop button is pressed. Interferograms collected in the Alignment mode do not undergo the
normal RMMSoft data validity checks nor are ZPD aligned.

W hile collecting Interferograms, maximize the power level of the returned signal by adjusting the
pointing angle of the FTIR. The RMMSoft program aids you in this activity with a unique set of
displays. These include a display of the ZPD power level, the percent of A/D full scale and the
percent of full-scale power level of three bands of the Single-Beam response. The ZPD power
and Percent of full-scale displays also provide the user with a display of both the current received
signal strength and the maximum value that has been detected over the run.
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When you have maximized the returned signal energy, you should set the position locks on the
FTIR. This will allow the system to obtain data with the maximum Signal to Noise Ratio (SNR). If
your system was purchased with a Positioner system, the position of the FTIR (Elevation and
Bearing) should be recorded from the Positioner control panel for later use on the Site Setup for
that retroreflector.

Spectral Types

Absorbance
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An Absorbance spectrum is the negative logarithm of the ratio of the sample ( Single-Beam )
spectrum to a reference spectrum. The mathematical relationship is expressed by the equation:

A() =—log, (10 / I,(M)

Where:

I(v) is the sample spectrum as a function of frequency (V).

I,(v).

is the background or reference spectrum.

Interferogram

An Interferogram is a time-domain waveform produced by the optical path difference of the
Michelson-type Fourier Transform Infrared (FTIR) interferometer that normally consists of a
moving mirror, a fixed mirror, a beamsplitter, and a detector. Interferograms can be Co-Added to
increase the Signal-to-Noise Ratio (SNR) of the signal. Care should be taken not to over Co-add
Interferograms since they may average out any short term signals.

A Interferogram can be either single sided or double sided. A double-sided interferogram has a
complete spectrum on both sides of the center burst. A single sided interferogram has data only
on one side of the center burst. The RAM 2000 system produces single sided interferograms. The
point at which the interferogram has the largest absolute value is called the Zero Path Difference
(ZPD) point. This is the point at which the path lengths for the fixed and moving mirrors are the
same. The Center Burst is the area around the ZPD point.

Interferograms that are obtained through the FTIR are subject to a number of data validity checks
by the RMMSoft program. The program automatically discards interferograms that do not pass
the data validity checks. Discarded Interferograms can be saved into Discard files for your review.

The program then aligns Interferograms that have passed the validity checks. The interferogram
is aligned so that the ZPD point is positioned to location 257. This alignment allows the program
to Co-add interferograms non-destructively.
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Single Beam

A Single Beam spectrum is the Fourier transform of the interferogram. Phase correction is
commonly applied to the interferogram as part of the Fourier transform process. The type of
phase correction applied can be selected on the Signal Processing dialog on the Setup menu.

Transmittance

An transmittance spectrum is the ratio of the sample ( Single-Beam ) spectrum to a reference
spectrum. The mathematical relationship is expressed by the equation:

T(v) =(1(v)/ 15(v))*100

Where:

Iv) is the sample spectrum as a function of frequency (V).

I[,(v).

is the background or reference spectrum.

Files

Automatic File Naming / Generation

The program provides a Automatic File naming / Generation capability that will:
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This capability allows the user to control the size and/or scope of the files generated by the

program to a manageable size.

This capability is enabled on the New File Options dialog when creating a new Document.
affects all files being generated by the program except for the Log file . The automatic file name

Allowing the program to generate all flenames automatically.
2. Limit the size of files based on a specified condition (time, or number of frames ).

3. Automatically generates new files when the previous ones are closed. This occurs when the
current files exceed their specified size.

processing in the RMMSoft program builds a filename in the form:

MMDDXNNT.EXT

Where: MM - is the 2 digit Month.
DD - is the 2-digit day of the month.
X - is a one-digit user selectable letter.
NN - Is a 2-digit sequence number.
T - Is the spectral type designator
.EXT - is the filename extension.
Where T=
A - Absorbance
F - Final Single Beam Background
I - Interferogram
S - Single Beam
T - Transmittance
Where .EXT =
.DAT - A Spectralfile.
.BGD - A Background spectrum file.
.RLT - A Results File
.SPC - A SPC formatted Spectral file.

For each document that you will create you will need to provide a different custom letter for
the filename to prevent the program from over-writing data from one document to another.

Typically this designator is used to specify the beampath.

For Example:

If your system has a Positioner system that points to two retroreflectors,
you would need to create two documents (via the New command on the
File menu). You would provide the letter “A” in the first document for the
selectable filename letter and “B” in the second document for the second

selectable filename letter.

Averaging File
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The RMMSoft program has the capability to average the concentration data computed by the
system. The program can perform two different averages for all chemicals simultaneously (e.g.,
15 minute and 24 hour averaging). For each averaging being performed, you can save the results
of the averaging to an Averaging file.

The Averaging file is an ASCIl text file that can be imported in any word processing or
spreadsheet program. Averaging files have a filename extension of .AVG. The size and name of
the Averaging file can be selected automatically using the Automatic Naming / Generation option
(see New File Options for further details).

Background Files

A Background file contains either an interferogram or Single Beam spectra that is used as the
reference spectrum (Io) for Classical Least Squares (CLS) processing. Typically this is a
RMMSoft formatted file (that has a filename extension of .BGD or .DAT ), but can also be a SPC
formatted file. If multiple interferograms are stored in the background file, the program uses only
the first one.

When running with both Automatic Filenaming and Adaptive Background Filtering enabled, the
last Single Beam spectrum used prior to the current file set being closed is saved to a separate
file. This simplifies the process of re-processing the data at a later date. The filename of this
background file has the format:

mmddxnnt.dat

Where:

mm - 2 digit Month.
dd - 2 digit Day.

X - User specified beampath designator.
nn - File sequence number

t - Spectral type designator
.dat - File extension

Where t = i - Background single beam

‘" - Final background single beam

Discard files

The RMMSoft program performs various validity checks on all Interferograms that are obtained
from the FTIR. The program automatically discards Interferograms that do not pass the data
validity checks. Interferograms rejected for processing by the program can be saved into
individual Discard Files for later review. You can enable / disable storage of discard files on the
Diagnostics Dialog (available via the Options — Diagnostics menu item). Discard files are
stored in the directory specified on the File Locations Dialog. A Discard file has the following
naming convention:

dxxxxxxx.dat
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Where:

d - Discard file
XXXXXXX - Discard file number starting at 0.
.dat - File extension.

The program also generates a Discard Reason file that describes the reasons for rejecting the
interferogram for processing.

Discard Reason Files

The program generates a Discard Reason file when it discards interferograms that do not meet
acceptance criteria. The Discard Reason file describes the reason for rejecting an individual
interferogram. There is a single Discard Reason file for all interferograms rejected on a single
day. It is an ASCII text file that can be read by most word processing programs. The Discard
Reason file has the following naming convention:

drsnmmdd.txt

Where:
drsn - Discard Reason file
mm - The two digit month
dd - The two digit day
Axt - Text file extension

File Saving Options

RMMSoft provides the capability to specify the conditions for saving spectral and processing
results data to file. The user can specify to save:

All Data and Results
Every frame of collected spectra along with each spectrums processing results are saved
to a Signal file and a Results file.

Above Warning Alarm

Only those frames of collected spectra, along with its associated processing results, that
are above a user specified Warning alarm level are saved to a Signal file and a Results
file.

Above Trigger Alarm

Only those frames of collected spectra, along with its associated processing results, that
are above a user specified Trigger Alarm level are saved to a Signal file and a Results
file.

None
No spectral or processing results are saved to file.

The Warning Alarm and Trigger Alarm can be specified individually for each chemical on the
Chemical Setup For Concentration dialog.
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You can also specify that the program automatically generate the filenames for spectral and
processing results files and specify the criteria used to determine when they are regenerated.
This can be done by selecting the Enable automatic file naming option on the New File Options
dialog. The program will then request the conditions for which the file sizes should be limited; by
either time or file size. When the limiting condition is met the program will close the currently
active files and create new files to use. You can cause file changes to be synchronized to a
specific time by specifying the time on the dialog. For example, to specify that files are to be
changed every 24 hours at 7:00 AM, specify file changes every 24 hours, enable file change
synchronization and set the synchronization time to 07:00.

Log file

The Log file records the events that occur in the program. There is one Log file for the program
regardless of the number of documents that are currently open. You can enable / disable usage
of the Log file on the Diagnostics Dialog (available via the Options — Diagnostics menu item).
When activated, all messages that are displayed on the Status Bar are saved to the Log file along
with the time of occurrence. The Log file name is automatically generated by the program. If you
have selected the automatic file sizing / file renaming option on the New File dialog, a new Log file
will be created at the periodicity of the fastest changing document. Log files are stored in the
directory specified on the File Locations Dialog. The Log file flenames are of the form:

rmmxxxxx.log

where:
rmm - RMM Log file.
XXxxX - Sequential numbers starting from 00001.
.log - File extension.

Results File

The Results file is a RMMSoft proprietary file format used to store the results of processing
spectra. This proprietary file format stores the processing results (summary and detailed) for all
chemicals and for all algorithms enabled along with the chemical setup information used for
processing (if applicable).

The Results file is structured similarly to the Signal file in that there is a Global Header block,
followed by a Frame Header and the computed results. There is a one-to-one correspondence
between a Results file frame and its’ corresponding Signal file frame. This provides the user with
complete traceability from the input spectrum to the output results. The file extension used for a
Results file is .RLT

Each Results file frame contains both summary and detailed analysis results for all algorithms
performed. This data is stored on a frame by frame basis. The different segments of the
summary and detailed analysis results are:

Arbitrated Results
CLS Average Results
CLS Region Results
Emission Rate Results
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NEA Noise Results

The Arbitrated Results is the final summary value that is presented to the user. It is called the
Arbitrated Results because this final answer is computed via an arbitration algorithm from all
enabled algorithms that calculate chemical concentrations. There is only one Arbitrated Results
answer (composed of a chemical's concentration, Standard Deviation and Minimum Detection
Limit) for each chemical.

The CLS Average Results is the statistical mean values of all of a chemical’'s spectral region
analysis results. If the CLS algorithm is the only algorithm enabled that calculates chemical
concentrations, then the CLS Average Results and the Arbitrated Results values will be the same.
There is only one CLS Average answer (composed of a chemical's concentration, Standard
Deviation and Minimum Detection Limit) for each chemical.

The CLS Region Results are the results of a chemical CLS processing in each of its individual
regions where it is being processed. Each region will have a separate concentration value as
computed by the CLS algorithm.

The Emission Rate Results segment stores the results of Emission Rate analysis on a per
chemical basis.

The NEA Noise Results segment stores the results of the NEA noise analysis for each frame.

The Results file can be opened at a later time to replay the previously computed processing
results without recomputing the results. This is accomplished by opening a Results file document.
The Results file can be exported to an ASCII file for import into Microsoft Excel™ or other
spreadsheet program for further analysis and summation. See Convert Results To Delimited
ASCII Text for further details.

RMMSoft file format

The RMMSoft file format is used when storing spectral data to file. It is based upon the Interactive
Data Analysis (IDA) file format that was developed by the Army’s ERDEC laboratory as a common
format for storing interferograms. This file format consists of a single Global header record
followed by sets of Scan Header and associated Spectral data records. There will be one Scan
Header and Spectral data record for each frame of data stored.

The Global Header contains information that applies to all data records in the file, such as the site
of the data collection, the format and type of the data (Interferogram, Single Beam, Absorbance,
or Transmittance) recorded in the file and sensor information.

The Scan Header contains data that relates specifically to the Spectral data record that follows.
Information in the Scan Header includes weather data associated with the time the spectrum was
collected, and other information describing the spectrum.

The Spectral data record contains the spectrum collected. It may be of type: Interferogram, Single
Beam, Absorbance or Transmittance, as defined in the Global Header. If interferograms have

been selected by the user to be saved, and the user has also selected to Co-Add interferograms,
the Spectral data record will contain the co-added interferogram.

Remote Access Definition File
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The Remote Access Definition (*.rad) file is used to specify the currently active files used by the
RAM 2000 system. The file is automatically generated by the program running in the computer for
the RAM 2000 system. The file will be located in the directory specified for RAD files in the File
Locations Dialog .

The file is used when starting a copy of the program in the Remote Viewing Mode. When starting
the RMMSoft™ program in this mode, the user must specify the RAD file for the RAM 2000
system they wish to view data.

Signal Files

Signal Files contain the spectra to be analyzed by the RMMSoft program. Spectral data stored in
a Signal file can be in an Interferogram, Single Beam, Absorbance or Transmittance spectral
format. The Signal File can be either a RMMSoft or a SPC formatted file.

Signal files saved by the RMMSoft program follow the following naming convention when
automatic file naming is enabled:

mmddxnnt.dat

Where:
mm - 2 digit Month.
dd - 2 digit Day.
X - User specified beampath designator.
nn - File sequence number

t - Spectral type designator
.dat - File extension

Wheret= ‘a’ - Absorbance
i - Interferogram
‘s’ - Signal single beam
‘t - Transmittance

SPC

The RMMSoft program supports three versions of Galactic’'s SPC file format. The SPC file format
allows the storage of Interferograms, Single-Beam, Absorbance, Transmittance, or Arbitrary
spectra. RMMSoft supports the following SPC formats:

Lab Calc formatted files.
Grams formatted files.
Macintosh Grams formatted files.

SPI File

Signal Processing Information (.SPI) files are used to store information about the chemicals and
algorithms selected for processing. These files are generated automatically by RMMSoft and are
linked to the Results file to which they were used. SPI files are generated by either the Analysis
Setup Dialog or the Chemical Setup Document Editor.

26



Analysis Setup Dialog

When you have created a document in either the Collect Data and Process or the Process Data
from File modes, you need to supply signal processing configuration data to the program. This is
accomplished via the Analysis Setup dialog. The Analysis Setup dialog provides the interface for
selecting the algorithms, chemicals and processing resolutions required to perform an analysis.
After completing data entry on this dialog, you would press the OK button. The RMMSoft program
will then verify the setup information provided and request that you provide a filename for the SPI
file in which your data will be stored.

Chemical Setup Document Editor

The second method is to create a document to build a SPI file by selecting the Chemical Setup
option from the New command on the File menu. This will cause the program to build an empty
SPI file. Then select the Signal Processing Information command on the Edit menu. This will
bring up the Analysis Setup dialog. You can now enter the chemicals for the CLS algorithm to
analyze. After you press the OK button the program will verify the setup information provided and
update the Chemical Setup display. Save the changes to the SPI file using the File —» Save menu
item or when prompted as the file is being closed.

Weight File

A Weight File contains the processing information necessary to perform ASP processing on a
specific chemical. A Weight file contains the starting and ending wavenumbers for the spectral
region that will be interrogated and the “weights” to be applied to the neural network to perform
chemical detection.

Installation

Installation Overview

Installation of the RAM 200 system involves the installing, positioning and aligning the RAM 2000
hardware and loading of the RMMSoft program into the RAM 2000 computer.

For Information on the installation of the RAM 2000 hardware, see the RAM 2000 Installation
Manual.

Installing the RMMSoft program is a simple process. RMMSoft comes on a self-extracting
CD_ROM. Insert the CD-ROM and follow the prompts on the screen.

To Install RMMSoft:

1. Insert the CD-ROM

2. If Autorun capability is not present then:
2.1 From the Windows Start Bar, Click RUN.
2.2 Select the CD-ROM drive.

2.3 Select the program Setup.exe.
2.4 Click OK
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Follow the prompts on the Screen.

Installed Components

The installation program will install RMMSoft program components on a computer's drive. The
default directory structure for program installation is:

drive:\Program Files\AIL Systems\RMMSoft\...

The user may select to install the program into any directory structure they choose. The programs
copied during the installation process include:

RMMSoft.exe - Main Ram 2000 program.
mid_driv.dll - FTIR driver.

pstnrsvr.exe - Positioner server program.
ddecint.exe - Alarm processor.

wthrsrvr.exe - Weather station server program.
In2srvr.exe - Ln2 refill system server program.
RMMSoft.hlp - Help file.

RMMSoft.cnt - Help contents file.

readme.txt - List of latest changes to the program.
chembase.mdb - Chemical database version 1.
chembase2.mdb - Chemical database version 2.
nn.mdb - Neural network chemical database.
DcsSrver.exe - DCS system server program.
linx2drv.dll - DCS driver.

stitmem .dll - DCS driver.

slinx.dll - DCS driver.

stidrv.dll - DCS driver.

Lsapiw32.dll - License server program.

Chemical reference files are stored in the directory structure: drive:\<installation
directory>reffile\halfwave

The installation adds a folder titted RMMSoft to the Windows Start menu. Execute the program by

clicking on the Windows Start button, then navigate to Programs —» RMMSoft and click on
RMMSoft (in the RMMSoft folder).

Using RMMSoft

System Alignment

The RAM 2000 FTIR must be aligned to the retroreflector in order to maximize the signal return.
A maximized signal return translates to increased system sensitivity and increased path length
performance. The RAM 2000 system should be aligned during the installation process and re-
calibrated periodically. The methodology used for alignment depends on the configuration of your
system (fixed site system or with a FTIR Positioner system).

Fixed Site Alignment
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Once the FTIR and Retroreflector have been installed at their appropriate positions, perform the
following steps:

1. Loosen the FTIRs tripod horizontal and vertical position locks so that the FTIR can be
repositioned on the tripod.

2. Using the FTIRs telescopic gunsight, manually turn the FTIR until the upper left corner of the
retroreflector is in the center of the gunsight.

3. Start the RMMSoft program in the Alignment Mode. Observe the Percent Full-scale, the ZPD
Power and the three Single-Beam response indicators.

4. Change the pointing angle of the FTIR slightly. Observe the effects of the movement on the
alignment indicators.

5. Repeat step 4 until the maximum power levels have been obtained.

6. Tightly lock the Vertical and Horizontal position locks to lock-in the FTIR pointing angle.

Alignment using the Positioner system

Once the FTIR and Retroreflector have been installed at their appropriate positions, there are then
two methods to align the system when your system has a Positioner system. One is an automated
method and the other is a manual method. The automated method involves using the FTIR Peak
Amplitude Search capability. For the manual method, perform the following steps:

1. Enable the Positioner system to be in the Local mode by depressing the Local / Remote
button on the Positioner system control console and ensuring the Local light is lit.

2. Using the Positioner system Location Control joystick change the pointing angle of the FTIR
until the gunsight crosshairs are in the top left corner of the retroreflector.

3. Start the RMMSoft program in the Alignment Mode . Observe the Percent Full-scale, the ZPD
Power and the three Single-Beam response indicators.

4. Change the pointing angle of the FTIR slightly using the Location Control joystick. Observe
the effects of the movement on the alignment indicators.

5. Repeat step 4 until the maximum power levels have been obtained.

6. Record the Elevation and Bearing values from the Positioner system console. These will be
needed later on the Site Setup dialog in order to move the FTIR from one retroreflector to another.

7. Repeat steps 2 - 6 for each retroreflector that this FTIR will point to.

8. Set the Positioner system into the Remote mode by depressing the Local / Remote button on
the Positioner system control console.

Collecting a Background
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A background spectrum is an Interferogram that will be used as the reference spectrum (Io ) for
Classical Least Squares (CLS) processing. In order to properly detect and quantify chemicals
present in the atmosphere, the background spectrum must be devoid of all traces of the target
chemicals. For each retroreflector used, a separate background spectrum is required.

There are several methods for obtaining a “clean” spectrum to use as the background, these
include:

1) The Upwind Background,
2) The Cross-path Background,
3) The Zero target gas Background
The steps necessary to perform the collection of the Background by the RMMSoft program are the
same regardless of the methodology used.
Collecting a Background
1. From the File menu select New.
2. Select New Background File from the New File Options dialog.
3. Select the All Data And Results option on the New File Options dialog.
4. Press the OK button.
5. Provide a path and filename for the output file on the Background File dialog.
6. Press the OK button. The Status and Signal Interferogram windows are displayed.
7. Perform FTIR Setup and Site Setup from the Setup menu, entering the appropriate data.

8. Press the Go or Step button to collect the background interferogram.

9. Close the document by selecting the Close command from the File menu.

Collecting Signal Data

Signal data are spectra that you wish to analyze for chemical detection and quantification.

The spectra can be processed concurrently with the acquisition of the interferograms (Collect
Data and Process mode) or stored for later non-real time processing Collect Data without
Processing mode).

Spectra may be saved in one or all of the following spectral types: Interferograms, Single Beam,
Absorbance or Transmittance during collection. Saving spectra in any other type than an
Interferogram is not allowed in the Collect Data without Processing mode. The processing steps
to acquire the signal data are similar regardless of the analysis method selected.

Collecting Signal Data with concurrent processing

1. From the File menu select New.

2. Select Collect Data and Process from the New File Options dialog.
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3. Select a Data Save option. If file size limiting and automatic file naming is desired, select the
Enable automatic file naming option from the New File Options dialog. (See File Saving
Options and New File Options dialog for details).

4. Select the format(s) the Spectral data will be saved in.

5. Press the OK button.

6. |If data is to be saved to file, and automatic file naming option was selected, provide the Drive
and Directory to store the data in on the Automatic File Directory dialog; Otherwise provide
a path and filename for the Results File on the Results File dialog.

7. Press the OK button.

8. If automatic file naming option was not selected, provide a path and filename for the Signal file
on the Interferogram Collection File dialog.

9. Press the OK button. The Standard system windows (Status, Concentrations and
Concentration History Graphic) are displayed.

10. Perform the required setup processing from the Setup menu. See Configuring the System for
further details.

11. Press the Go button to begin collection of interferograms, (or the Step button if you wish to
perform single step collections).

12. If you have not specified a Stop condition during FTIR setup, depress the Stop button on the
toolbar to terminate collection when you have collect a sufficient number of interferograms.

13. Close the document by selecting the Close command from the File menu.

Collecting Signal Data without processing

1. From the File menu select New.

2. Select Collect Data without Processing from the New File Options dialog.

3. Select a Data Save option. If file size limiting and automatic file naming is desired, select the
Enable automatic file naming option from the New File Options dialog. (See File Saving
Options and New File Options dialog for details).

4. Press the OK button.

5. If data is to be saved to file, and automatic file naming option was selected, provide the Drive
and Directory to store the data in on the Automatic File Directory dialog; Otherwise provide
a path and filename for Signal file on the Interferogram Collection File dialog.

6. Press the OK button. The Standard system windows, (Status and Signal Interferogram), are displayed.

7. Perform the required setup processing from the Setup menu. See Configuring the System for
further details.

8. Press the Go button to begin collection of interferograms, (or the Step button if you wish to
perform single step collections).
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9. |If you have not specified a Stop condition during FTIR setup, depress the Stop button on the
toolbar to terminate collection when you have collect a sufficient number of interferograms.

10. Close the document by selecting the Close command from the File menu.

Quality Assurance Techniques

It is necessary to periodically perform quality assurance processing in order to ensure that your
RAM 2000 system is performing correctly and supplying accurate data. The RMMSoft program
provides two methods of determining the quality of the data being calculated by the system. One
is to perform the Noise Equivalent Absorption (NEA) measurement. The other is to perform a
concentration calibration using a calibration gas.

NEA Noise Measurement

The Noise Equivalent Absorbance (NEA) Noise Measurement measures the amount of system
noise that is present in three quiescent areas of the infrared spectrum and automatically evaluates
the performance of the system. This test evaluates how well the FTIR of the RAM 2000 system is
performing.

The NEA Noise Measurement can be run either from a pre-defined Macro , which can be
activated from the Run menu item on the Mainframe menu, or from any Document which has
been opened in the Collect Data and Process or Process from File modes by the New
commands from the File menu. The processing capabilities are different based upon how the
Alignment mode has been activated. See NEA Noise Measurement for details

Gas Calibration

The Gas Calibration test provides with a means of evaluating the concentration accuracy of the
RAM 2000 system. This test involves introducing a gas flowed into the systems 15cm gas cell at
a known concentration. This test can only be performed in the Collect Data and Process mode.
Gas Calibration Setup

See the RAM 2000 Operators Documentation manual, Section 1, paragraph 6.0 for FTIR / gas
setup and safety requirements prior to performing the following steps.

1. From the File menu select New.

2. Select Collect Data and Process from the New File Options dialog.

3. Select a Data Save option. If file size limiting and automatic file naming is desired, select the
Enable automatic file naming option from the New File Options dialog.

4. Press the OK button.

5. If data is to be saved to file, and automatic file naming option was selected, provide the Drive
and Directory to store the data in on the Automatic File Directory dialog; Otherwise provide
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10.

11.

12.

13.

14.

15.

16.

17.

a path and filename for the Results File on the Results File dialog.
Press the OK button.

If automatic file naming option was not selected, provide a path and filename for the Signal file
on the Interferogram Collection File dialog.

Press the OK button. The Standard system windows, (the Status, Concentration and
Concentration Vs Time windows), are displayed.

Perform the required setup processing from the Setup menu. See Configuring the System for
further details.

Select the Gas Calibration item from the Setup menu.

Select the name of the gas that is to be flowed through the gas cell from the dialog along with
its concentration. See Gas Calibration Dialog for further details.

Flow the gas into the gas cell at the rate input on the Gas Calibration dialog.

Press the Go button to begin collection of signal interferograms, (or the Step button if you
wish to perform single step collections).

Bring up either the Concentration Text view or the Concentration graphic view.
Find the name of the calibrating gas and record the concentration computed. Verify that the
concentration computed by the system should be within 10% of actual; if not system

maintenance may be required.

If you have not specified a Stop condition during FTIR setup, depress the Stop button on the
toolbar to terminate collection when you have collected a sufficient number of interferograms.

Close the document by selecting the Close command from the File menu.

Modes

Modes of Operation

Any document opened by the RMMSoft program can be executed in one of three modes of
operation. These are:

Collection Modes
Analysis Modes

System Verification

These modes provide the capability to process live data from the FTIR or stored data from
spectral Signal files.
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The RMMSoft program also provides the capability to view any Results File, Signal File, or Signal
Processing Information File. See Opening a Document for further information.

The RMMSoft program also has a number of off-line Tools available to aid the user in creating
spectra, creating or editing Signal Processing Information (.SPI) files, and converting files to other
formats.

Analysis Modes

Collection Modes

Collection Modes

There are three Collection modes available to the user. These modes involve the real-time
collection of spectral data from the FTIR. One mode includes the real-time processing of this
data. The modes are:

Collect New Background

Collect Data without Processing

Collect Data and Process

These modes can be entered when the user selects New from the File Menu. When selected, the
New File Options dialog box appears.
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When the user selects one of these modes of operation, RMMSoft will highlight the available File
Saving Options for that mode selected. The program will then ask the user to specify the names
of the files to save the spectral (Interferogram) data, and if applicable, the processing results.

Collect Data and Process

The Collect Data and Process mode is used when real time data collection and processing of
results are desired. When you select this mode, RMMSoft will create a new document in which to
encapsulate all data related to this collection. Spectra collected in this mode of operation can be
saved in any or all of the following spectral formats: Interferogram, Single Beam, Absorbance or
Transmittance. For each spectral format selected, the program will save the associated data into
a separate spectral file. You may also choose to enable or disable the saving of processing
results into a Results file. All File Saving Options are available in this mode of operation.

When this mode is selected, the program requires filenames for storing the collected
interferograms and computed processing results. The collected interferograms are stored into a
Signal file (.DAT). The processing results are stored in a Results file (.RLT). The RMMSoft
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program provides the capability for you to either specify the names of these files directly, or for the
program to automatically generate the filename. Selection of the automatic filenaming capability
also allows you to specify a size or time at which the program will limit all file sizes. See New File
Options for further details.

Once filenames have been provided, RMMSoft will bring up the standard system displays. The
user must then enter the appropriate data on the FTIR Setup, Site Setup and the Analysis Setup
Dialog prior to starting data collection. Data collection can then be started in either a single step
or continuous manner by use of the Step or Go buttons on the toolbar.

The RMMSoft program can collect and process data from multiple retroreflectors in a sequential
manner when the system is purchased with a positioner system attachment. You can accomplish
this by repetitively creating new documents in the Collect and Process mode from the File menu.
For each of these documents, you would perform all setup functions as required normally, but in
the Site Setup dialog, direct the system to use the positioner to move the FTIR. When the setup
of all documents have been completed, the user starts the processing of all documents by
pressing the Go button on the toolbar, or to process each document in a single step mode from
one position to another, by using Step button.

Collect New Background

The Collect New Background mode allows you to collect an Interferogram for use as the Classical
Least Squares reference (lo) signal for later use in the Collect and Process or Process from File
modes. There are two data saving options available in this Collection mode: Saving all data and
Saving no data. Background spectra can only be stored as Interferograms.

In this mode if you have requested saving interferogram data you will be required to provide the
name of the file in which to store the collected Interferograms (.BGD). Once provided, RMMSoft
will bring up the standard system displays. The user must then enter the appropriate data on the
FTIR Setup and Site Setup dialogs prior to starting data collection. Data collection can then be
started in either a single step or continuous manner by use of the Step or Go buttons on the
toolbar. Only one Interferogram (which can be a Co-Add Interferogram) is collected in this mode.

Collect Data without Processing

The Collect Data without Processing mode allows you to collect spectra without processing them
in real time. Spectra can only be saved as Interferograms in this mode of operation. You may
select to save either all Interferograms or none in the Collect Data without Processing mode.

When this mode is entered, if you specified saving all data, the program will ask for the name of
the file in which to store the collected Interferograms (.DAT). The program will then bring up the
standard system displays. The user must then enter the appropriate data on the FTIR Setup and

Site Setup dialogs prior to starting data collection. Data collection can then be started in either a
single step or continuous manner by use of the Step or Go buttons on the toolbar.

Viewing Modes

Opening a Document
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Opening a document provides the capability to view the contents of a file. You can open any
Signal File , (Background Files) , Results file or SPI File for viewing. The data presented by the
program is dependent on the type of file opened. You open a file via the Open command on the
File menu.

When opening a file containing signal spectra, the Status View and a spectrum view will be
displayed. The exact type of spectrum displayed is again dependent upon the spectrum type that
is in the file (Single-Beam, Absorbance, Interferogram , or any arbitrary spectrum). You can
position the file to any frame of data using the toolbar buttons.

When opening a Results File, the Status View and other views appropriate to the kind of results in
the results file will be displayed for frame number one. You can position the file at any frame of
data using the toolbar buttons. When you open a Results file containing chemical concentration
results, the program will also allow you to perform certain analyses. Specifically you can perform

Concentration Averaging and Concentration Rose processing. Spectral Library Search results
cannot be used for concentration averaging or concentration rose processing.

Remotely Viewing RAM 2000 data

The RMMSoft™ program provides a Remote Viewer Mode capability that allows remote viewing
of data that is being actively collected on any RAM 2000 system connected to a network from any
other PC connected to the same network.

To remotely view a RAM 2000 system’s data, the following steps must be performed:

1) The root directory of the hard drive of the RAM 2000 system’s computer must allow
access (Share) to the PC on the network that wishes to remotely view data.

2) The local PC must have a (legal!) copy of the RMMSoft™ program stored on its hard
drive.

3) Startthe RMMSoft™ program on the local PC and enter the File - Open command.

4) Select the file type *.rad.

5) Change the drive to the remote RAM 2000 system’s PC hard drive.

6) Selectthe active.rad file.
The remote RMMSoft™ program will then open a copy of the selected RAM 2000 system’s file for
viewing. The user can change the update rate at which the remote files are locally updated on the
Remote Viewing Options dialog . Multiple RAM 2000 systems can be monitored by following the
process outlined above for each remotely connected system.
Once remote viewing is established it continues when the remote system changes files

automatically as well as when a user stops one collection and starts another collection on the
remote system. To terminate remote viewing on the local PC you must exit the RMMSoft program.

System Verification
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System Verification

The RMMSoft program provides a number of methods to help setup and verify the performance of
the RAM 2000 system. These include:

FTIR - RetroreflectorAlignment Mode
Provides a fast method to optimize the signal strength returned from the Retroreflector.

NEA Noise Measurement
Measures the noise level of the system in quiescent areas of the spectrum.

Gas Calibration
Provides a means to determine the validity of chemical concentration measurements.

NEA Noise Measurement

The Noise Equivalent Absorbance (NEA) Noise Measurement measures the amount of system
noise that is present in three quiescent areas of the infrared spectrum and automatically evaluates
the performance of the system.

The NEA Noise Measurement can be run either from the Run menu item on the Mainframe menu,
or from any Document which has been opened in the Collect Data and Process or Process from
File modes by the New commands from the File menu. The processing capabilities are different
based upon how the measurement has been activated.

Run Menu Item Execution

When activated from the Run menu item, a collection will be automatically started by the system.
The program will configure the RAM 2000 system to collect data at 0.5 cm™ wavenumber's
resolution and take a total of 17 Interferograms. The program will also display the Status View,
the Absorbance and NEA Noise views. There is no capability to modify the FTIR Setup or Site
Setup data. You begin data collection by pressing the Go button on the toolbar. When executed
from the pre-defined macro all data will be saved to file.

When started via the Run menu item, the NEA Noise Measurement will calculate the NEA Noise
in three quiescent bands of the infrared spectra and provide a pass/fail evaluation. The
measurement will stop after 17 interferograms have been collected and processed. The results
are shown on the NEA Noise view.

Execution in a Processing mode

You can run the NEA Noise measurement in the Collect Data and Process or Process from File
modes. To start a NEA Noise measurement you will need to perform the setup processing that is
normally required for the mode of Operation that the system will be run in. You enable the NEA
Noise Measurement by selecting the NEA Noise algorithm during Analysis setup (See Analysis
Setup Dialog for further details). You begin data collection by pressing the Go button on the
toolbar. The NEA noise measurement will continue until either the stop conditions entered on the
FTIR Setup are met, or until the Stop button is pressed.

During execution the program will compute the Mean, Maximum and Standard Deviation of the
NEA Noise in 3 spectral regions and will automatically evaluate each against a pre-defined
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tolerance. If any regions’ Mean is greater than the tolerance, the NEA Noise for that region is
marked as Out of Spec. The results of this test are shown on the NEA Noise view.

When executed from a processing mode, the RMMSoft will also perform a NEA Noise Data
Quality test. This test checks the NEA noise of a single region against the rolling Mean noise of
that region. If the NEA Noise of this Data Quality region is greater than 10 times the Mean noise,
the test will be marked as Out of Spec. The results of this Data Quality test will be shown on the
Status View .

F,qlllgal?.r'l'l' {AIL backyard) : NEA Noise

NEA Noise Results
Region 1: 968 to 1008 cm-1 Region 2: 2480 to 2520 cm-1 Region 3: 4380 to 4420 cm-1
Frame Noise Bias Slope Hoise Bias Slope Hoise Bias Slope
(LLALD (mal) |{LAUicm-1)| (LAU) (mal)  |[{LAUicm-1)| (LAU) imal)  |{lLAUCm.
1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
2 4.36e3 -F.27e3 -620 1.03e3 -7.2503 -84.9 4.08e3 -6.70e3 647
3 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
4 4,273 -f.26e3 -581 1.18e3 -7.2583 -38.6 3.43e3 -6.70e3 h22
Min 4.27e3 -F.27ed -620 1.03e3 -F.2583 -84.9 3.43e3 -6.70e3 h22
Max 4.36e3 -F.26e3 -581 1.18e3 -7.2503 -38.6 4.08e3 -6.70e3 647
Mean 4.32e3 -F.26e3 -601 1.11e3 72583 -61.8 3.75e3 -6.70e3 85
Std Dev 46.4 2.07 10.9 76.2 1.69 231 J23 J21e-3 62.5
Spec 283 283 H66
The statistics values are for frames 1 through 4.
4] |

Configuring the System

Configuring the System

The configuration data that must be supplied to the program prior to execution is dependent upon
the mode of operation that is to be performed. The mode is specified when a new document is
opened (see New File Options ). When collecting new data, Site and FTIR configuration data must
be supplied. When processing signal data from a file, these parameters are not required since
they typically have been stored in the signal file in which they are contained. This is because
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processing signal data at a later date and time than that at which they were taken does not
change the fact that the data was collected at the earlier date and time.

Once a new document has been created the appropriate setup data must be entered on the
associated setup dialogs. Configuration data must be supplied on each of the setup dialogs listed
for the following modes:

Process From File Mode
Analysis Setup

Collect and Process Mode
Site Setup

FTIR Setup

Analysis Setup

Collect Without Processing Mode
Site Setup
FTIR Setup

Collect New Background
Site Setup
FTIR Setup

Pointing a FTIR at multiple Retroreflectors

If your RAM 2000 system configuration includes a Positioner system, your system has the
capability to automatically point the FTIR from one retroreflector to another in a sequential
manner, up to a maximum of 36 retroreflectors per FTIR. This feature allows you the capability to
cover multiple beam paths at your facility using a single FTIR.

Prior to starting the system in this manner System Alignment must be performed and the
Elevation and Azimuth values for each Retroreflector must be recorded. For each retroreflector a
separate document will have to be created in the program, each with a different flename for
storing the spectral input data (interferograms in a Signal file) and processing results data (Results

file). When your application uses multiple retroreflectors, it is recommended that you build a
macro to store your setup information.

Creating Multiple Documents to point the FTIR to Multiple Retroreflectors

1. From the File menu select New.

2. Select a Mode of Operation

3. Select a Data Saving option. If file size limiting and automatic file naming is desired, enable
the automatic file naming option from the New File Options dialog; Otherwise select a Data

Save option. See New File Options for details.

4. Press the OK button.
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5. If data is to be saved to file, and automatic file naming option was selected, provide the Drive
and Directory to store the data in on the Automatic File Directory dialog; Otherwise provide
a path and filename for the Results File on the Results File dialog.

6. Press the OK button.

7. If automatic file naming option was not selected, provide a path and filename for the Signal file
on the Interferogram Collection File dialog.

8. Press the OK button. The Standard system windows, (the Status, Concentration and
Concentration Vs Time windows), are displayed.

9. Perform the required setup processing from the Setup menu. When performing Site setup,
enable the use of the Positioner system by checking the Use the positioner to direct the
telescope option. Enter the Azimuth and Elevation pointing angles for the retroreflector. See
Configuring the System for further details.

10. Repeat steps 1 through 9 (above) for each retroreflector that this FTIR will use during operations.

FTIR Peak Amplitude Search

The Program provides the capability to find the best FTIR pointing angle (azimuth and elevation)
for a retroreflector via the FTIR Peak Amplitude Search function. This feature provides an
automated capability to find the best azimuth and elevation to point the FTIR at a retroreflector.

The Peak Amplitude Search function is initiated via the “Find FTIR Peak Amplitude Position” item
on the Run menu. When initiated, the program will display the FTIR Peak Amplitude Search
Dialog. Once you enter the search parameters and have pressed the OK button, the program will
display the Peak Amplitude Search View. Press the GO button to start the process.

The Peak Amplitude Search view is comprised of a grid coordinate display and a text display.
When the process is started the RAM 2000 positioner system will move the position of the FTIR
across the face of the selected retroreflector and fill in squares of the grid. The color intensity of
the squares on the grid indicates the returned signal strength with white indicating the lowest
signal strength and red indicating the greatest signal strength. Once the process has completed
the program automatically displays the azimuth and elevation of the square that contains the
highest returned signal. Use these values on the Site Setup dialog in the Sensor Position group
as the pointing position of the FTIR.

Performing an Analysis

Overview

There are two Analysis modes available to the user. One is an on-line processing mode and the
other is an off-line processing mode. The latter mode involves the processing of spectra or results
from data files previously created. The modes are:

Collect Data and Process

Process from File Mode
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The Collect Data and Process mode is the standard on-line processing mode of the system. It
allows you to see processing results in real time.

The Process from File mode is an off-line mode that provides the capability to reprocess a signal
spectrum stored in a file. This provides the capability to reprocess signal spectra for additional
chemicals that may not have been previously selected for processing.

The results of an analysis can be “played back” by opening a Results File by opening a document.

This provides the capability to review previously processed results from file. This is especially
useful when quick verification of chemical concentration values for specific dates are needed.

Process from File mode Selection

The Process from File mode (Reprocess mode) is similar to the Collect Data and Process mode
with the exception that the data source for the signal spectra to be processed is either a RMMSoft
formatted or a SPC formatted Signal file instead of the FTIR. Spectra may be saved in one or all
of the following spectral types: Single Beam, Absorbance or Transmittance based upon the type of
spectral data type used as input.

Process from File Mode

1. From the File menu select New.

2. Select Process Data from File from the New File Options dialog.

3. Select a Data Saving option. See File Saving Options for details.

4. Select the format to which spectral and processing results data will be stored.

5. Press the OK button. The Results File dialog will appear.

6. Provide a path and filename for the Results File on the Results File dialog.

7. Press the OK button. The Standard system windows, (the Status, Concentration and
Concentration Vs Time windows), are displayed.

8. Perform the required setup processing from the Setup menu. See Configuring the System for
further details.

9. Press the Go button to begin collection of interferograms, (or the Step button if you wish to
perform single step collections).

10. If you have not specified a Stop condition during FTIR setup, depress the Stop button on the
toolbar to terminate collection when you have collect a sufficient number of interferograms.

11. Close the document by selecting the Close command from the File menu.

Collect Data and Process Mode Selection
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The Collect Data and Process mode is used when real time data collection and processing of
results are desired. When you select this mode, RMMSoft will create a new document in which to
encapsulate all data related to this collection. Collected spectra may be saved in one or all of the
following spectral types: Interferograms, Single Beam, Absorbance or Transmittance during
collection. All File Saving Options are available in this mode of operation.

Collect Data and Process Mode
1. From the File menu select New.
2. Select Collect Data and Process from the New File Options dialog.

3. Select a Data Save option. If file size limiting and automatic file naming is desired, select the
Enable automatic file naming option from the New File Options dialog. (See File Saving
Options and New File Options dialog for details).

4. Select the format to which spectral and processing results data will be stored.
5. Press the OK button.

6. |If data is to be saved to file, and automatic file naming option was selected, provide the Drive
and Directory to store the data in on the Automatic File Directory dialog; Otherwise provide
a path and filename for the Results File on the Results File dialog.

7. Press the OK button.

8. If automatic file naming option was not selected, provide a path and filename for the Signal file
on the Interferogram Collection File dialog.

9. Press the OK button. The Standard system windows, (the Status, Concentration and
Concentration Vs Time windows), are displayed.

10. Perform the required setup processing from the Setup menu. See Configuring the System for
further details.

11. Press the Go button to begin collection of interferograms, (or the Step button if you wish to
perform single step collections).

12. If you have not specified a Stop condition during FTIR setup, depress the Stop button on the
toolbar to terminate collection when you have collected a sufficient number of interferograms.

13. Close the document by selecting the Close command from the File menu.

Concentration Averaging Parameters Dialog

The RMMSoft program allows you to average a chemical’s concentration values in order to reduce
the amount of data needed to be reviewed for EPA / Community emission compliance. The
program provides the Mean (average) concentration value for a user specified averaging duration
(i.e. time span) along with the Mean Standard deviation and the maximum concentration
calculated during the duration. Concentration averaging can be performed for two distinct
averaging durations for every chemical. For example, you could average the concentration data
every 15 minutes and every 24 hours simultaneously.

43



Concentration averages are controlled via a mechanism called an Averaging Window. Each
Averaging Window allows you to select specific parameters for averaging chemical
concentrations. Each Averaging Window is a distinct process and is not affected by other
Averaging Windows. The RMMSoft program provides two Averaging Windows for your use.
Each Averaging Window allows you to specify the type of averaging to be performed, (Continuous
or Interval), and the length of time to average, known as the “duration”, and, for Interval averaging,
the Start and Stop time to average. Each of these entries is explained in more detail below.

Averaging Type

There are two types of averaging provided by the RMMSoft program, Continuous and Interval.
Continuous averaging means that the program will average data every specified averaging
duration (i.e. time span) until data collection is stopped. For example, if you select 30-Minute
Continuous averaging, the program will calculate a Mean concentration for each chemical every
30 minutes until collection of data is halted. Interval Averaging is a method in which you can
specify discrete start and stop times for averaging; for example from 01:00 to 13:30 (l.e. 1:30
P.M.). If you select Interval Averaging, you may select up to three non-overlapping start-stop time
intervals. Each start-stop time interval may have a different averaging duration.

Averaging Duration

The Averaging duration is the time span for which you wish to average the concentration data.
You may select to average data in the units of minutes or hours. Averaging by “minutes” is
specified in 5-minute increments between 5 and 55 minutes. Averaging by “hours” is specified in
1-hour increments between 1 and 24 hours.

Start Time / Stop Time

For Interval Averaging you need to specify the Starting and Stopping time for the averaging.
Time is in military (24 hour) time starting at 00:00 hours (12 midnight) and ending at the following
23:30 hours (11:30 P.M.). Time is specified in 1/2-hour increments.

Emission Rate Determination

In order to determine the emissions being released from a site and that emissions affect on
nearby communities, an emission rate determination needs to be performed. An emission rate
determination can determine the amount of chemical being released from a site and the amount of
the chemical, which may reach a nearby site (called a receptor).

The determination of emission rate for a set of target chemicals is performed using the release of
a known gas, preferably one which is easy to identify and quantify, and has no deleterious effects.
Commonly a gas such as SF6 is used. This gas is called a Tracer gas and is used to compute
the emission of the target gases as a ratio of the Tracer gas. The Tracer gas is released at a
known rate in close proximity to the site at which the target gases are emitted. The use of a
METS is required to perform the emission rate determination. The FTIR and retroreflector are set
up downwind from the site at which the Tracer and Target gases are released in order to assure
that the gases will cross the beam of the FTIR.

To set up for emission rate determination, create a new document in the Collect Data and Process
mode. Perform CLS setup processing for all Target and Tracer gases. Then perform Emission
Rate Setup processing. During setup of the emission rate algorithm specify the Tracer gas,
Receptors and Plume Capture parameters. Then start the collecting and processing of the data.
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Once the run has completed you can see the results of the processing on the Emission Rate
View. This view will indicate the emission rate (at the source) of all target gases and the
concentration of the gases at the receptors.

RMMSoft Reference

Displays and Reports

Displays and Reports

The RMMSoft program provides numerous displays and reports to provide you with a complete
picture of events occurring at your site. All non-popup views display the context menu for the view
when the right mouse button is pressed. The context menu provides access to the View pull down
menu items that apply to the view.

All views that display captured or processing results data support using the left and right arrow
keys on the keyboard to display the previous and next data frame, respectively.

The displays and reports available include:

Analysis Results Views
Concentration Views
Concentration Averages View
Concentration Rose
Concentration History Views
NEA Noise View

Emission Rate View

Spectral Library Search Views

Spectral Views
Spectral Views

Status Views

Status View

Positioner System Pop-Up
LN2 Refill System Pop-Up

Analysis Setup Views

Chemical Setup Views
Concentration Averaging Setup View
Adaptive Background Filtering View

Miscellaneous Views
Alignment View

File Header View

Peak Amplitude Search View
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Adaptive Background Filtering View

The Adaptive Background Filter view displays the information concerning the setup information
entered for controlling the Adaptive Background Filtering (ABF) process. This process involves
updating the background spectrum using the Signal spectrum collected by the FTIR.

The view will display the chemicals selected for background subtraction and the upwind angles
used.

Alignment View

The Alignment view is displayed only when you have started a collection in the Alignment Mode .
The RMMSoft program aids you in aligning the system with this unique display.

The Alignment view displays the ZPD power level, the percent of A/D full scale and the power
level of three bands of the Single-Beam spectrum. The ZPD power and Percent of full scale
displays provides the user with a indication of both the current received signal strength and the
maximum value that has been detected over the run on the Alignment view display. This allows
you to determine whether the adjustments in alignment being made are beneficial or not.

el 1119a16i.dat {AIL backyard) : Alignment

ZPD P-P: 5098V _utsm e
| s1fi
% Full Scale: 51.3 100% | so% | 31%
| s1ffl

- Current Value
- Peak Value

968 - 2480 - 4380 -
1008 cm-1 2520 cm-1 4420 cmi-1

Chemical Setup Views

There are two different Chemical Setup views that you can display to see the algorithms and
chemicals selected for analysis. One is a graphical view and the other a textual view.

The Text view displays the chemicals selected for processing (for both concentration and / or for
interference), the frequency regions that are being searched and an indication of whether the
chemical is being processed in a frequency region. Chemicals being processed for concentration
in a region are marked with a “C”. A chemical being processed as an interferent in a region is
marked with a “I”. Chemicals not being processed in a region are marked with an “-”. This is
illustrated below.
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The Text view also provides a “detailed” report that will display a chemical’s:
Name
Reference file used for analysis
CAS number
Molecular mass
Concentration path length product (CP*L)
The number of Std deviation required for acceptance
The Warning alarm level
The Trigger alarm level
The alarm triggers values (M out of N values).

The Graphical view displays the chemicals selected for processing (for both concentration and / or
for interference), the frequency regions that are being searched and an indication of whether the
chemical is being processed in a frequency region. Chemicals being processed for concentration
are shown with a green line marked with a “C”. Chemicals being processed as an interferent are
shown as a red line marked with a “I”. Dashed vertical black lines indicate a break in the
frequency range along the X axis.

You can display a region’s start and stop wavenumber by clicking the left mouse button on the
region of interest. The data will be displayed in the chemical setup data popup window.
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Concentration Averages View

The Concentration Averages view shows the current concentration average data for the averaging
windows setup for the document. The mean and 3 sigma values as well as the maximum
concentration and time of maximum concentration are shown for each chemical for the current
averaging period.
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=1 0721e86_Ffullrlt : Concentration Averages

Averaging Duration: 15 Minute Averages 1 Hour Averages
Averaging Type: Average Onby at Specified Times Average Onby at Specified Times
Current Processing Interval: 07:00 to 17:00 07:00to 17:00
Current Data Period: 07:1510 0730 16:00to 17:00
Chemical Mean Jo Maximum Mean Jo Maximum
ppm*m__ppm*m_ppm*m ppm*m__ppm*m_ppm*m
Ammonia <0.00 0.0 0.00 @ 07:15 <780e-3 780e-3 3.73 @ 16:26
Methane J7.0 2.9 395 @ 0720 <7.21 7.2 21.3 @ 16:37
Carhon Monoxide 104 1.2 120 @ 0725 +3.55 3.5 18.2 @ 16:11
Hitric Oxide <0.00 0.0 0.00 @& 0715 <0.00 0.0 0.00 & 16:00
Hitrogen Dioxide (Old Hanst) =0.00 0.0 0.00 & 0715 <0.00 0.0 0.00 @& 16:00
Hitrogen Dioxide <0.00 0.0 0.00 @ 07:15 <0.00 0.0 0.00 @ 16:00
iso-Propanol =0.00 0.0 0.00 @ 07:15 <0.00 0.0 0.00 @ 16:00
Tetrachloroethene =0.00 0.0 0.00 & 0715 7.24 1.6 818 & 16:42

"<" Symbol indicates that =10% of data is Below Detection Limits

Concentration Averaging Setup View

The Concentration Averaging Setup view displays the parameters entered by the user that are to
be used for concentration averaging. In the figure shown below the user has setup Concentration
Averaging Window 1 to average data every one hour continuously throughout the run.
Concentration Average Window 2 has been setup so that 4 hour averaging is performed from
12:00AM (midnight) to 8:00AM, 1 hour averaging from 8:00AM to 5:00PM and 2 hour averaging
from 5:00PM to 12:00AM (midnight).
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F:'qDElZyﬂl.r'lf : Concentration Averaging Setup =1 E3

Concentration averaging window 1:
Continuousty average every 1 hours.

Concentration averaging window 2:
Average every 4 hours from 00:00 to 08:00.
Average every 1 hours from 08:00 to 17:00.
Average every 2 hours from 17:00 to 00:00.

Concentration Views

There are two different Concentration Views that you can display to see the analysis results for a
specific frame of data. One is a textual report and the other is graphical report. Both provide a
means of monitoring chemical concentrations on a frame by frame basis.

Concentration Graphic View
Concentration Text View

Concentration Graphic View

The Concentration Graphic View presents the analysis results of the current frame of data in a
graphical manner. This allows you to quickly see the current alarm state and concentration values
for any chemical undergoing analysis. It is one of the default views that are displayed when a
document has been created/opened for analysis.

The Concentration view has four different display formats selectable with the View — Histogram
menu item. These are:

3D Bar chart

2D Bar chart

Percent of Trigger Level Bar chart

Error Range chart.

Each chart presents the results of an analysis in a slightly different format, although each format
uses common color coding to simplify the process of identifying the Alarm Level or state of any
chemical. The color scheme used is as follow:

Bar/ Line Color Meaning

Red Chemical is above its Trigger value.

Yellow Chemical is above its Warning value.

Green No alarms for this chemical.

Dark Blue Chemical is below its Minimum Detection Limit.
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Light Blue MDL value (Bar charts) or Standard Deviation (Error Range)

All Concentration View formats provides the capability to change the presentation order of the
data and the concentration units that the data will be presented in. You can select the units and
presentation order of the chemicals via the View —» Concentration Units and View — Sort By
menu items, respectively. As with all RMMSoft views, you may also select the font, font size, text
color and background color for this display with the Options — Font and Options — Color menu
items. You may not change the colors of the bars or the background color of the chart's grid. See
Program Controls for further details.

2D and 3D Bar charts

The 3D and the 2D Bar charts are effectively the same except for the depth (2D Vs. 3D) of the
bars. These charts provide the capability to see a chemical’'s concentration value and Alarm Level
quickly. They also allow you to see the relative concentration of one chemical versus another.
When the concentration value is below the Minimum Detection Limit (MDL), it is shown as a Dark
Blue flat square. The value listed will then be the MDL value instead of the chemical's
concentration. An example of a 3D Bar chart is illustrated below.

The Y-axis of the charts are in the range from 0 to a value slightly larger than the largest
concentration. The Y-axis automatically auto-scales to ensure that all data is presented
completely on the graph. This ensures that the relative heights of one chemicals bar to another is
always accurate. The X-axis is as wide as necessary to list all chemicals that are being
processed for analysis. Chemicals that are processed as interferents only are not displayed. If
the display does not fit within the view area, due to the font size selected or the number of
chemicals processed for analysis, the program will automatically provide horizontal and vertical
scroll bars.
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Indicates the presentation order of the data
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Percent of Trigger Level chart

The Percent of Trigger Level chart is a specialized 2D Bar chart which shows a chemical’'s
analysis result as a percentage of its specific Trigger Alarm Level. This chart is especially useful
for non-technical personnel such as guards and low level technicians. This chart provides these
personnel with an easy to monitor display that requires no evaluation to determine the highest
alarm state of any chemical. An example of the Percent Of Trigger Level chart is illustrated below.

The Y-axis range of the chart is from 0% to, as a minimum, 150% of the highest Trigger Level of
all chemicals processed. The Y-Axis will autoscale above 150% of Trigger Level as required. A
chemical's individual Detection, Warning and Trigger levels are indicated as Green, Yellow and
Red ranges, respectively, as a percentage of it's Trigger Level. The presentation order can be
either by “Chemical Name” or by “Percent Of Trigger Level’. Chemicals that are processed as
interferents only are not displayed. If the display does not fit within the view area due to the font
size selected or the number of chemicals processed for analysis, the program will automatically
provide horizontal and vertical scroll bars.
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Error Range chart

The Error Range chart is provided for those users who want an indication of the standard
deviation of a chemical's concentration on the display. In this view a chemical’'s concentration is
indicated by a central line in the color of its alarm state (as indicated above), encompassed by
lines indicating the potential highest and lowest values of the concentration as computed by the
chemical's standard deviation. An example of the chart is illustrated below.

The Y-axis of the chart is in the range from 0 to a value slightly larger than the largest
concentration. The Y-axis automatically auto-scales to ensure that all concentration data is
presented completely on the graph. It will not auto-scale to ensure that the display of the error
range is on the graph. This is done to prevent a chemical with a large standard deviation (which is
probably a poor analysis result to begin with) from dominating the graph scale. The X-axis is as
wide as necessary to list all chemicals that are being processed for analysis. Chemicals that are
processed as interferents only are not displayed. If the display does not fit within the view area,
due to the font size selected or the number of chemicals processed for analysis, the program will
automatically provide horizontal and vertical scroll bars.

See Program Controls for full details on the display options available.
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Indicates that the upper bounds of the standard deviation is off the screen.

FHTEI:.PI'I' : Concentrations

Calculated concer’:tration

Concentration Text View
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o-¥ylene p-Mylene
z

Highest possible concentation value
based Lpon its standard deviation.

The Concentration Text view is a textual report of the results of an analysis. The data presented
in the view is the same as that used in the Concentration Graphic View. The view is comprised of
up to 3 sections.

The first section is the General Data section.

This section displays data concerning the Signal

spectrum, the Background spectrum, the Results File and the Site data. This section is illustrated

below.
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FHTSI:.FH- ! Concentrations Text !EE

Source Data File:
Source Data Type:

Input Background File:
Chemical Setup File:

Saved Interferogram File:

Saved Backoground Single Beam File:
Saved Signal Single Bearn File:
Saved Absorbance File:

Saved Transmittance File:

Retro Location Hame:
Site Location:
Temperature:
Barometric Pressure:
Humidity:

Wind Speed:

Wind Direction:

Adaptive Background Filtering:

GEMERAL DATA

Results File: EXTEST\Tah.rit

Results Data Date/Time: 11/25/08 11:53:19 Eastern Standard Time
Created by RMMSoft version: 311

EATEST \Tha.spc
Interferogram

EXTESTBACKGROUND1.BGD
EXTEST\TSh.spi

EXTEST'SIGHAL1.BGD
Hone
Hone
Hone
Mone

Back Fence

AlL Backyard, Deer Park, NY, USA
J55 den. F

29.9in Hyg

43%

3.99 MPH
N (7.55 + 2.9)

Off

]

The second section is the Analysis Summary Report. It contains summary data pertaining to the

analysis results for all signal-processing algorithms performed for all chemicals.

analysis results for each chemical for

It displays the

the current frame. For each chemical, the average

computed concentration, the average 3 0, the user entered Warning and Trigger alarm levels, and

the current highest alarm level are displayed. As stated previously, the concentration and 3 ©
values are an average value computed as the mathematical mean of all the regions that a
chemical was analyzed for concentrations. This section is illustrated below.
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FETEH.FH‘ ! Concentrations Text !Em

CLS AMALYSIS SUMMARY
Frame Humber: 9 of 44
Time: 050505 12:00:54 Eastern Daylight Time
Warning Trigger

Conc ic Level Lewvel Exceed J
Chemical ppm*m ppm*m ppm*m ppm*m Lewvel
YVimy Acetate <5H80e-3 H80e-3 0.0 0.0 MNif
Toluene <68 i1 300 G600 il
Benzene 66 10 ih 200 Hone
m-¥ylene <44 44 50 300 NIl
o-Xylene <h7 LTy 100 400 MNif
p-Xylene 5.7 J6 25 300 Warning
Ethanol =21 21 0.0 0.0 il
Ethwihenzene 80 16 H0 a0 Warning LI

The third section is a Detailed Analysis Report. It contains detailed data pertaining to the analysis
results for all signal-processing algorithms performed for all chemicals. It displays the analysis
results for each chemical for the current frame. The view displays the chemical’s processing
results for each region for which it was analyzed. For each chemical’s region, the Start Frequency
(wavenumbers), Stop Frequency, Concentration, and 3 O values are displayed.

The view also displays whether the analysis was for computing a concentration or as an
interferent. This is marked with a “c” or and “I” respectively. No averaging of data is performed.
The Detailed Analysis section can be included or excluded from the view by selecting the Detail
Results command on the View menu. The Detailed Analysis Report is illustrated below.
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Fﬂ T5b.rit : Concentrations Text !E m
r 4l
CLS DETAILED ANALYSIS
Frame Humber: 9 of 44
Time: 05050945 12:00:54 Eastern Daylight Time
Start End Conc 3o
Chemical Frequency | Frequency ppmm ppm*m
Vimyd Acetate
region 1 (i) 856.00 907.00 -4.8 15
region 2 (i) 1123.00 1163.00 4.2 2.6
region 3 (c) 1200.00 1241.00 5ie-3 H80e-3
Toluene
region 1({c) 1018.00 1104.00 15 68
region 2 (c) 1019.00 1049.00 122 83
region 3 (c) 2841.00 2928.00 J06 20
region 4 (c) 2841.00 2940.00 325 17
Benzene
region 1({c) 1004.00 1065.00 63 28
region 2 (c) 3020.00 3075.00 67 1 b
m-Xylene
region 1({c) 757.00 F73.00 377 7.2
region 2 {c) 856.00 920.00 1.5 44
region 3 (c) 2843.00 2928.00 1545 14
region 4 (c) 2843.00 2971.00 128.7 5.2 =
4 | v

The program provides the capability to change the concentration units that the data will be
presented in. As with all RMMSoft views, you may also select the font, font size, text color and
background color for this display. See Program Controls for further details.

Concentration History Views

There are two different Concentration History Views that you can display to see the results
analyses over time. One is a textual report and the other is graphical report. Both provide a
means of monitoring chemical concentrations over time.

Concentration History Text View
Concentration History Graphic View

Concentration History Text View
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The Concentration History Text View displays a text report containing the analysis results data, for
each chemical, for up to the last 16,000 frames. It is similar in nature to the Concentration vs
Time View except that the data is presented in a tabular rather than graphical format.

The View displays the Frame number, Date, Time, Concentration and Standard Deviation for each
chemical for up to 16,000 frames. The display is reset after any automatic file changing has
occurred.

F:q T5b.rit : Concentration History Text !E m
Frame Time Toluene Benzene m-Xylene 3
Eastern Standard Time ppm*m ppm*m ppm*m
1 050505 11:35:50 27213 8.1+53 89+27
2 05/05/95 11:38:58 <16+ 16 <5hH+545 F7x34
3 05/05/95 11:42:06 2314 <H.6 + 5.6 FHx345
| 050595 11:45:13 Mo data Mo data Mo data
h 05/05/95 11:48:22 <63+ 63 3273 18+ 3.3
6 050595 11:51:31 <67 + 67 6307 <42+ 42
¥ 05/05/95 11:54:39 <67 + 67 63+ 10 <42 + 42
g 050595 11:57:47 =65 + 65 65 + 10 <44 + 44
o 05/05/95 12:00:54 =68 + 68 66 + 10 <44 + 44
10 050505 12:04:03 Mo data Mo data Mo data
11 050505 12:07:11 =69 + GO 67 10 <44+ 44
12 05/05/95 12:10:19 <F0+70 6310 <43+ 43
13 050595 12:13:26 <68 + 68 65+ 10 <41+ 41
14 N&M&MN& 171636 <70+ 7N A7 + 1N <Ad + 44 i
< | W

The View provides the capability to change the concentration units that the data will be presented
in via the View menu. As with all RMMSoft views, you may also select the font, font size, text
color and background color for this display. See Program Controls for further details.

Concentration History Graphic View

The Concentration History Graphic View (Concentration Vs Time) presents the analysis results of
up to the last 16,000 frames of data for all selected chemicals in a graphical manner. It is one of
the default views that are displayed when a document has been created/opened for analysis.

This view will display a line plot of up to the last 16,000 concentration values for all selected
chemicals. The actual number of frames plotted is dependent upon the number of frames saved
in the current Results File being processed. The display is reset after any automatic file changing
has occurred. Each chemical will be displayed in a different color for increased readability. When
the computed concentration value of a chemical is below the Minimum Detection Level (MDL), the
MDL value will be plotted instead. This is represented by a winged V symbol. In the case that the
signal processing fails to compute a MDL and a concentration, or the quality of the calculation was
low and the Display Low Confidence Data is not enabled, then no value will be plotted (you will
see a break in the plotted line for the chemical). Single data points are plotted as a colored circle.
An example of the Concentration Vs Time view is illustrated below.

The Y-axis of the chart is in the range from 0 to a value slightly larger than the largest
concentration. When not scrolled, the Y-axis automatically auto-scales to ensure that all
concentration data is presented completely on the graph. The X-axis is initially set to 50 data
points in width. This value can be increased or decreased using the expand and contract toolbar

58



buttons described below. If the display does not fit within the view area, due to the font size
selected or the number of chemicals processed for analysis, the program will automatically
provide horizontal and vertical scroll bars.

The Concentration History Graphic view provides its own toolbar controls for controlling the
display of data. The toolbar controls are described below:

U

Show BDL as
Zero

Show Low
Confidence
Data

UnZoom

Scale Vertically

Page Left
Scroll Right

Scroll Up

Scroll Down
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The Show Below Detection Limits (BDL) data as Zero buttons controls the
display of BDL data on the graph. When enabled, data that is BDL, which is
shown as a winged “V” at the Minimum Detection Limit (MDL), will instead be
plotted as a zero value.

The Show Low Confidence Data button controls the display of data that the
RAM 2000 system has determined to be of poor quality. When disabled, low
quality data will be reported as No Data. When enabled, low quality data will
be reported as the value calculated by the system.

The UnZoom button restores the display to 50 data points on the X-axis and
full scale in the Y-axis.

The Scale Vertically button will expand the current display to fill the vertical
extent of the view.

The Page Left button will cause the data viewed to be shifted to the right by 5
data points. Holding the button down will cause the process to repeat
continually.

The Page Right button will cause the data viewed to be shifted to the left by 5
data points. Holding the button down will cause the process to repeat
continually.

The Scroll Up button will cause the data being viewed to be shifted down by
half of the size of the display. Holding the button down will cause the process
to repeat continually. This function can also be accomplished by pressing the
Page Up key. This button is currently not enabled.

The Scroll Down button will cause the data viewed to be shifted up by half of
the size of the display. Holding the button down will cause the process to
repeat continually. This function can also be accomplished by pressing the
Page Down key. This button is currently not enabled.



Scroll Left

Scroll Right

Contract

Horizontally

E x p and

Horizontally

Contract

Vertically

E x p and

Vertically

Display All
Chemicals in
Alphabetic
Order

Display All
Chemicals in
Default Order

S el e ¢
Chemicals
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The Pan Left button will cause the data viewed to be shifted to the right by one
data point. Holding the button down will cause the process to repeat
continually.

The Pan Right button will cause the data viewed to be shifted to the left by one
data point. Holding the button down will cause the process to repeat
continually.

The Contract Horizontally button will cause the view to display more data
points in the horizontal (X) axis. Holding the button down will cause the
process to repeat continually.

The Expand Horizontally button will cause the view to display less data points
in the horizontal (X) axis. Holding the button down will cause the process to
repeat continually.

The Contract Vertically button will cause the view to display more data points
in the vertical (Y) axis. Holding the button down will cause the process to
repeat continually.

The Expand Vertically button will cause the view to display less data points in
the vertical (Y) axis. Holding the button down will cause the process to repeat
continually.

The Display All Chemicals in Alphabetic Order button will cause all chemicals
being processed for concentration to be displayed on the graph in alphabetic
order.

The Display All Chemicals in Default Order button will cause all chemicals
being processed for concentration to be display on the graph in the order they
were selected in the SPI file.

This button will cause the Select Chemical Name dialog to be displayed. This
allows you to select the specific chemicals that you wish to display on the
graph.



This button will cause the program to display the chemical before the current
chemical in the chemical list. The chemical list can be ordered in either
Alphabetic or Default order (see the description of button Display All

Previous Chemicals in Alphabetic Order and Display All Chemical in Default Doer).

Chemical

This button will cause the program to display the chemical next chemical in the
chemical list. The chemical list can be ordered in either Alphabetic or Default
. order (see the description of buttons: Display All Chemicals in Alphabetic
Next Chemical Order, and, Display All Chemicals in Default Order).
This control will allow you to select one specific chemical to display on the

Display Single graph.

Chemical

The View provides the capability to change the chemicals selected for plotting and the
concentration units that the data will be presented in. You can select the concentration units and
presentation order of the chemicals via the View — Concentration Units and View — Sort By
menu items, respectively, or from the graph’s context menu.

The program also provides the capability to view the weather data associated with any frame via a
Weather Data Pop-up . You can display the weather data by clicking the left mouse button over
the graph. The program will display the weather data for the frame number closest to the mouse
position. The units for weather data can be selected via the View — Weather Units menu item or
from the graph’s context menu.

To make it easier to identify a chemical on the display, you can click on a chemical name in the
legend to cause the name and the associated chemical trace to blink. Click on the chemical name
again to stop blinking.

As with all RMMSoft views, you may also select the font, font size, font color and background
color for this display using the Font Dialog and Color Dialog, respectively. You can change the
order of color usage or change any color used to display each of the chemicals on the charts’ grid
using the Colors For Chemicals Dialog. These dialogs are displayed by selecting the Options —
Font and Options — Color menu items. See Program Controls for further details.
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Concentration Rose View

The Concentration Rose view shows a chemical's average concentration and average MDL
values as a function of the wind direction over time. This display is particularly useful when
determining if a receptor may be encountering gases released in the area. This display is only
valid when used in conjunction with a meteorological station (METS).

The display is a polar plot of the average concentration and Minimum Detection Limit (MDL) for a
single chemical over a specified number of frames . There are four rings on the plot. Each ring
represents a different average value as delineated in the text box to the left of the plot. The view
will display data for one chemical at a time. The chemical can be selected from the drop down list
in the menu bar. The frames that you wish to average over are also selectable in the menu bar.
The directions indicate the direction from which the wind is blowing (standard meteorological
definition), not to which direction the chemical is blowing to. An example of the display is
illustrated below.
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HEEl&IIH] [H|T||]'*|]l| ) | c4 | Methane j 1 112 il Ii!_l

Chemical: Methane M

Frames: 1-112 NN MNE
Start Time: 05/05/97 18:27:12
End Time: 05/06/97 16:26:29

Ratio: detects / events
RING ppm*m

1 86.25

2 172.50

3 258.75

4 345.00

B Average MDL
I Average Conc.
[ ] Nowind

Mazx. Conc. for

maonitoring period:
4357 ppm*m in ESE
at 0506197 01:58:23

Wind Sector |Average Conc. (Average MDL |Wind Sector |Average Conc. (Average MDL
(ppm*my) (ppm*my) (ppm*my) (ppm*my)

H 3441 144.1 5 71.33 39.28
HNE 1] 15.11 S5 147.9 48.11

MNE 136.4 60.64 S 114.4 62.63
ENE MNo data Ho data VWS 162 128.6

E 246.6 00,52 W 33.04 30.81
ESE 185.6 65.71 VWA 118.1 44,73

SE Mo data Mo data N 106.8 61.19
S5E No data Mo data HMWY 320 130.7

The program provides the capability to change the concentration units that the data will be
presented in using the View — Concentration Units menu item. You may also display the data
in a textual form beneath the graph by enabling the Detail Results command on the View menu.

The program provides the capability to view the data associated with any wind sector via a
Concentration Averages popup view. You can display the wind sector data by clicking the left
mouse button over the graph. The program will display the chemical name, the wind sector, the
number of chemical detection’s in this sector, the total number of times the wind was in this sector,
the average concentration and the average MDL values.

The Concentration Rose view provides its own toolbar controls for controlling the display of data.
The toolbar controls are described below:
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This button will cause all chemicals in the Chemical listbox to be ordered
alphabetically.

This button will cause all chemicals in the Chemical listbox to be ordered as
they were selected in the SPI file.

This button will cause the Select Chemical Names dialog to be displayed. This
allows you to select the specific chemicals to include in the list of selected
chemicals. The Selected Chemicals List is used by the Previous Selected
Chemical and Next Selected Chemical buttons. It will also allow you to remove
chemicals (temporarily) from the Selected Chemical List. This can be used
with the Next Selected Chemical and Previous Selected Chemical buttons to
toggle between a selected sub-set of chemicals.

This button will cause the program to display the chemical before the current
selected chemical from the Selected Chemicals List. This button’s action is
affected by user selection or removal of chemicals from the Selected Chemical
List.

This button will cause the program to display the next selected chemical from
the Selected Chemicals List. This button’s action is affected by user selection
or removal of chemicals from the Selected Chemical List.

This button will cause the program to display the chemical before the current
chemical from the complete set of chemicals. This button’s action is
unaffected by the current state of Selected Chemicals List. The chemical list
can be ordered in either Alphabetic or Default order (see the description of
buttons Display All Chemicals in Alphabetic Order and Display All Chemical in
Default Order).

This button will cause the program to display the next chemical from the
complete set of chemicals. This button’s action is unaffected by the current
state of Selected Chemicals List. The chemical list can be ordered in either
Alphabetic or Default order (see the description of buttons: Display All
Chemicals in Alphabetic Order, and, Display All Chemicals in Default Order).

This control will allow you to select one specific chemical to display on the
graph.

This button will cause the Concentration Rose display to be scaled based
upon the chemical’s maximum concentration.



Upon Maximum
Concentration

This button will cause the Concentration Rose display to be scaled based
upon the larger of the chemical’s maximum concentration or Maximum

Scale Based Minimum Detection Limit.

Upon Maximum
MDL or
Concentration

As with all RMMSoft views, you may also select the font, font size, text color and background
color for this display. You may not change the colors of the pie wedges that indicate the MDL or
concentration values. See Program Controls for further details.

Detected Chemicals Window Popup View

The Detected Chemicals Window View displays information on chemicals that have met the
conditions specified in the Detected Chemicals Window dialog. The popup window is visible only
when one or more chemicals are at or above the threshold selected on the dialog.

For each active document the view will display the name of the chemical which has met the
specified detection criteria and its associated document. The threshold that the chemical
exceeded: detection, warning or trigger, is indicated by the background color used for that
chemical: green, yellow or red respectively.

Chloroethane

Emission Rate View

The Emission Rate view is displayed only when an Emission Rate Determination has been
performed. It displays both the emission rates of all chemicals selected for Emission Rate
determination along with a prediction of the concentrations at all receptors.

The view is comprised of three sections. These are the Atmospheric, Emission Rate and
Receptor displays.

The Atmospheric section of the view displays the wind conditions at the time the data was

collected along with the amount of the plume captured. The Plume Capture is a ratio of the
amount of the Tracer gas detected versus the amount of the Tracer gas released.
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The Emission Rate section of the view displays the calculated concentration and emission rate of
each target chemical.

The Receptor section of the view displays the calculated concentration of each chemical at each
Receptor.

As with all RMMSoft views, you may also select the font, font size, text color and background
color for this display. See Program Controls for further details.

B PLCAP.RLT : Emission Rate

Emission Rate Results
Location: sred3%&#SDE
Temperature: 295.2 deg. K
Wind Speed: 2.99 m/sec
Wind Direction: 398 deq
Standard Deviation of Wind Direction: 27.3 deg.
Plume Capture: 50.055%
Chemical Concentration Emission Rate
ppm*m Hy'sec)
Z Butanone 86.34 = 22.07 34.00
Z-Methyl 2-Pentene 0.000 = 7.279 0.000
3-Methyl Pentane 0.000 = 4.680 0.000
1,1,1,7 Tetrachloroethane 0.000 + 3.268 0.000
1-Pentene 0.000 = 7.626 0.000
Acetone 0.000 = 6.151 0.000
Chemical test
ppm©m
Z Butanone 436.59e-15
W T3 Y W ST —— 3
File Header View

The File Header View displays the contents of SPlI or RMMSoft formatted files. The File Header
View displays information concerning the spectral data that is contained in the file, the location
and user of the system (if a RMMSoft formatted file) and user memos. As with all RMMSoft views,
you may also select the font, font size, text color and background color for this display. See
Program Controls for further details.
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F$71118007i.dat (AIL backyard) : File Header =] E3

EATEST1118a07i.dat File Header

File name:

* Date:

* Start time:

* Stop time:

Stop scan:

Operator:

Location:

Town:
State/Province:
Country:

Retro location name:
Collect mode:

Integer type:

Scan size:
Resolution:

Scan speed:

Mirror velocity:
Sample frequency:
Start frequency:

Stop frequency:
Maximum wavenumber:
fEero crossing:
Coaddition count;
Data interval:

Round trip path length:
FTIR mode:

Ambient temperature:
Barometric pressure:
Humidity:

Wind speed:

Wind direction:
Sensor direction:
Sensor direction:
Precipitation:

Full scale count:

Full scale voltage:

E:ATEST'1118a07i.dat
11/18/98
15:58:18
15:58:50

1

JPK

AlL Systems Inc
Deer park

NY

usa

AlL backyard
Ground stationary
64 hit

28671

0.482117
0.000000
0.000000
0.000000
0.000000
7898.758942
¥898.758942

1]

|

L]

10

Active

1]

0.000000

1]

1]

1]

180

180

Ho precipitation
65536
10000000

FTIR Status Data

The FTIR Setup status data presents the collection conditions specified by the user. This is a
static display and no updates are shown. All data is taken from the values entered by the user on

the FTIR Setup dialog.

Scans to CoAdd

The number of scans that are to be summed and averaged to create the Co-added interferogram.

Coll Interval
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The time between the start of successive collections of interferograms (Collection Interval).

Resolution
The spectral resolution of the interferograms that will be collected in wavenumbers (cm™).

Round Trip Path
The total round trip path from the FTIR to the retroreflector and back (2 * the distance between the
FTIR and the retroreflector).

Mode
The mode of the FTIR (Active or Passive).

LN2 Refill System Pop-Up

The LN2 Refill System Pop-up displays information concerning the status of the LN2 refill system.
The Pop-up displays the state of the LN2 refill system, the current fill level (in percent full) for the
Detector and Supply dewars, and the LN2 loss (evaporation) rate for the Detector and Supply
dewars. The LN2 Refill System Pop-up is displayed via the Window — Liquid Nitrogen
Controller menu item.

NEA Noise View

The NEA Noise view displays the results of NEA Noise algorithm processing. It provides an
indication of the quality of data being generated by the system as a function of the FTIR noise.
The view displays the instantaneous and statistical NEA noise algorithm results for three spectral
regions, along with a indication of “In Spec” or “Out of Spec”.

The view is comprised of two display sections. The first is the display of instantaneous (frame by
frame ) NEA noise data and a second is a display of statistical data. Both sections display NEA
Noise data for three quiescent areas of the spectrum. For each region and section, the Noise (in
microAbsorbance Units), the Bias (in milliAbsorbance Units) and the Slope (in microAbsorbance
Units per inverse cm) are displayed.

The Instantaneous NEA Noise section will display every frame of NEA Noise results computed.
As a new frame is collected and processed, its NEA Noise results will be added to the bottom of
this display section.

The Statistical NEA Noise section will display the Minimum, Maximum, Mean and Standard

Deviation of the data collected. The “In Spec” “Out of Spec” evaluation is performed on the Mean
Noise of each region. If any one region is “Out of Spec” it is indicated at the top of the display.
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F,qlllgal?.r'l'l' {AIL backyard) : NEA Noise

NEA Noise Results
Region 1: 968 to 1008 cm-1 Region 2: 2480 to 2520 cm-1 Region 3: 4380 to 4420 cm-1
Frame Hoise Bias Slope Hoise Bias Slope Hoise Bias Slope
(LLALD (mal) |{LAUicm-1)| (LAU) (mal)  |[{LAUicm-1)| (LAU) imal)  |{lLAUCm.
1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
2 4.36e3 -F.27e3 -620 1.03e3 -7.2503 -84.9 4.08e3 -6.70e3 647
3 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
4 4,273 -f.26e3 -581 1.18e3 -7.2583 -38.6 3.43e3 -6.70e3 h22
Min 4.27e3 -F.27ed -620 1.03e3 -F.2583 -84.9 3.43e3 -6.70e3 h22
Max 4.36e3 -F.26e3 -581 1.18e3 -7.2503 -38.6 4.08e3 -6.70e3 647
Mean 4.32e3 -F.26e3 -601 1.11e3 72583 -61.8 3.75e3 -6.70e3 85
Std Dev 46.4 2.07 10.9 76.2 1.69 231 J23 J21e-3 62.5
Spec 283 283 H66
The statistics values are for frames 1 through 4.
4] |

As with all RMMSoft views, you may also select the font, font size, text color and background
color for this display. See Program Controls for further details.

Peak Amplitude Search View

The Peak Amplitude Search View a text and graph containing the results of the Peak Amplitude
Search function.

The Peak Amplitude Search view is comprised of a Grid coordinate display and a text display.
When the process is started the RAM 2000 positioner system will move the position of the FTIR
across the face of the selected retroreflector and fill in squares of the grid. The color intensity of
the squares on the grid indicates the returned signal strength. Once the process has completed
the program automatically displays the azimuth and elevation of the square that contains the
highest returned signal. You can find the square on the grid of the peak amplitude position by
using the Intensity control slider. Sliding the Intensity control until only one square is displayed
identifies the square that contained the highest signal amplitude during the peak search. At any
time the user can click the mouse on any square in the grid and the program will display the
square’s azimuth, elevation and signal amplitude in the view’s status bar.
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FSTRMMSoftl (Retro) : FTIR Peak Amplitude Search _ O] x|
Ij 1 1 1 ' 1 1 ' 0 0 L 'I-I_j'-ll ‘

Search criteria: Azimuth: from 51.000 to -49.000 in 0.250 degree steps.
Elevation: from -0.500 to 1.500 in 0.250 degree steps.

FTIR peak amplitude position: Azimuth: -49.000
Elevation: 1.000

X

1.500
1.250 -

1.000 -
0.750
0.500 -
0.250
0.000 -
0.250

-0.500 -.

51.000 50.250 _49.500
Azimuth (degrees)

Elevation (degrees)

Azimuth: -B0.000 | Elevation: 0500 | Amplitude: 518

Positioner System Pop-Up

The Positioner System Pop-up displays the current pointing angle of the FTIR attached to the
Positioner System. Itis updated as the Positioner system is moving. The Positioner System Pop-
up is displayed via the Window — Positioner menu item.

Site Status Data
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The Site data on the Status view presents the Site and Operator parameters as entered on the
Site Setup dialog. Data content on this view and update periodicity is dependent upon the
configuration of your system. If your system has a Positioner system attachment, the RMMSoft
program will display two parameters for sensor azimuth and elevation. If your system does not
have a Positioner system attachment, then the RMMSoft program will present the Sensor
Direction values entered on the Site Setup dialog.

Name
The operators name.

Site
The name of the site for which data was taken.

City
The City name at which the data was taken.

State
The State name at which the data was taken.

Sensor Direction
The azimuth (pointing angle) of the FTIR from the Site Setup dialog.

Sensor Azimuth
The azimuth (pointing angle) of the FTIR from the Positioner system.

Sensor Elevation
The Elevation (pointing angle) of the FTIR from the Positioner system.

Signal Status Data

The Signal Status data on the Status view presents information describing the Signal data
currently being collected / processed.

Alarm

The current highest alarm value of any chemical for which a concentration was computed by the
program (None, Warning, Trigger). See Signal Processing Setup dialog for details as to the Alarm
processing features of the system.

Interferogram / Absorbance / Single-Beam
The current Scan Number of the Signal Spectrum being processed. The views’ label reflects the

spectral format of that signal spectrum, either Interferogram, Absorbance, or Single-Beam.

Frame
The frame number of the current signal spectrum being processed.

Time
The data and time at which the data was collected.

Data
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A color code indicating the relative goodness of the input signal spectrum as a function of the data
quality checks of the program.

Zero Burst Position

The position of the zero burst. During normal collections the RMMSoft program aligns all
interferograms to position 257. In the Alignment mode, the zero bursts are not aligned and
therefore this value will change.

ZPD P-P

The peak-to-peak voltage of the Zero Path Difference (ZPD) point of the incoming signal. The
Incoming signal data is in the range of £ 5 volts. The computation of the ZPD P-P value is from
the small negative value to the largest positive value and is displayed as a number between

0 - 10 volts.

% Full Scale
The % of full-scale display is an indication of dynamic range of the signal strength. It is a measure
of the largest peak (positive or negative) of the ZPD versus the 1/2 the full scale value (5 volts).

For example: if the largest ZPD peak is the positive peak and its maximum value is 4.2
volts the % full-scale value is:

4.2/5.0=84%

Gas Cell
The name of any gas currently being flowed through the calibration gas cell in the FTIR.

Gain

The current gain setting used to collect interferograms. If you have set the gain setting to Auto (on
the FTIR Setup dialog) the value presented represents the gain setting automatically computed by
the software.

Scans CoAdded
The number of individual scans Co-added together to form a signal interferogram. The number of
scans to co-added are specified on the FTIR Setup dialog.

Scans Discarded

The number of individual scans that failed any of the interferogram quality checks and therefore
were not co-added into the signal interferogram. If the Save discarded Raw Scans to File option
was selected, each discarded scan will be saved to a Discard file .

Spectral Library Search Graphic View

The Spectral Library Search graphic view is a variation of the Concentration Graphic View . The
view shows the chemical concentrations for the current frame. The presentation and options for
the view are the same as for the Concentration graphic view except that:

- Negative concentrations are displayed.

- Only those chemicals whose absolute value of concentration to goodness of fit ratio in
the current frame is greater than the value specified on the Spectral Library Search
options dialog are displayed.

- Sorting by Percent Of Trigger is not supported.

72



Note that a new sorting criterion, Concentration to Goodness of Fit ratio, has been added to the
Concentration graphic view and is available with the Spectral Library Search graphic view.

Since negative concentrations are displayed, the 0 line is not always at the bottom of the graph as in the
Concentration graphic view. As a consequence of this, the 3D Bar Chart histogram may be visually confusing. If this is

the case, use the 2D Bar Chart instead.

Spectral Library Search History View

The Spectral Library Search History view is a variation of the Concentration History graphic view .
The presentation and options for the view are the same as for the Concentration History graphic

view except that:

- Negative concentrations are displayed.
- Only those chemicals that were detected in at least one frame of the concentration

history are displayed.

Even though all chemicals are not displayed, the number of chemicals displayed may be larger
than 32. Since only 32 colors are available for coloring the chemical traces, the colors are reused
when more than 32 chemicals are displayed. Use the feature of clicking on a chemical name at
the bottom of the view to cause the name and the associated trace to blink to distinguish among

multiple traces with the same color.

= 0721e86_fullrlt : Spectral Library Search History
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Spectral Library Search Text View

The Spectral Library Search text view shows that chemical concentration data in a sortable list
view. The view shows the chemical concentration data for the current frame. Click on the header
of any column to sort the data by that value. Click on the header again to sort the data in the
reverse order.

The only view options applicable to the view are the font size, the selection of concentration units
and whether or not low confidence data is to be displayed.

=1 0721286 _fulllt : Spectral Library Search Text

Chemical Hame Detected | Conc/GOF | Concentration [ppm®m] | Goodness of Fit [ppm®m] -
Carbon Monoside Yez 208 26.4 1.27
Formic Acid Tes AT 125 1.E5

b ethane Tes .44 291 452
biz-Chloromethl ether Yes -5.96 -2.58 433e-3
Puridine ez AE1 308 R.AN
Ozone Yes 485 379 T82e-3
Tributyl phozphate Yes 473 287e-3 B0.0e-3
Bromoform Tes 438 1348 a15
Chlorotrifluoromethane e -4.34 -1.00 230e-3
Acmylic Acid Yez 116 h.a4 1.40
Perosy acetyl nitrate ez 363 207 hE2e-3
Carbon dioside Tes 2E1 11.0 208
Benzotrichloride Tes 342 -9.68 283
Acetone e -3.41 -16.6 4 86
n.h-Dimethylformannide Yez -3.22 -3.70 1.15
izo-Butanol Tes 2498 1.52 E44e-3
1.1 Dimethylhydrazine Yes -2.61 -1.69 G43e-3
p-Crezol Yes -2 55 -6.93 274
Ethwl acrylate Yes -2.51 -1.80 719e-3
Hexachloro-1,3-Butadiene Yez -2.02 -917e-2 4533
1.1 Dichlaroethane Mo 0.00 0.00 4.94 ;I

Spectral Library Search Views

The Spectral Library Search views present the results of the Spectral Library Search algorithm in
graphical and textual forms.

Due to the generalized nature of the Spectral Library Search algorithm the specific values
associated with any reported chemical detections must be examined to decide whether a chemical
is actually present in the environment. Personnel with some familiarity with spectroscopy should
review these results. A general guideline for interpretting the results is that when the concentration
to goodness of fit ratio for a chemical is greater than 10, it is very likely that the chemical is in the
environment.

Spectral Library Search Graphic View
Spectral Library Search Text View
Spectral Library Search History View

Status Bar
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The status bar, which is a horizontal area in RMMSoft below the document window, provides the
current state of the program, user messages, and the status for hardware devices (FTIR, LN2
Refill system and Weather Station) attached to the system.

Pane Number Used for
1 Indicates the current state of commands for the system. When the program is
waiting for commands, this pane will state “Ready”.

2 User messages.

3 Provides a Red, Yellow, Green indication of the status of the LN2 Refill system.
Moving the mouse over the pane will cause a Pop-Up window to be displayed
that will provide textual information on the hardware status.

4 Provides a Red, Yellow, Green indication of the status of the Positioner system.
Moving the mouse over the pane will cause a Pop-Up window to be displayed
that will provide textual information on the hardware status.

5 Provides a Red, Yellow, Green indication of the status of the W eather Station.
Moving the mouse over the pane will cause a Pop-Up window to be displayed
that will provide textual information on the hardware status

When in Remote Viewer mode viewing multiple RAM 2000 systems panes 3 - 5 will display the
highest hardware alarm status of all systems being viewed.

Status View

The Status View displays information on the Background or Signal status, FTIR status, Weather
Conditions and Site information. Data is updated for each frame of data. Click on any data group
below for an explanation of the data presentation.
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= [TESTROSE.RL = |

SIGHAL STATUS
Alarm: HOME
Interferogram: 1
Frame: 1 of 25
File: TESTROSE.DAT
Time: 010297 15:03:28

Data: [

fero Burst Pos: 257
ZPD P-P; 4.28 volis
% Full Scale: 53.7
Gas Cell: Hone

MEA noise: N
Gain: 1%

Scans CoAdded: 1
Scans Discarded: 0

FTIR SETUP
Scans to Cofdd: 1
Coll. Interval: 15 Sec
Resolution: 0.5 cm-1
Round Trip Path: 5 m
Mode: Active

SITE
Hame: J. Stone
Site: AlL Systems
City: Deer Park
State: NY
Sensor Dir: 340 deg

WEATHER
Temp: 294.7 den. K
Humidity: 41 %
Pressure: 1011 hPa
Wind Speed: 1.99 misec
Wind Dir: 348 + 27 deg

Spectral Views

The RMMSoft program supports display of the following spectral views. These are:

Absorbance
Transmittance

Signal Single Beam
Background Single Beam
Signal Interferogram
Background Interferogram

Arbitrary

NEA Noise Absorbance

The views currently available for display depend upon the mode of operation selected and the
current state of processing the spectrum. When in the Collect Data and Process mode, you may
display the Interferogram, Absorbance, Transmittance and Single Beam views simultaneously.
That's because the RMMSoft program automatically calculates each of these spectral formats
internally during processing. No user interaction to command a spectral conversion is needed.
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Each spectral view window provides its own toolbar controls for controlling the display of data.
The toolbar controls are described below:

E The Show RMS button will allow you to compute statistics of a
user selectable area of the spectrum. The statistics computed
Show RMS are the Minimum, Maximum, Mean, Standard Deviation and

RMS Noise of the spectral area selected. To use this
command, perform the following steps:

1. Press the Show RMS button.

2. Bound the area of interest by clicking and holding the left
mouse button at the top left corner of the desired rectangle
and then dragging the mouse to the bottom right corner of
the rectangle.

The Scale Vertically On Frame Change button determines
whether the view is to be automatically scaled vertically when
the frame number of the data being displayed changes. The

Scale Vertically L
button is displayed as depressed when enabled, not pressed

On Frame hen disabled
Change when disabled.

The UnZoom button restores the display to full size.
UnZoom

The Scale Vertically button will expand the current display to fill
the vertical extent of the view.

Scale Vertically

The Scroll Left button will cause the data viewed to be shifted to
the right by half the size of the display. Holding the button down
Scroll Left will cause the process to repeat continually. This function can
also be accomplished by pressing the Cntrl + Page Down keys.

The Scroll Right button will cause the data viewed to be shifted
to the left by half the size of the display. Holding the button
down will cause the process to repeat continually. This function

Scroll Right . )
can also be accomplished by pressing the Cntrl + Page Up
keys.
The Scroll Up button will cause the data being viewed to be
shifted down by half of the size of the display. Holding the
Scroll Up button down will cause the process to repeat continually. This

function can also be accomplished by pressing the Page Up
key.

The Scroll Down button will cause the data being viewed to be
shifted up by half of the size of the display. Holding the button
down will cause the process to repeat continually. This function

Scroll Down X -
can also be accomplished by pressing the Page Down key.
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The Pan Left button will cause the data viewed to be shifted to
the right by one data point. Holding the button down will cause
the process to repeat continually. This function can also be

Pan Left
accomplished by pressing the Shift + F6 keys.
The Pan Right button will cause the data viewed to be shifted to
the left by one data point. Holding the button down will cause
Pan Right the process to repeat continually. This function can also be

accomplished by pressing the F6 key.

The Contract Horizontally button will cause the view to display
more data points in the horizontal ( X ) axis. Holding the button
down will cause the process to repeat continually. If a crosshair
marker has been placed on the view, the display will contract
around the crosshair. This function can also be accomplished
by pressing the Cntrl + Right Arrow keys.

Contract
Horizontally

The Expand Horizontally button will cause the view to display
less data points in the horizontal ( X ) axis. Holding the button
down will cause the process to repeat continually. If a crosshair
marker has been placed on the view, the display will expand
around the crosshair. This function can also be accomplished
by pressing the Cntrl + Left Arrow keys.

E x p and
Horizontally

The Contract Vertically button will cause the view to display
more data points in the vertical ( Y ) axis. Holding the button
down will cause the process to repeat continually. If a crosshair
marker has been placed on the view, the display will contract
around the crosshair. This function can also be accomplished
by pressing the Cntrl + Down Arrow keys.

Contract
Vertically

The Expand Vertically button will cause the view to display less
data points in the vertical ( Y ) axis. Holding the button down
will cause the process to repeat continually. If a crosshair
marker has been placed on the view, the display will expand
around the crosshair. This function can also be accomplished
by pressing the Cntrl + Up Arrow keys.

E x p and
Vertically

Zooming the display

There are two different methods to Zoom the display. The first method uses the mouse to bound
a rectangle encompassing the area of the display that you wish to zoom. This is accomplished by
clicking and holding the left mouse button at either the top left or lower right corner of the
rectangle, dragging the mouse to the opposite corner and then releasing the left mouse button.

The second method involves the Zoom command on the View menu. The Zoom command
allows you to enter directly the starting and ending wavenumber that you wish to zoom to. You
may access this command via its shortcut keys (Alt + Z).

Placing a Crosshair marker

You can determine the exact wavenumber and amplitude of any peak on the view by placing a
Crosshair marker on the display. To place a Crosshair marker, press the Right mouse button at
the desired location on the display. The Wavenumber (X) and Amplitude (Y) values will be
displayed at the top right of the view. If the position chosen is not exactly on a point on the graph,
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you can force the Crosshair to the nearest graph point by pressing the Down Arrow key. You can
move the Crosshair marker via the Left and Right Arrow keys on the keyboard. When you place
the Crosshair marker on a spectral view all the scroll, expand, contract and page functions will be
centered on the Crosshair.

Deleting the Crosshair marker
You can delete the Crosshair marker by pressing the Delete key.

Displaying the spectrum’s memo field
As the default, the view displays the first 64 characters of the spectrum’s memo field below the
graph. You can toggle this display on and off by pressing the Insert button.

Weather Data Pop-up

The Weather Data Pop-up displays the weather data for a frame selected by the user. This
display is available only from the Concentration History Graphic View.

To display the weather data, move the mouse over the Concentration History graph near the
frame number you wish to view weather data and press the left mouse button. The program will
display the weather data for that frame number. The weather data Pop-up is moveable and can
be reselected for another frame by again clicking the left mouse button over the graph near the
next desired frame number.
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Weather Data

The Weather data on the Status view presents the weather data currently stored in the system. If
your system has a Weather Station, then this data represents the weather conditions for the
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period of interferogram collection and will be updated after the collection of each Co-added
interferogram. If your system does not have a weather station, then the operator enters this data
on the Site Setup dialog. It will not be modified during the duration of program execution.

W eather data can be presented in either English or Metric units. This selection can be made on
the View menu. The units for the various parameters in English and Metric units are as follows:

Parameter English Unit Metric Unit
Temperature Degrees Fahrenheit Degrees Kelvin
Pressure Inches of Mercury MilliBars

Wind Speed Mile per Hour Meters per Second
Temp

The temperature in degrees.

Humidity
The relative humidity (as a percent of full saturation).

Pressure
The barometric pressure.

Wind Speed
The wind velocity.

Wind Dir
The wind direction and the wind direction variation (c®) in degrees from North.

Program Controls

Toolbar

The RMMSoft program provides a toolbar of the most commonly used commands to facilitate
ease of use. You can click on toolbar buttons as a shortcut to using the commands on the menu
bar.

New
Creates a new document in which to perform work in. Selection of this command will bring
up the New File dialog, which allows you to select the operation that you wish to perform.

Open
Opens an existing file. Selection of this command will bring up the File dialog, which will

allow you to select the file to replay.

Save
This command is currently not available.

Print
Print the currently selected (highlighted) view to the printer.

Go

When collecting data from the FTIR, this command will cause the program to collect
Interferograms from the FTIR as specified by the user in the FTIR Setup dialog. When in
the Process from File or Replay modes, this command will continuously step through the
data, until stopped by the user or until the last frame of data is reached.
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Step Forward
When collecting data from the FTIR, this command will cause the program to collect one

frame of data from the FTIR, as specified by the user in the FTIR Setup dialog. When in
the Process from File or Replay modes, this command will cause the program to step
forward to the next sequential frame of data.

Step Backward
Step backward to the previous frame of data. This command is only available in the

Replay mode.

Fast Forward

Rapidly step forward until stopped by the user or until the last frame of the data is reached.
This command is only available in the Replay mode.

Rewind

Rapidly step backward until stopped by the user or until the first frame of the data is
reached. This command is only available in the Replay mode.

Stop
Stop the current collection, or processing. Does not stop dialog-based activities such as

Tools operations (Create Spectrum, Create Interferogram, ETC).

Help
Brings up the on-line help

Analysis Menu
Control Menu

Start Command

The Start command will cause the system to start the processing of data.

In the Playback mode it will cause the system to continuously step through the recorded data until
stopped by the user or until the last frame of data is reached.

In a Collection mode, it will cause the system to begin the collection of data from the FTIR until the
stop condition is reached or until the user commands the system to stop.

In an Analysis mode it will cause the system to begin the collection and processing of data from
the data source (file or FTIR). Processing will continue until the stop condition is reached or until
the user commands the system to stop.

RMMSoft supports a special case start situation when multiple collecting documents have been

setup. In such a situation, all documents are started when the Start button is pressed, with each
document collecting (and processing) a frame before any document collects the next frame.

Stop Command

The Stop command stops the current action.
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Step Command

The Step command will cause the system to step forward to the next sequential frame of data
from the data source (File or FTIR).

In the case of multiple collecting documents, the next frame of the next document is collected.

BackStep Command

The Step backward command will cause the system to step backward to the previous frame of
data. This command is only available in the Playback mode.

Fast Forward Command

The Fast Forward command will cause the system to rapidly step forward until stopped by the
user or until the last frame of the data is reached. This command is only available in the Playback
mode.

Rewind Command

The Rewind command will cause the system to rapidly step backward until stopped by the user or
until the first frame of the data is reached. This command is only available in the Playback mode.

Start Liquid Nitrogen Fill

When collecting data from the FTIR, the RMMSoft program provides the capability to manually
command a LN2 refill of the internal dewar in the FTIR. This can be accomplished via the Start
Liquid Nitrogen Fill command location on the Control menu. This command will schedule a LN2
refill prior to the start of the next Interferogram collection.

Edit Menu

Spectral Truncation

The RMMSoft program provides the capability to truncate Absorbance, Transmittance and Single-
Beam spectra to specified ranges. This capability is not provided for multi-record files. To
truncate a spectrum and store it to file, perform the following steps:

2) Highlight the spectral view.

3) Select the Spectrum command on the Edit menu.

4) Select the Truncate command. The Frequency Range dialog will appear.
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5) Either:
a) Enter the Start and End frequencies into the edit controls and press OK.

b) Or, if you wish to truncate the spectrum to the frequencies currently being displayed on
the view; Press the Truncate to displayed frequency range button.

Copy

The copy command provides the capability to copy a display and paste it into another application,
such as a graphics program. To copy a view, perform the following steps:

1. Highlight the view to be copied.
2. Select the Copy command on the Edit menu.

3. Open the graphics program that the image will be inserted into and perform a Paste operation.

Processing Source Parameters

Non-Spectral Parameters Dialog

This dialog provides the capability to modify the exiting values of non-spectral system parameters.
This dialog is especially useful when reprocessing data from a file in the Process from File Mode
when initial values that have been stored to file were incorrect.

Dialog Options

Round Trip Path Length (meters)
The currently stored value of the round trip path length (2 * FTIR to Retroreflector distance) is
displayed. Enter the desired round trip path length in meters.

Spectral Parameters Dialog

The Spectral Parameters dialog provides the capability to modify preset processing parameters
concerning the spectral data. Itis only available in the Process from File Mode . This provides a
method to correct Signal Files which may have incorrect spectral parameters stored in the file.

Dialog Options

Resolution (cm-1)
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This edit control initially indicates the currently stored value of the spectral resolution. Enter the
desired spectral resolution as a function of the exact laser frequency.

Start Frequency (cm-1)

This edit control initially indicates the currently stored value of the start frequency of the FTIR.
Enter the desired start frequency in cm-1.

Stop Frequency (cm-1)
This edit control initially indicates the currently stored value of the stop frequency of the FTIR.
Enter the desired stop frequency in cm-1.

File Menu

New File Options

The New File Options dialog is used to select the mode of operation or activity that you wish to
perform for the new document that you are creating.

Dialog Options

File Options Group
This group provides the selection of the mode of operation or activity that you wish to perform.

Collect New Background
Select this radio button to collect an interferogram to use as a Background Spectrum .

Collect Data without Processing
Select this radio button to collect Signal Spectrum without concurrent analysis.

Collect Data and Process
Select this radio button if you wish to concurrently collect and analyze signals in real-time.

Process Data from File.
Select this radio button to analyze Signal spectra from a file.

Chemical Setup
Select this radio button to create a new Signal Processing Information (SPI) file. This will
allow you the capability to create a Signal Processing Information file.

Save Options Group

These radio buttons provide the capability to specify the conditions for which spectral and
processing results data will be saved. The allowable options are dependent upon the mode of
operation selected. Disallowed options will be grayed.

All Data and Results
Every frame of collected spectra along with each spectrum’s processing results are saved to
Signal file and a Results file.

Above Warning Alarm
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Only those frames of collected spectra, along with its associated processing results, in which
one or more chemicals are above a user specified Warning alarm level are saved to a Signal
file and a Results file.

Above Trigger Alarm
Only those frames of collected spectra, along with its associated processing results, in which
one or more chemicals are above a user specified Trigger Alarm level are saved to a Signal
file and a Results file.

None
No spectral or processing results are saved to file.

Data to Save Group

This group box will display the allowable file formats that the Spectra and Processing Results can
be saved into. The program will only display valid file formats for the mode of operation selected.
Click on the checkbox next to the file format desired to enable or disable the saving of data.

Enable automatic file naming
Provides the capability to control the size of data files by:

1.
2.
3.

Allowing the program to generate all flenames automatically.

Limit the size of files to a specified condition (time, or number of frames ).

Automatically generates new files when the previous ones are closed. This occurs when the
current files exceed their specified size.

Automatic file naming options Group

Change file name every. ..

Select the units of the limiting condition (Frames, Seconds, Minutes, Hours, or Days) from the
list box based upon your needs. Provide the number of units that you wish to limit the file size
to.

For Example:
If you wish to have new file for each week of operation, enter 7 in the edit line and select
the units Days.

Letter to use to customize file names . ..
For each document you open, provide a unique letter for the filename. The automatic file
name processing in the RMMSoft program builds a filename in the form:

MMDDXxNNT.EXT

Where: MM - is the 2 digit Month.
DD - is the 2-digit day of the month.
X - is a one-digit user selectable letter.
NN - Is a 2-digit sequence number.
T - Is the spectral type designator
.EXT - is the filename extension.
Where T=

A - Absorbance
F - Final Single Beam Background

85



I - Interferogram
S - Single Beam
T - Transmittance

Where .EXT =

.DAT - A Spectralfile.

.BGD - A Background spectrum file.
.RLT - A Results File

.SPC - A SPC formatted Spectral file.

For each document that you will create you will need to provide a different custom letter for
the filename to prevent the program from over-writing data from one document to another.
Typically this designator is used to specify the beampath.

For Example:
If your system has a Positioner system that points to two retroreflectors,
you would need to create two documents (via the New command on the
File menu). You would provide the letter “A” in the first document for the
selectable filename letter and “B” in the second document for the second
selectable filename letter.

Synchronize file name changes to. ..

The program provides the capability to specify the time to which all automatically generated
files will be synchronized. The program will use the time provided from this control and the file
changing periodicity control (Change file name every .. .) to determine the time at which files
should be automatically stopped and re-started with a new automatically generated
flename(s). The time entered is always referenced to the current day. The time is entered in
the format:

HH:MM
Where:
HH - is the Hours in 24 hour (Military) time from 00 (12 Midnight)
to 23 (11:00 PM).
MM - is the minutes from 00 to 59.

For Example:

In the example below, the user has setup the system to collect and process data in real-
time saving both the Interferograms and processing results. The file
names will be generated automatically and will be synchronized such
that they are changed every day at 12:00 AM (midnight). All filenames
generated for this beampath will have the designator “a” in the name.
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Export Data to File

The Export Data to File dialog provides the capability to save data in the current Document to that of
another format. This is similar to the “Save As” capability.

Dialog Options
Data to Export

Select the type of data that is to be exported. Only that data that is currently valid in the document
will be available for export.

Format Select
Select the type data format the output will be exported in. Available options are:

LabCalc
Select this radio button to select the LabCalc file format for the output file.
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Grams
Select this radio button to select the Grams file format for the output file.

Grams for Macintosh

Select this radio button to select the Grams file format for the Apple / Macintosh computer
systems.

Delimited ASCII text

Select this radio button to convert the data to Delimited ASCII text.

Export File
This button will bring up the dialog to select the file to process data from.

Options Menu

Advanced System Configuration Dialog
The Advanced System Configuration dialog provides the ability to edit parameters that control the
liquid nitrogen fill cycle and the acceptance criteria for FTIR raw scans.

WARNING: Incorrect settings of any of these parameters may cause damage to the RAM2000
hardware and/or collection of poor quality data.

These parameters are separated from the LN2 Controller Configuration Dialog and the FTIR
Setup Dialog since it is potentially dangerous for the values to be changed.

Dialog Options

Liquid nitrogen fill cycle group

Filling the FTIR dewar with liquid nitrogen is done by cycling the transfer of liquid nitrogen on and
off to allow time for the transfer hardware to reach liquid nitrogen temperature and to minimize the
possibility of spilling liquid nitrogen.

Fill time
Specifies the number of seconds to transfer liquid nitrogen from the tank to the FTIR dewar
before waiting.

Time between fills

Specifies the number of seconds to wait after stopping the transfer of liquid nitrogen before
starting to fill again.

Maximum consecutive fill cycles

Specifies the maximum number of on/off cycles before returning to collecting FTIR data.

FTIR raw scan acceptance tests group

Several tests are performed on each raw scan collected from the FTIR to check for good quality
data. If the raw scan fails any of the tests, the raw scan is discarded.

Minimum voltage
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Specifies the minimum peak to peak voltage at the zero path difference point to accept the raw
scan.

ZPD position tolerance
Specifies the number of points that the zero path difference point is allowed to move relative to
the calibration scan to accept the raw scan.

Beam block threshold

Specifies the percentage of the full scale count value of the FTIR A/D converter below which a
beam block is declared and the raw scan is discarded. The value compared to the threshold is
the peak to peak amplitude at the zero path difference point of the raw scan.

Clipping magnitude maximum tolerance

The raw scan is checked to determine if it is clipped at the zero path difference position. All
magnitudes used in the test are absolute values of the actual magnitudes. The raw scan is
considered clipped (and is discarded) if the magnitude of the point at the zero path difference
position is within the clipping magnitude maximum tolerance of the maximum FTIR A/D count
value and the magnitude of either point adjacent to the zero path difference position is within the
clipping magnitude delta threshold of the zero path difference magnitude.

Clipping magnitude delta threshold

The raw scan is checked to determine if it is clipped at the zero path difference position. All
magnitudes used in the test are absolute values of the actual magnitudes. The raw scan is
considered clipped (and is discarded) if the magnitude of the point at the zero path difference
position is within the clipping magnitude maximum tolerance of the maximum FTIR A/D count
value and the magnitude of either point adjacent to the zero path difference position is within the
clipping magnitude delta threshold of the zero path difference magnitude.

Largest delta noise allowed

The raw scan is checked to determine if there is too much noise in the data. The standard
deviations of every other span of 250 points of the raw scan are calculated. If the difference in
the standard deviations of any two adjacent spans is greater than the largest delta noise
allowed the raw scan is discarded. The largest delta noise is specified as a voltage ratio that is
typically derived from a desired noise in dB. For example, to specify a largest delta noise value
corresponding to 30dB the value is 10**(30/20) = 31.6228.

Largest mean difference allowed

The raw scan is checked to determine if there is a discontinuity in the data. The arithmetic
means of every other span of 250 points of the raw scan are calculated. If the difference in the
means of any two adjacent spans is greater than the largest mean difference allowed the raw
scan is discarded.

Automatic Start Dialog

The Automatic Start dialog provides a means of configuing RMMSoft to automatically start when
Windows starts. When automatic start is enabled, RMMSoft will start and run the specified macro
file the next time Windows starts. RMMSoft can be configured to start either before or after user
login. On computers with that are configured to start without user login, RMMSoft starts when
Windows startup is complete.
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Dialog Options

When Windows starts Group

Don’t start RMMSoft
RMMSoft is not started when Windows starts.

Start RMMSoft before login

RMMSoft starts after Windows starts before any user logs in. Normal network access may not
be available based on the host network configuration. Use this option only if starting after login
cannot be supported in the host configuration.

Start RMMSoft after login
RMMSoft starts after a user logs in after Windows starts. This is the option that should normally

be selected for automatic start.

Macro file to run when starting automatically

Specify the macro file to run when RMMSoft starts automatically.

Working directory when starting automatically

The working directory to use when RMMSoft starts automatically. This path defaults to the
current working directory of the application.

utomaic Stan
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Detected Chemicals Window dialog

The Detected Chemicals Window dialog provides the capability for setting the conditions for which
the Detected Chemicals Window Popup View will be displayed.

Dialog Options

Display the Detected Chemicals Window group

Select the condition for which the Detected Chemicals Window View will be displayed. The
available selections are:

90



When a chemical is detected.

When a chemical is detected above its warning threshold
When a chemical is detected above its trigger threshold
Never

Display Views of Collecting Document

This option provides the capability to have the program automatically switch the views displayed
(Status, Concentrations, Concentration History, ... etc.) to the document currently collecting data
from the FTIR. This is useful when collecting data from multiple retroreflectors when used with the
optional positioner system.

Diagnostics Dialog

This dialog provides the capability to enable / disable the storing of diagnostic data. Currently
there are two types of diagnostic data that can be stored, discarded raw scans and Status
Messages.

Dialog Options

Save discarded FTIR raw scans to file

The RMMSoft program performs numerous data validity checks on each raw scan (an individual
unco-added interferogram) prior to processing. This assures that the data used in processing is
the highest quality. Any scans that do not pass all data quality checks are rejected from
processing. These raw scans can be stored into a file for later review to determine the reason that
the scan was rejected. Enabling this option will cause each rejected scans to be saved to a
Discard file .

Save status messages in the log file

The RMMSoft program displays status messages during processing on the Status Bar. These
messages indicate the results of processing, errors encountered, and other pertinent information.
Enabling this option will cause these messages to be stored in the Log file for later review.

File Locations Dialog

The File Locations Dialog provides the capability to select the drives and directories in which
RMMSoft files are stored and retrieved. Click on the Modify button to change the values stored in
the dialog.

Font Dialog

The RMMSoft program provides the capability to select the font, font size and font style for each
individual view. A different font, font size and font style can be selected for each view. To select a
font, perform the following steps:

1. Select the desired view.
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2. Bring up the Font dialog from the Options menu.

3. Select the font, font size and font style for the view. The parameters selected will be
previewed in the Sample preview window.

4. Press the OK button.

Prompt for Missing Files on Open

The RMMSoft program generates different data files for signal data, and results data. The Results
file points the Signal file that contains the data used for generating the analysis results. When
opening a Results file it will attempt to open the Signal file at the same time. If the Signal file is
not present, the program normally would prompt the user to provide the path to the file, even
though the results data is usable without it. When enabled, this option would prevent the program
from prompting you for the missing files.

Remote Viewing Options dialog

The Remote Viewing Options dialog provides the capability to set the parameters for remotely
viewing RAM 2000 system data that is connected on the same computer network.

Dialog Options

Remote Update Interval
Enter the time between updates for polling the remote computer for a change in data. The lower
the number the faster the updates (and the larger the network bandwidth used).

Update Results Only
Check this checkbox if you want only the remote processing Results data updated from the
remote drive. Selecting this option reduces the network bandwidth used.

Remote Hardware State Button layout

When monitoring multiple RAM 2000 systems, the program will display the Remote Hardware
State toolbar. The data on this toolbar may be vertically or horizontally arranged. Select the
organizational layout that is desired.

Sound Dialog

The program provides the capability to enable / disable individual sounds emitted by the system.
The different sounds that the program emits are listed in the Sound Events listbox. Sounds that
are enabled are indicated by a Speaker symbol to the left of the sound event.

To enable / disable a sound event, select the desired sound event and press the Enable / Disable
button. The name on the button will change automatically based upon the current state of the
selected sound event.

Spectral Library Search Options Dialog

The Spectral Library Search Options dialog provides the ability to edit the parameters that control
the display of spectral library search results.
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Dialog Options

Minimum magnitude of concentration/GOF to consider a chemical detected

The minimum magnitude (absolute value) of the concentration to goodness of fit ratio of a
chemical for the chemical to be considered detected and thus displayed on the spectral library
search graphic view.

Suppress Future Scan Time Warnings

The Suppress Future Scan Time Warnings option provides the ability to prevent display of the
Future Scan Time Warning Dialog dialog when opening a file that contains a scan time that is in
the future. The menu item is checked if future scan time warnings are suppressed and unchecked
if future scan time warnings are enabled.

Time Zone Dialog

The Time Zone dialog provides the ability to select what time zone to use when displaying or
comparing times in stored data. For most situations the time zone associated with the data should
be used. One situation where the time zone to use selection would be changed is if data had been
taken on a computer where the time zone was set incorrectly.

W hile collecting and processing data the time zone to use should always be the time zone
associated with the data to avoid confusion. Certain times, such as the time of the next file
change, are always presented in the time zone selected for the operating system for similar
reasons.

It is important that the right time zone is used when comparing times, such as when creating a
Daily, Weekly, Monthly Summary since all times are based on the time zone in use. For example,
a daily summary looks for data tagged between 00:00:00 and 23:59:59 of the appropriate day, but
00:00:00 Eastern Standard Time is a different time than 00:00:00 Pacific Standard Time.

Legacy data, produced by RMMSoft versions earlier than 3.1, does not contain time zone

information with the data. The time zone to use for data with no associated time zone is specified
separately on the dialog.

Dialog Options

Time Zone to use Group

Time zone associated with data
The time zone used will be the time zone associated with the data. This is the default selection
and should only be changed for special situations.

Time zone selected for the operating system
The time zone used will be the time zone selected for the operating system.

Specified:
The time zone used will be the time zone selected in the combo box.

93



Time Zone to use if no associated time zone in data Group

Time zone selected for the operating system
The time zone used will be the time zone selected for the operating system.

Specified:
The time zone used will be the time zone selected in the combo box.

Time Zone
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Use Global View Options

The Use Global View Options provides the capability to apply selected View menu commands to
all views in the system. When you enable this feature any modifications to the Concentration
Units, Weather Units and Display Low Confidence Data settings will be applied to all system
views. When this feature is disabled, modifications to these command settings will only be
applied to the selected view. All other views will revert to their previously setup state.

View Title dialog

The View Title dialog provides the capability to select the title(s) that appear on the system views.
This allows you to customize the view titles as required for your site. At least one of the dialog
options provided must be selected at all times.

Dialog Options

Include document file name
Select this checkbox to display the computer node and filename on all views in the system.

Include retro location name

Select this checkbox to display the name entered on the Retro location name field from the Site
Setup dialog on all the views in the system.
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Device Configuration

FTIR Configuration Dialog

The FTIR Configuration dialog provides the capability to set the parameters of the FTIR interface
card that is installed in your P.C. The setting selected on this dialog must match the physical
setup of the FTIR Interface card, as indicated by the jumper settings, in order to ensure proper
communications between the P.C. and the FTIR.

Dialog Options
IRQ
Select the interrupt (IRQ) which has been set on the FTIR interface card. Insure that the IRQ

selected is not currently being used by other P.C. components.

1/0 Base Address
Select the I/O Base Address as it has been set on the FTIR interface card.

LN2 Controller Configuration Dialog

The LN2 Controller Configuration dialog provides the capability to set the parameters of the LN2
controller for your system. The setting selected on this dialog must match the physical setup of
the communications port (COM) selected for your PC in order to ensure proper communications
between the P.C. and the LN2 controller.

Dialog Options
COM Port

Select the COM port that the PC uses to interface to the LN2 controller. Insure that the COM Port
selected is not currently being used by other P.C. components.

Detector Dewar Group

Start Fill at ...

Select the LN2 level at which the LN2 controller should begin a refill cycle. The level selected
should not be so low that the detector in the FTIR becomes warm prior to the refill cycle
beginning.

Stop Fill at ...

Select the LN2 level at which the LN2 controller should stop a refill cycle. The level selected
should not be so high that the detector overfills. The detector may overfill since there is a
latency between the LN2 extracted from the Supply (external) dewar and the LN2 currently in
the detector.

Supply Dewar Group

Supply dewar probe connected
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Check this checkbox if your LN2 refill system Supply dewar has a LN2 level probe. This will
enable the RMMSoft program to monitor the Supply dewar LN2 level.

Warn when below % full
Enter the value (% full) at which you want the RMMSoft program to generate an alarm for a
low Supply dewar LN2 level.

Positioner Configuration Dialog

The Positioner Configuration dialog provides the capability to set the parameters of the Positioner
controller for your system. The setting selected on this dialog must match the physical setup of
the communications port (COM) selected for your PC in order to ensure proper communications
between the P.C. and the Positioner controller.

Dialog Options

COM Port
Select the COM port that the PC uses to interface to the Positioner controller. Insure that the COM
Port selected is not currently being used by other PC components.

Weather Station Configuration Dialog

The Weather Station Configuration dialog provides the capability to set the parameters of the
W eather Station controller for your system. The setting selected on this dialog must match the
physical setup of the communications port (COM) selected for your PC in order to ensure proper
communications between the P.C. and the Weather Station controller.

Dialog Options
COM Port

Select the COM port that the PC uses to interface to the weather Station controller. Insure that the
COM Port selected is not currently being used by other P.C. components.

Color

Color Dialog

The Color dialog provides the capability to customize the color schemes used throughout the
program. You can change the text, line and background colors for textual and graphical views.
The capability to specify colors is divided into Text and Plot colors. The colors that can be
specified are as follows:

Plot Window Background color.

Plot Window Trace (line) color.
Plot Window Text color.
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Text Window Background color.
Text Window Text color.

You can preview the color schemes selected in the Text Window Sample and Plot Window

Sample preview windows on the dialog. To change a color for a specific item, perform the
following steps:

1. Select an item to change by clicking the left mouse button on appropriate item. The current
color will be previewed in the Display Element Color preview window.

2. Press the Select Color button. This will cause a Color selection dialog to be displayed.

3. Select a preset color, or create a new color by pressing the Define Custom Colors button.

4. After selecting a color, press the OK button.

Colors For Chemicals Dialog

The Colors For Chemicals dialog provides the ability to specify the colors used for each chemical
on displays that use color coding for chemicals such as the concentration history graphics view.

Two default color sets are available as well as a custom color set where the all colors are
selectable.

Dialog Options

Use optimized default colors
Selects the optimized set of default colors.

Use original default colors
Selects the original set of default colors. These were the colors used in RMMSoft version 3.2.3
and earlier.

Use custom colors

Selects the custom colors. Modify the custom colors by dragging and dropping the colors to
change the color order or selecting a single color and clicking the “Edit Color” button to change
the color.

When custom colors are selected the “Set to Optimized” and “Set to Original” buttons are
available to reset the custom color set to one of the default color sets.
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Run Menu

Alignment

This menu item runs the predefined alignment mode macro. See Alignment Mode.

FTIR Peak Amplitude Search Dialog

This dialog provides the capability to enter the parameters required to perform the FTIR Peak
Amplitude search. Note that the range of values entered (in degrees) is dependent upon the
distance from the FTIR to the retroreflector. That is, a one-degree search at 500 Kilometers
covers more area than a one-degree search at 100 kilometers.

Dialog Options

Initial Center Position Setup Group

Azimuth
Enter the initial center position (in degrees) of the retroreflector as a starting point for the search.

Elevation
Enter the initial center position (in degrees) of the retroreflector as a starting point for the search.

Search Extent
Enter the maximum excursion (in degrees) from the initial center point for the search.

Search Step Size
Enter the step size (in degrees) that will be taken from measurement to measurement.
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Macro

This menu item displays a file dialog from which you can select a macro to run. See Macros.

NEA Noise Test

This menu item run the predefined NEA noise test macro. See NEA Noise Measurement.
Setup Menu

DCS Setup Dialog

The DCS Setup dialog provides the user interface to assign chemicals and system status’s to
specific Distributed Control System (DCS) channels for monitoring in a facility’s control room.

Dialog Options

Available Items to Monitor

This control lists the chemicals and system status’s that can be monitored on a specific DCS
board and channel. To select an item from this control, click the left mouse button over the item’s
name. The control will list all chemicals from all active documents collecting data in real time from
the FTIR.

Assigned Channels

This control lists the DCS board and channel numbers along with any current assignments. To
add or change an assignment for a board and channel, first select a item to monitor, then select
the desired board and channel, lastly press the Add button. To delete an assignment, select the
desired item and press the Delete button.

Add

This button will make an assignment for a selected DCS board and channel. To make an
assignment, select an item from the Available Items to Monitor control. Select a DCS board and
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channel for assignment, then press the Add button. An item previously assigned to that DCS
board and channel will be removed and placed back onto the Available Items to Monitor listbox.

Delete

This button will remove an existing DCS board and channel assignment. To delete an
assignment, select the DCS board and channel to remove and press the Delete button. The item
assigned to the DCS board and channel will be returned to the Available ltems to Monitor listbox.

FTIR Setup

The FTIR Setup dialog provides the capability to set the conditions for the collection of
interferograms from the FTIR, along with the condition of when to terminate collections. You must
perform FTIR setup prior to the collection interferograms and the parameters entered may not be
changed for a document once collection of data has started.

Dialog Options

Mode Group

Normal Collection

The Normal Collection option is used for all modes of operation except for aligning the FTIR
(see System Alignment ). Select this radio button is you wish to collect interferograms for use
as a Background Spectrum or a Signal Spectrum .

Alignment
Check this radio button to put the current document into Alignment Mode. This is used to
align the FTIR with its retroreflector.

Data Collection
Enter the number of scans that are to be Co-added together into a single Interferogram.

Resolution Group

Select the collection resolution for the Interferograms. The lower the value, the higher the
resolution (0.5 cm-1 is the highest resolution available). A higher resolution provides finer spectral
detail enabling better concentration determination. RAM 2000s’ spectral reference library
provides spectral files for 0.5 cm-1 resolution processing.

Collection start Interval Group

Specify the time between Co-added interferogram collections in Minutes and Seconds. If the
interval provided is greater than the time to collect the Co-added interferogram specified on the
Data Collection edit control, the program will collect data as fast as possible. The nominal time to
collect each interferogram at 0.5 cm-1 resolution is ~ 2 seconds. The time can be entered in
Minutes and Seconds or just in total seconds.

Minutes
Enter the whole number of minutes between data collections. For example, if the total time
between collections desired is 3 1/2 minutes, enter 3.

Seconds
Enter the number of residual number of seconds between data collections. For example, if
the total time between collections desired is 3 1/2 minutes, enter 30. If desired, enter the total
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time in seconds without entering a value in the Minute edit control. For 3 1/2 minutes, you can
enter 210 in the Seconds edit control.

Round Trip Path Length
Enter the total round trip distance between the FTIR and the retroreflector in meters (2 X
distance).

FTIR Mode
Enter the mode of the FTIR. This should always be setto ACTIVE.

Gain
Select the gain settings for the FTIR. The Auto gain setting allows the RAM 2000 system to
automatically detect the proper gain value to maximize the signal strength to appropriate levels.

Stop Conditions Group
Select the condition for which the system should stop collecting interferograms.

When Stop is Selected
This selection will cause the system to perform interferogram collection continually (for the co-
addition and collection interval parameters specified) until the stop button is pressed.

After ... interferograms are collected
If a specific number of interferograms is required to be collected, select this option and enter
the total number of Co-added interferograms to collect.

Memo
Enter any comments that may pertain to the collection. These comments will be stored in the
spectral file for later review.

Laser Wavenumber
Enter the Laser wavenumber of the system. This value is preset at the factory and should not be
modified.

Gas Calibration Dialog

The Gas Calibration Dialog allows you to specify the chemical and release rate used as a
calibrating gas. The dialog will allow you to select one chemical as the calibration gas.

Chemical

Select one chemical as the calibration gas. The chemicals shown is the listbox are those which
have been configured in the Signal Processing dialog as being for concentration computation.
Chemicals added as interferents on the Signal Processing dialog are not supported as a
calibration gas.

Concentration
Enter the concentration value at which the gas is to be flowed into the gas cell. This value can
typically be found on the cylinder containing the calibrating gas.

Units
Enter the units for the concentration of the calibrating gas. This can typically be found on the
cylinder containing the gas.

Site Setup
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The Site setup dialog provides the capability to enter data pertaining to the site conditions,
retroreflector locations, Liquid Nitrogen control, user name and the weather conditions during
processing. This data will be stored with the Signal and Results data for later review. You must
perform Site setup prior to the collection of signal spectra and the parameters entered may not be
changed for a document once collection of data has started.

Dialog Options

Location Group

Retro location name

Enter the name that best describes the location of this retroreflector. This name will appear
on all views containing data from this location if the Include retro location name command
on the View Title dialog is selected.

Site
Enter the name of the site at which this FTIR is taking data.

City/Town
Enter the City/Town of the site.

State/Province
Enter the State or Province name.

Country
Enter the country name.

General Group

Operators Name
Enter the operator’'s name

Date
The program automatically enters the date into the dialog. If desired, enter the date, in
MM/DD/YY format, at which data collection was started.

Time
The program automatically enters the time into the dialog. If desired, enter the time in
HH:MM:SS format.

Sensor Direction

If this is a fixed installation (no Positioner system attached to the FTIR), enter the bearing from
North that the FTIR is pointing.

Weather Group

Collect weather data from the weather station

If you have purchased a weather station (METS station) with your RAM 2000 system and wish
associated real-time weather data with the signal data, select this checkbox. This will disable
all other Weather Group controls.

Temperature
Enter the current temperature in degrees Kelvin.

Barometric Pressure
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Enter the current Barometric Pressure in inches of Mercury.

Humidity
Enter the Relative Humidity as a percent.

Wind Speed
Enter the Wind Speed in MPH.

Wind Direction
Enter the Wind Direction in degrees.

Sensor Position Group

The Sensor position group box provides controls for using the RAM 2000s’ Positioner system to
point the FTIR’s telescope to different retroreflectors. For each retroreflector that a FTIR is to
point at, you will need to create a separate document . Each document will contain the setup
information (Site, FTIR and Signal Processing) for that specific retroreflector. See Pointing a FTIR
at multiple Retroreflectors for further details.

Use the positioner to direct the telescope

If you have purchased a RAM 2000 system with an Positioner system and want to use the
Positioner to point the FTIRs telescope to one of multiple retroreflectors, then check this
checkbox.

Azimuth
Enter the bearing from North that the FTIR should point to for this retroreflector. This value

would have been computed during System Alignment .
Elevation

Enter the elevation from the vertical that the FTIR should point to for this retroreflector. This
value would have been computed during System Alignment .

Liquid Nitrogen Control Group

The Liquid Nitrogen (LN2) Control group box provides controls for using the RAM 2000s’ Liquid
Nitrogen Refill system. The Liquid Nitrogen Control system is a RAM 2000 system option that
provides an automated method for refilling the dewar in the RAM 2000 FTIR unit from an external
large capacity dewar. This provides the capability for long term unattended operations. To enable
the LN2 Refill system, check the “Use Liquid Nitrogen Controller” checkbox.

Analysis Setup

Analysis Setup Dialog

The Analysis Setup dialog provides the capability to:

—_

Select the background spectrum to use for CLS processing;
2. Select and edit an existing Signal Processing Information file (SPI) that will be used in an
analysis, or create a new SPI file to contain the analysis parameters of choice.
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The Analysis Setup dialog is the primary interface in the selection of parameters for performing an
analysis. Selection of an existing SPI file is made through the use of the Browse button. This will
bring up a Windows standard file selection dialog that will let you browse the files that are
available on your system’s disk(s). You can modify the current parameters of a selected SPI file
by pressing the Edit button.

To specify a new set of algorithms and/or chemicals for an analysis, use the Edit button. When

depressed, the program will bring up the Signal Processing dialog . This dialog allows you to
select the algorithms and chemicals that you wish to use in your analysis.

Background Spectrum Group

Browse

Press this button to select the spectrum file that will contain the Background Spectrum for
CLS processing. Pressing this button will bring up the Select Background File Dialog. That
dialog will allow you to select the file that will contain the background spectrum for CLS
processing. The file selected will appear above this button after selection.

Signal Processing Info File Group

Browse

Press this button to select the SPI File that will contain the signal processing information to
be used for an analysis. Pressing this button will bring up the Signal Processing Information
File Dialog. That dialog will allow you to select the file that contains the signal processing
information for this analysis. The file selected will appear above this button after selection.

Edit

Press this button to edit the currently selected SPI file, or if no current SPI file is selected, to
create a new SPI file. Pressing this button will bring up the Signal Processing Dialog. That
dialog will allow you to select the specific parameters for your analysis.

ABF Setup Dialog

The ABF Setup dialog provides the capability to select the chemicals that will be subtracted from
the signal spectrum in order to update the background spectrum. The dialog also provides the
capability to specify the Upwind direction from the area at which the chemicals would nominally be
found.

Dialog Options

Available Chemical Names

The Available Chemical Names listbox displays the names of chemicals that are not currently
being displayed on the view. This listbox and the Selected Chemical Names listbox will only
include those chemicals that were selected for analysis from the Signal Processing Dialog. You
may select one or more chemicals by using the mouse to highlight the names desired.

Chemicals to Subtract

The Chemicals to Subtract listbox displays the names of chemicals that are to be subtracted from
the Signal Spectrum during the Adaptive Background Filtering process. Chemicals listed in this
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listbox, if found to be present in the signal spectrum, will be subtracted out prior to updating the
current background spectrum. If a chemical is not listed to be subtracted from the Signal
spectrum and then later it is found to be present during an analysis, the Background spectrum will
not be updated.

This listbox and the Available Chemical Names listbox will only include those chemicals that were
selected for analysis from the Signal Processing Dialog. You may select one or more chemicals
by using the mouse to highlight the names desired.

Add
The Add button will transfer the chemicals selected in the Available Chemical Name listbox to the
Selected Chemical Names listbox, adding them to the bottom of the list.

Delete
The Delete button will remove the selected chemicals in the Selected Chemical Name listbox and
return them to the Available Chemical Names listbox.

Replace
The Replace button will swap one selected chemical from the Selected Chemical Names listbox
with one selected chemical in the Available Chemical Names listbox.

Insert Before
The Insert Before button will insert the chemicals selected in the Available Chemical Name listbox
before the selected chemical in the Selected Chemical Names listbox.

Insert After
The Insert After button will insert the chemicals selected in the Available Chemical Name listbox
after the selected chemical in the Selected Chemical Names listbox.

Upwind Direction Group

The Upwind Direction group provides the capability to specify the upwind direction from the area
of potential chemical releases. This data is used by the RMMSoft program to modify the currently
used background spectrum.

From Degrees ...

Specify the starting bearing, from true North, that encompasses the angle that is upwind from
the area of potential chemical releases.

To Degrees Clockwise. ..

Specify the ending bearing, from true North, that encompasses the angle that is upwind from
the area of potential chemical releases.

ASP Setup Dialog

The Advanced Signal Processing Setup dialog is used to select the appropriate Weight File for the
ASP algorithm.

Dialog Options

Chemical Selection Group

Chemical Listbox
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This list box provides the complete list of chemicals in the RMMSoft chemical database.
Press the Down arrow button next to the Listbox to display the list of chemicals in the
database. Click the left mouse button on the name of the chemical that you wish to select. If
the chemical that you wish to perform ASP processing on does not appear in the listbox, and
if you have a Weight File for the chemical, then you can add the name directly by pressing the
New Chemical button. See details for this button below. Selection of a chemical will cause
the program to load the all chemical data into the Chemical Info group controls.

Add

The Add button adds the chemical selected in the Chemical listbox, described above, into the
Selected Chemicals list. Only those chemicals which have been “added” to the list will be
processed by the ASP algorithm during an analysis.

Delete

The Delete button deletes any selected chemicals from the Selected Chemicals list. This
removes that chemical from ASP analysis processing. To delete a chemical, select the
chemical by clicking the left mouse button its name in the Selected Chemicals listbox and then
press the Delete button.

New Chemical

The New Chemical button provides the capability to add a chemical which is not in the
Chemical database into the list of chemicals. Click the New Chemical button. Then enter the
name of the chemical into the chemical listbox and press the Add button.

UnModified Database / Modified Database / User Defined

These buttons indicate the status of the chemical setup information in relation to the
chemicals database entry. If you select a chemical for ASP processing without modification,
then the UnModified Database button will be highlighted. If you select a chemical from the
database and you modify any of the parameters, then the Modified Database button will be
highlighted. Finally, if you have entered a new chemical into the Selected Chemicals list, (l.e.
one which currently does not exist in the chemical database), then the User Defined button
will be highlighted.

Selected Chemicals
This list displays the chemicals that have been selected for ASP processing. Only those
chemicals appearing in this list will be processed.

Chemical Info Group
This group provides the interface to add and delete ASP weight files for the chemical currently
selected in the Selected Chemicals list in the Chemical Selection group.

Add Weight Files

This button allows you to select ASP Weight files for the currently selected chemical.
Pressing this button will bring up the Weight Files dialog, which is a standard Windows file
dialog.

Delete Weight Files

This button allows you to remove currently selected ASP Weight files for the selected
chemical. To delete a Weight file, click the left mouse button on the Weight file that you wish
to delete and then press the Delete Weight Files button.

Weight files for the selected chemical

This control lists the weight files that are currently being applied to the selected chemical for
ASP processing. Files can be added or deleted via the Add Weight Files or Delete Weight
Files buttons.
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Chemical Setup For Concentration Dialog

This dialog provides the interface between the RMMSoft chemical database and the user for the
selection of chemicals for CLS processing. This dialog will allow you to select chemicals defined
in the program’s chemical database, or to define your own chemicals that do not appear in the
RMMSoft chemical database.

Dialog Options

Chemical Selection Group

Chemical Listbox

This list box provides the complete list of chemicals in the RMMSoft chemical database.
Press the Down arrow button next to the listbox to display the list of chemicals in the
database. Click the left mouse button on the name of the chemical that you wish to select. If
the chemical that you wish to perform CLS processing on does not appear in the listbox, and if
you have a Reference File for the chemical, then you can add the name directly by pressing
the New Chemical button. See details for this button below.

Add

The Add button adds the chemical selected in the Chemical listbox, described above, into the
Selected Chemicals list. Only those chemicals which have been “added” to the list will be
processed by the CLS algorithm during an analysis.

Delete
The Delete button deletes any selected chemicals from the Selected Chemical list. This
removes that chemical from CLS analysis processing.

New Chemical

The New Chemical button provides the capability to add a chemical which is not in the
chemical database into the list of chemicals which will be analyzed by CLS processing. Press
this button to clear the Chemical Setup For Concentrations dialog. Then enter the name of
the chemical into the Chemical listbox and other chemical information in their respective edit
controls, and press the Add button.

UnModified Database / Modified Database / User Defined

These buttons indicate the status of the chemical setup information in relation to the
chemical’'s database entry. If you select a chemical for CLS processing without modification,
then the UnModified Database button will be highlighted. If you select a chemical from the
database and you modify any of the parameters, then the Modified Database button will be
highlighted. Finally, if you have entered a new chemical into the Selected Chemicals list, (l.e.
one which currently does not exist in the chemical database), then the User Defined button
will be highlighted.

Selected Chemicals

This list will display the chemicals that have been selected for CLS processing. Only those
chemicals appearing in this list will be processed.

Delete all regions ...
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When checked, any regions defined in the chemical setup that are not processed for
concentration in any chemical will be deleted when OK is clicked. This is the behavior that is
typically desired. If you want such regions to be left in the chemical setup, uncheck the check box.

Chemical Info Group

The Chemical Info group displays information from the RMMSoft chemical database for the
chemical currently selected in the Selected Chemicals list (specified in the Chemical Selection
group). The controls located in the Chemical Info group provide you the capability to modify the
preset chemical setup information (supplied from the Chemical Database) so that you can
customize CLS processing for your specific application. If you have entered a chemical which is
not in the chemical database into the Selected Chemical list, then no data will appear in the
Chemical Info group; you will have to enter all associated data by hand for this chemical.

Reference File

The Reference File button and its associated edit control, provide you the capability of
selecting a Reference File for CLS processing. |Initially the program will specify the
recommended file that should be used as a reference for the chemical. Pressing the
Reference File button will cause the program to bring up the Reference File For Selected
Chemical Dialog , where you may select another file as the reference spectrum for this
chemical. This is a required input for CLS processing and may not be left blank.

CAS Number
The Chemical Abstract (CAS) number of the selected chemical is displayed for reference.

Molecular Mass

The molecular mass of the chemical is displayed. Some chemicals have multiple species with
similar names and different molecular masses. For these chemicals the molecular mass has
been set to zero. You may enter the correct molecular mass for the exact species of the
chemical in this control.

C*L Product
This control lists the Concentration Pathlength (C*L) Product of the reference file and the C*L
Products units. This is a required input for CLS processing and may not be left blank.

Number of Std. Deviations for Acceptance

This value indicates the number of standard deviations that the chemicals standard deviation
must be greater than for reporting a concentration value as being above the chemicals
Minimum Detection Limit (MDL). A value of 3 in this field indicates that the computed
standard deviation of the chemicals concentration must be greater than 9 Sigma ( 3 * 3
Sigma).

Alarm Data Group

The Alarm Data group provides the capability to specify the concentration levels at which user
alarms will be triggered. The program provides two alarm levels and a filtering value. Alarm
values of zero indicate that any concentration value above the MDL will cause an alarm to
trigger.

Warning Alarm

The Warning Alarm is the lowest alarm level in the system. This is typically used to
provide an early indication that a problem may occur. You may enter any fractional value
in this field. A value of zero indicates that any concentration value above the MDL will
cause an alarm to trigger. The exact value to enter is to be determined based upon your
specific application and needs.
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Trigger Alarm

The Trigger Alarm is the highest alarm level in the system. This is typically used to
indicates that a problem has occurred. You may enter any fractional value in this field. A
value of zero indicates that any concentration value above the MDL will cause an alarm to
trigger. The exact value to enter is to be determined based upon your specific application
and needs.

Units

This field represents the units of the displayed Alarm Data. You may select the
appropriate units by pressing the down arrow to bring up the valid selections and then
clicking on the desired units. The program will convert the values in the Trigger and
Warning Alarm field automatically when you change units. Therefore you select the
proper units prior to entering alarm values.

Alarm Ratio (M out of N)

The Alarm Ratio provides the capability to prevent alarming on single instances of a
chemical’'s concentrations being above the alarm level. The M value indicates the number
of above alarm value concentrations that must occur in the data set (N value ) prior to
alarming. For example, if you wish to alarm only when 3 out of 5 concentration values are
above the alarm level, the M value will be 3 and the N value will be 5. The Alarm Ratio
processing is a rolling ratio, meaning that as each new concentration is added to the
process the oldest one is discarded.

Region Data Group

The Region Data group provides the capability to add, delete or modify the spectral regions in
which CLS processing will be performed for this chemical. Initially the data presented in this
group is the recommended spectral regions for processing this chemical from the Chemical
Database. You may modify this data as desired to support your application.

New Region Group
This group allows you to specify the starting and ending region for CLS analysis.

Start
Specify the Start region in wavenumbers for this chemical.

End
Specify the End region in wavenumbers for this chemical.

Add Region
Press this button to add the data entered in the Start and End controls in to the

Region Data list.

Region Data List
This list displays the current spectral regions for processing this chemical.

Delete Regions
This button will delete the currently selected spectral region from the Region Data list.

CLS Setup Dialog
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The CLS dialog provides the capability to specify the chemicals that will be analyzed and their
associated spectral regions.

Dialog Options

Setup From Database Group

Chemicals
Press this button to select the chemicals that will be analyzed by the CLS algorithm. Pressing
this button will bring up the Chemical Setup For Concentration Dialog.

Analysis Regions

Press this button to select to review, modify and delete regions for analysis by the CLS
algorithm. You can also select chemicals that will be treated as Interferents by the CLS
algorithm. Pressing this button will bring up the Spectral Region Analysis Dialog.

Clear Setup
Press this button to erase all previously selected CLS setup selections.

File Selection Dialog

Dialog Options

File Name
Select a file from the File Name listbox for use as the chemical’s reference file. You may also type
the path and filename directly into the edit control.

List Files of Type
Select the file type (by filename extension) from the drop down list. Only files of the selected type
will be shown in the File Name listbox.

Directories
Select the directory that you require by clicking on the appropriate folder. The directory and path
selected will be listed above the Directory listbox.

Drives
Select the drive that contains the reference file.

Signal Processing Dialog

The Signal Processing dialog provides the capability to select the algorithms and processing
parameters that you wish to use for an analysis. All selections made on this set of dialogs will be
automatically saved into a SPI File for later reuse.

The dialog provides a convenient method for selecting the algorithms that you wish to use in your

analysis. Once an algorithm is selected you can select the chemicals that you wish to apply the
algorithm to by pressing the Setup button.
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Dialog Options

Processing Resolution Group
Select the resolution at which you wish to process Signal Spectrum . The lower the value, the
higher the resolution (0.5 cm™ is the highest resolution available). A higher resolution provides
finer spectral detail enabling better concentration determination. RAM 2000s’ spectral reference
library provides spectral files for 0.5 cm™ resolution processing. The Selected resolution must be
equal to the collection resolution.

Phase Correction Group

Forman
Select this radio button to select the 1-Pass Forman phase correction method. This method is
more accurate than the Mertz method, but slower in execution. Normally this is the preferred
method.

Mertz
Select this radio button to select the Mertz phase correction method. Mertz method provides
the fastest conversion but provides the least accurate phase correction.

Algorithms To Perform Group

Select the algorithms to perform on the signal data. Algorithms can be enabled or disabled by
clicking on the algorithm’s checkbox. Algorithms can also be enabled by selecting the name of
the algorithm and pressing the Setup button. If the algorithm has any associated setup
parameters then the algorithm specific setup dialog is displayed when the algorithm is enabled.
You must populate the algorithm specific parameters and click OK for the algorithm to be enabled.
The following algorithms are available:

Water Line Alighment

The Water Line Alignment algorithm is used to align the spectra received from the FTIR to a
reference spectrum. This alignment ensures that signal processing results are as accurate as
possible. This algorithm should always be enabled for all processing modes.

Classical Least Squares

Select this item to have the program use Classical Least Squares (CLS) processing to
determine chemical detection and quantification. CLS is the standard method of computing a
chemical's concentration. To apply the CLS algorithm to a set of chemicals, CLS setup
processing must be performed. This is accomplished by pressing the Setup button when the
CLS algorithm entry has been selected (highlighted) or by clicking on the algorithm’s
checkbox. When pressed, the program will bring up the CLS Setup dialog . This will allow
you to select the chemicals that you wish to analyze using the CLS algorithm.

Advanced Signal Processing

Select this item to have the program use AlL’'s Advanced Signal Processing (ASP) algorithm
to perform chemical detection. The ASP algorithm does not perform concentration
calculations. It determines the probability of detection of a chemical. To apply the ASP
algorithm to a set of chemicals, ASP setup processing must be performed. This is
accomplished by pressing the Setup button when the ASP algorithm entry has been selected
(highlighted) or by clicking on the algorithm’s checkbox. When pressed, the program will bring
up the ASP Setup Dialog . This will allow you to select the chemicals that you wish to
analyze using the ASP algorithm.

Spectral Library Search

The Spectral Library Search algorithm is used to get a rough determination of what chemicals
are in the air when not looking for a specific set of chemicals. The algorithm uses predefined
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sets of CLS parameters for various groups of chemicals in the chemical database and
displays the results of each chemical in the associated displays. Because the CLS setups
used are general and not tuned to any specific environment or interferents, the Spectral
Library Search results should be considered preliminary. This algorithm is intended for use by
personnel familiar with spectroscopy who can properly interpret the results. To apply the
algorithm, Spectral Library Search setup must be performed. This is accomplished by
pressing the Setup button when the Spectral Library Search algorithm is selected
(highlighted) or by clicking on the algorithm’s checkbox. When pressed, the Spectral Library
Search Dialog will be displayed. This allows you to select the groups of chemicals to be used.

NEA Noise

Select this checkbox to enable the program to perform the NEA Noise algorithm. To apply the
NEA Noise algorithm simply depress the Setup button when the NEA Noise algorithm entry
has been selected (highlighted). There are no other inputs required to enable this algorithm.

Emission Rate

Select this item to enable the program to perform the Emission Rate (ER) algorithm. To apply
the ER algorithm to a set of chemicals, ER setup processing must be performed. This is
accomplished by pressing the Setup button when the ER algorithm entry has been selected
(highlighted) or by clicking on the algorithm’s checkbox. When pressed, the program will bring
up the ER Setup . This will allow you to select the chemicals that you wish to analyze using
the ER algorithm.

Adaptive Background Filtering

Select this item if you want the program to update the user supplied background spectrum
automatically using AlL’s Adaptive Background Filtering (ABF) technique. This process
involves updating the background spectrum using the Signal spectrum collected by the FTIR.
This technique is a recursive process in which the background is updated only if there are
either no chemicals detected or the only chemicals detected are those which have been
specified by the user to subtract out of the signal spectrum. If a chemical that was not
selected to be subtracted out of the background is detected, then the background is not
updated. To apply the ABF algorithm, ABF setup processing must be performed. This is
accomplished by pressing the Setup button when the ABF algorithm entry has been selected
(highlighted) or by clicking on the algorithm’s checkbox. When pressed, the program will bring
up the ABF Setup . This will allow you to select the chemicals for the ABF algorithm.

The benefits of this process are that the detection levels are improved as the weather / site
conditions change. A potential drawback of this process is that a slow long-term leak of a
chemical, which is initially below the system’s detection level, may actually cause an increase
of the chemical’s detection level. This is due to the fact that a chemical that is slowly leaking
still has some impact on the spectral input signal. This impacted signal spectra gets applied to
the newly updated background signal. This causes desensitization of the next signal spectra
collected. Therefore, if you select this algorithm you should periodically check the background
spectra for chemical contamination.

Setup

Press the Setup button to bring up the setup dialog for the currently selected algorithm in the
Algorithm to perform listbox.

Spectral Library Search Dialog

The Spectral Library Search dialog provides the ability to select the groups of chemicals that are
to be included when searching for chemicals. The chemicals that comprise each group are
predefined and cannot be changed by the user.
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Dialog Options

Include in spectral library search

The check list box contains the name of each chemical group defined for spectral library search.
Check each group that should be included when searching for chemicals.

Spectral Region Analysis Dialog

This dialog provides the interface between the RMMSoft chemical database and the user for the
selection of Interferents for CLS processing. This dialog will allow you to select chemicals defined
in the program’s chemical database, or to define your own chemicals that do not appear in the
RMMSoft chemical database.

Dialog Options

Chemical Selection Group

Chemical Listbox

This list box provides the complete list of chemicals in the RMMSoft chemical database.
Press the Down arrow button next to the Listbox to display the list of chemicals in the
database. Click the left mouse button on the name of the chemical that you wish to select. If
the chemical that you wish to perform CLS processing on does not appear in the listbox, and if
you have a Reference File for the chemical, then you can add the name directly by pressing
the New Chemical button. See details for this button below.

Add Interferent

The Add button adds the chemical selected in the Chemical listbox, described above, into the
Selected Chemicals list as an interferent. Only those chemicals which have been “added” to
the list will be processed by the CLS algorithm during an analysis.

Delete Interferent
The Delete button deletes any selected chemicals from the Selected Chemical list. This
removes that chemical from CLS analysis processing.

New Chemical

The New Chemical button provides the capability to add a chemical which is not in the
Chemical database into the list of chemical interferents. Press this button to clear the
Spectral Region Analysis dialog. Then enter the name of the chemical into the chemical
listbox and the other chemical information in their respective edit controls. Press the Add
button to complete the entry.

UnModified Database / Modified Database / User Defined

These buttons indicate the status of the chemical setup information in relation to the
chemicals database entry. If you select a chemical for CLS processing without modification,
then the UnModified Database button will be highlighted. If you select a chemical from the
database and you modify any of the parameters, then the Modified Database button will be
highlighted. Finally, if you have entered a new chemical into the Selected Chemicals list, (l.e.
one which currently does not exist in the chemical database), then the User Defined button
will be highlighted.

Selected Chemicals
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This list will display the chemicals that have been selected for CLS processing. Only those
chemicals appearing in this list will be processed.

Delete all regions ...

When checked, any regions defined in the chemical setup that are not processed for
concentration in any chemical will be deleted when OK is clicked. This is the behavior that is
typically desired. If you want such regions to be left in the chemical setup, uncheck the check box.

Chemical Info Group

The Chemical Info group displays information from the RMMSoft chemical database for the
chemical currently selected in the Selected Chemicals list (specified in the Chemical Selection
group). The controls located in the Chemical Info group provide you the capability modify the
preset chemical setup information (supplied from the Chemical Database) so that you can
customize CLS processing for your specific application. If you have entered a chemical which is
not in the chemical database into the Selected Chemical list, then no data will appear in the
Chemical Info group; you will have to enter all associated data by hand for this chemical.

Reference File

The Reference File button and its associated edit control provide the capability of selecting a
Reference File for CLS processing. Initially the program will specify the recommended file
that should be used as a reference for the chemical. Pressing the Reference File button will
cause the program to bring up a File Selection Dialog , where you may select another file as
the reference spectrum for this chemical. This is a required input for CLS processing and may
not be left blank.

C*L Product
This control lists the Concentration Pathlength (C*L) Product of the reference file and the C*L
Product units. This is a required input for CLS processing and may not be left blank.

Number of Std. Deviations for Acceptance

This value indicates the number of standard deviations that the chemicals standard deviation
must be greater than for reporting a concentration value as being above the chemicals
Minimum Detection Limit (MDL). A value of 3 in this field indicates that the computed
standard deviation of the chemicals concentration must be greater than 9 Sigma ( 3 * 3
Sigma).

Region Grid_

The Region Grid indicates the currently assigned designation for each chemical by spectral
region. For each chemical a spectral region may be either processed for concentration,
processed as an interferent, or not processed. These are designated by symbols “C” for
concentration, “I” for interferent or blank for not processed. The designations are initially assigned
automatically by the program based upon your data entries on this and the Chemical Setup for
Concentration dialog. When a chemical has been entered on the Chemical Setup for
Concentration dialog, all of its regions specified are initially marked with a “C” in the Region Grid.
When a chemical is added as an interferent on the Spectral Region Analysis dialog, all of its
regions are marked with an “I”. Regions not specified by one chemical but used by another are
automatically mark as blank. You may change the designation of any region by placing the
mouse into the specific chemical and region and either typing the C, I, or the space bar (to clear
it). You can also select any entire row or column by clicking the row or column label, respectively.

Emission Rate Setup

ER Setup Dialog
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The Emission Rate dialog is used to enter the setup configuration parameters for performing an
Emission Rate Determination. This dialog is a tabbed dialog consisting of 3 separate components;
these are:

Receptors
Emission Rate Chemical Selection
Plume Capture

These components must be setup prior to release of a tracer gas for calculation of emission rates.

Emission Rate Chemical Selection

The Emission Rate Chemical Selection tabbed dialog is used to select the gas that will be used as
a tracer gas and as the target chemicals for the Emission Rate determination. Target chemicals
are those chemicals whose emission rates are to be determined. The gases that you wish to use
need to have been selected in the Chemical Setup For Concentration dialog .

Available Chemicals

This listbox displays the chemicals that you have previously selected for CLS processing from the
Chemical Setup For Concentration dialog. You may select any one chemical as the tracer gas
that is used to determine the emission rates of other chemicals. Any number of the remaining
chemicals may be added to the Selected Chemicals listbox as target gases.

Add

This button will cause all chemicals selected in the Available Chemicals listbox to be transferred
from the Available Chemicals listbox and entered as target chemicals in the Selected Chemicals
listbox.

Delete

This button will cause all chemicals selected in the Selected Chemicals listbox to be deleted as
target chemicals and transfer from the Selected Chemicals listbox to the Available Chemicals
listbox.

Replace
This button will cause the chemicals selected in both the Selected Chemical’s listbox and the
Available Chemical’s listbox to be swapped.

Tracer Gas

This button is used to select a single chemical as the tracer gas used in the emission rate
determination. When a chemical in the available Chemicals listbox is selected and you depress
this button, the Tracer Gas Data Selection dialog will appear so you can enter the release rate of
the tracer gas.

Selected Tracer Gas Group
The Selected Tracer group displays the name of the tracer gas, the release rate and the release

rate units as entered on the Tracer gas Data Selection dialog. There are no editable controls for
this group.

Plume Capture

The Plume Capture tabbed dialog is used to enter data pertaining to the position of the FTIR and
the Retroreflector with respect to the source of the tracer gas. This allows the computation of the
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percent of plume capture that is necessary to correctly determine a target chemical’'s emission
rate.

Telescope Group

Distance from Source
Enter the distance from the Telescope to the source in the units selected in the Units control.

Units

Select the units for the distance from the telescope to the source from the drop down list.
Changing units will cause the recalculation of the Distance from Source from the original units
to the newly selected units.

Bearing from Source
Enter the bearing (angle) from the Source to the Telescope in degrees.

Retro Array Group

Distance from Source
Enter the distance from the Retroreflector to the source in the units selected in the Units
control.

Units

Select the units for the distance from the retroreflector to the source from the drop down list.
Changing units will cause the recalculation of the Distance from Source from the original units
to the newly selected units.

Bearing from Source
Enter the bearing (angle) from the Source to the retroreflector in degrees.

Receptors

The Receptors tabbed dialog is used to enter the information concerning the receptors that may
be downwind of your site. A Receptor can be any location (school, factory, shopping center, . ..
ETC) which may encounter gases that may be released at your site.

Dialog Options

Receptor Name
Enter the name of the receptor (e.g. Beach Wood Estates).

Distance From Source
Enter the distance from the source of the potential gas release site to the receptor in the units

specified in the Units control.

Units
Select the units of the distance from the source to the receptor from the listbox.

Bearing from Source
Enter the bearing from the source to the receptor in degrees.
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Add
Press the add button to enter the data provided above into the Receptors list.

Receptors Group

Receptors
This listbox shows the currently entered Receptors that will be processed for Emission Rate
determination.

Delete

This button will delete any currently selected receptor from the Receptors listbox. To remove
a receptor, click the left mouse button on the receptor and then click the left mouse button on
the Delete button.

Tracer Gas Data Selection
The Tracer Gas Data Selection dialog is used to enter the tracer gas’ release rate for Emission
Rate Determination .
Release Rate
Enter the release rate of the tracer gas in the units specified in the Units control. The
concentration of the tracer gas should be printed on its gas cylinder.
Units

Select the units for the concentration of the gas from the gas cylinder. Changing units will cause
the recalculation of the Release Rate from the original units to the newly selected units.

Tools Menu

Tools

The RMMSoft program provides a number of tools to support your processing needs. These tools
include Spectral conversion, File conversion and Data summarization tools. These tools are
located on the Tools menu on both the mainframe and document menu bars.

Spectral Conversion tools

The RMMSoft program provides spectral conversion tools to allow you to select specific spectra
from a file, Co-Add them, and convert them from one spectral form to another. The tools provided
are:

Create Spectrum

Create Interferogram

Create PNN Weight file
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File Conversion tools

The RMMSoft program provides file conversions to aid in data analysis. These tools are located
under the Convert command on the Tools menu on both the mainframe and document menu
bars. The conversions provided are:

Convert IDA to SPC formatted file.
Convert Results file (.RLT) to Delimited ASCII Text.

The first conversion allows you to convert files generated by the RMMSoft program
(Interferogram, Absorbance, Transmittance, or Single Beam) into one of Galactic’s standard file
formats. The last conversion tool converts the RMMSoft Results file into an ASCII text file that
then can be loaded into an MS Excel spreadsheet. All conversion tools require the user to supply
the name of the input and output files to be used.

Another tool available is the Export Data to File tool. This is found on the File menu under the
Export command. This provides the capability to convert any valid document data to other
formats. This is similar to the “Save As” feature in other programs.

Data Summarization and Reporting tools

The RMMSoft program provides Data Summarization and Reporting tools that provide the
capability to reduce data acquired over many hours, days or weeks into a summarized format.
The Data Summarization and Reporting tools provided are:

Daily, Weekly, Monthly Averages

Create Spectrum File

The Create Spectrum File tool provides the capability to create SPC formatted files of
Absorbance, Transmittance, Single Beam or Differential Absorbance data from interferograms.

Dialog Options

Spectrum type to create

Choose the type of spectra to create: Absorbance, Transmittance, Single Beam or Differential
Absorbance. A differential absorbance is an absorbance created by using signal frame n-1 as the
background for signal frame n. Frame 1 is used as the background for frame 1 of a differential
absorbance.

Background File Group

Select Bgnd File

Select the name of the file you wish to use as the background (Io) for the conversion. The file
must contain Interferograms and may be either an RMMSoft formatted file (.DAT, or .BGD) or
a SPC formatted file (.SPC). The file selected will appear above the Select Bgnd File button.

First Interferogram to coadd:

Select the number of the first interferogram to use in Co-addition. The number of
interferograms available in the file (if it is a multi-file) is listed above this dialog item
(Interferograms: #).

Last Interferogram to coadd:
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Select the number of the last interferogram to coadd. To use a single interferogram as the
background, set the first and last interferogram to Co-add to the same number.

Signal File(s) Group

Select Signal File(s)

Select the name of the file(s) you wish to use as the Signal (input) data. The file(s) must
contain interferograms and may be either an RMMSoft formatted file (.DAT, or .BGD) or a
SPC formatted file ((SPC). The file(s) currently selected will appear above the Select Signal
File(s) button. You may select multiple files to process at one time. If you have, the CoAdd
and Make Separate Files check boxes apply to each individual input file separately.

First Interferogram:

Select the number of the first interferogram to use as input. The number of Interferograms
available in the file (if it is a multi-file) is listed above this dialog item (Interferograms: #). If
multiple signal files are selected all interferograms from each signal file are used.

Last Interferogram:
Select the number of the last interferogram to use as input.

CoAdd

Check this check box if you wish to Co-add interferograms in the Signal file into a single
interferogram. For a single Signal file, the first through the last interferogram specified are
Co-added. If multiple Signal files are selected, all interferograms of each file are Co-added to
produce one output file per Signal file.

Make Separate Files
Check this check box if you wish to make a separate output file for output spectrum created.

Output File/Directory Group

Select Output File / Select Output Files Dir

If a single signal file is selected, select the path to the file to use as the conversion output. If
multiple signal files are selected, select the directory where all output files are to be stored.
All output files must be SPC formatted files (.SPC). The output file/directory selected will
appear above the Select Output File(s) button.

When creating multiple output files the program creates unique output filenames by appending
a suffix identifying the kind of spectrum created to the signal file name. For example, if
creating absorbances from signal files 1217z21i.dat and 1217x21i.dat, output files
1217z21i_a.spc and 1217x21i_a.spc would be created. The suffixes used for the various
kinds of spectra created are:

Absorbance: _a
Transmittance: _t
Single Beam: _s
Differential Absorbance: da

When the “Make separate files” check box is selected, output file names are created by
appending the frame number to the end of the file name. For example, if creating twelve
output files and OUTPUT.SPC is specified as the output file name, files OUTPUTO01.SPC to
OUTPUT12.SPC will be created. Similarly, if creating absorbances from signal files
1217z21i.dat (with 22 interferograms) and 1217x21i.dat (with 115 interferograms), output files
1217z21i_a01.spc through 1217z21i_a22.spc and 1217x21i_a001.spc through
1217x21i_a115.spc will be created.
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Phase Correction Method Group

2-Pass Forman
Select this radio button to select the 2-Pass Forman phase correction method. This method
provides more accurate phase correction than other methods, but is significantly slower in
conversion time.

1-Pass Forman

Select this radio button to select the 1-Pass Forman phase correction method. This method is
more accurate than the Mertz method, but not as accurate as the 2-Pass Forman method.
This is a good trade-off option between speed and accuracy.

Mertz
Select this radio button to select the Mertz phase correction method. Mertz method provides
the fastest conversion but provides the least accurate phase correction.

Options Group

Align 0.5 cm-1 resolution single-beams to known water lines

Check this check box if you wish to have the conversion align the computed single beam
spectrums to known water lines. Selecting this option will provide you with the most accurate
concentration results when using Classical Least Squares processing. This alignmentis CPU
intensive and will result in longer conversion times. This option is only available for
interferograms that have been collected at a 0.5 cm™ resolution.

Truncate output spectra to frequency range ...
Check this check box if you wish to truncate the output spectrum to be between the specified
wavenumbers. You must provide the starting and end frequencies for this option.

Buttons

Create

Create the spectral file using the information provided. The program will provide you a
progress meter on the toolbar to indicate the progress of the conversion. During conversion,
the Create button is changed to a Stop button to allow you to halt the conversion. If stopped
before completion, spectra that have already been written to the output file(s) are not deleted.

Close
Terminate and close the dialog.

Help
Display the help file topic for the dialog.

Create Interferogram File

The Create Interferogram tool provides the capability to create a RMMSoft formatted file of

Interferograms.  The tool provides the capability to change the resolution of the
interferogram (by decimation) and to select specific interferograms to save from the input file.

Dialog Options

Input Interferogram Group

Select Input File
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Select the name of the file that contains the input Interferograms. The file must contain
interferograms and may be either an RMMSoft formatted file (.DAT, or .BGD) or a SPC
formatted file (.SPC). The file currently selected will appear above the Select Input File
button.

Resolution of this file:
The program will display the resolution of the interferogram data contained in the selected
input file after you select the file for processing. No user action is required.

Interferograms in this file:
The program will display the number of interferograms contained in the selected input file after
you select the file for processing. No user action is required.

Output Resolution Group

These check boxes allow you to select the desired resolution(s) of the output interferograms.
Select the appropriate check box(es) for the resolution desired. The output resolution(s) selected
must be less than or equal to the input file resolutions.

Interferograms to Copy Group

First
Specify the number of the first interferogram to copy to the output file. The first value must be
less than or equal to the last value.

Last

Specify the number of the last interferogram to copy to the output file. The last value must be
greater than or equal to the first value.

Output Interferogram Group

Select Output File

Select the name of the file you wish to store the resultant Interferograms. The file will be
saved as an RMMSoft formatted file with an file extension of either .BGD or .DAT. If multiple
resolutions are selected, a separate output file is created for each, with the resolution
appended to the filename. For example, if 0.5 wavenumber and 16.0 wavenumber
resolutions are selected, with and output filename of FILE.DAT, files FILE_5.DAT and
FILE16.DAT are created. Enough room must be left in the output filename for the resolution
to be appended.

Create PNN Weight file

The Create PNN W eight file tool provides the capability to create a PNN reference file for use with
the RMMSoft Advanced Signal Processing (ASP) algorithm. The ASP algorithm employs a
Probabilistic Neural Network (PNN) as part of the detection algorithm. This tool is intended to
support RAM 2000 staff members during the installation process and therefore will not be
described here.

Convert RMMSoft (*.DAT) to Grams (*.SPC)

The Convert RMMSoft (*.dat) to Grams (*.spc) dialog provides the capability to create a SPC
formatted file from a RMMSoft file format (*.dat) file. The dialog provides the capability to convert
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Interferograms, Absorbance, Transmittance, or Single Beam files into either the GRAMS, LabCalc
or GRAMS for Macintosh formatted files. The tool also provides the capability to truncate the
number of frames to be stored into the output file.

Dialog Options

Input DAT File Group

Frames in this file
This control indicates the total number of frames in the selected input file.

Select Input File

Select the name of the file you wish to use as the input to the conversion. The name of the
file selected will appear above the Frames in this file control.

Output SPC File Group

Select Output File

Select the name of the file you wish to use as the conversion output. The file will be a SPC
file in the formatted selected. must be a SPC formatted file (.SPC). The output file selected
will appear above the Select Output File button.

Output File Type Group

LabCalc
Select this radio button to select the LabCalc file format for the output file.

Grams
Select this radio button to select the Grams file format for the output file.

Grams for Macintosh

Select this radio button to select the Grams file format for the Apple / Macintosh computer
systems.

Frame to Copy Group

First
Enter the frame number for the first frame that is to be converted and stored into the output
file.

Last
Enter the frame number for the last frame that is to be converted and stored into the output
file.

Buttons

Create

Create the spectral file using the information provided. The program will provide you a
progress meter on the toolbar to indicate the progress of the conversion. During conversion,
the Create button is changed to a Stop button to allow you to halt the conversion. If stopped
before completion, spectra that have already been written to the output file(s) are not deleted.
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Close
Terminate and close the dialog.

Help
Bring up the help file for this dialog.

Convert Results To Delimited ASCII Text

This dialog provides the capability to convert Results File(s) from AIL’s proprietary format to
delimited ASCII text file(s). You may select one or more Results files to convert at one time. The
converted file(s) can be loaded into a spreadsheet program for further analysis. The delimiter
used in the conversion is a comma.

Dialog Options

Results File
Select the name of the Results file(s) to convert.

Results to Convert

RMMSoft's Results file format includes summary and detailed data for all algorithms performed.
You may convert any or all of these data items (See Results File for further details on these
individual data items). Select the items of the Results file that you wish to convert to Delimited
ASCII text.

Options

Concentration units
Select the units that you wish to format the concentration values.

Weather units
Select the measurement system in which to format the weather data values (English or
Metric).

Include low confidence data

Check this selection if you want the conversion to include data values that the system has
determined to be of low confidence. If not selected, the conversion will report these values as
No Data.

Include interferant regions

Check this selection if you want to include interferent regions when converting a results
section that includes region based information. If not checked only information associated with
regions processed for concentration are included.

Maximum number of output columns for spectral library search results

Specifies the number of columns used in the output file before wrapping to another section.
Wrapping of the output currently applies only to the spectral library search results. When
wrapping is needed, an entire new section of results is written. All sections contain information
for all frames of the results.

Delimited ASCII Text File / Text Directory
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Select the output file name, if a single Results file was selected for conversion, or the
directory, if multiple files were selected, in which the converted data will be stored. When
converting multiple Results files the names of the resultant delimited ASCII text files will be
the input file name with a TXT extension.

Daily, Weekly, Monthly Averages

This dialog provides the capability to summarize data contained in Results Files. The data can be
summarized (averaged) in either daily, weekly, or monthly intervals by beampath, date and
chemical. The resultant summarized (averaged) data can be saved either to a spreadsheet or text
file. You can select up to 13 chemical and 14 weather parameters for summarization.

If multiple results files are selected and the results files contain data from more than one time

zone, the Ambiguous Time Zone Dialog will be displayed to allow selection of the time zone to use
for the summary.

Dialog Options

Statistical Setup Group

Statistical Interval

Select the interval (period) for which data is to be summarized (averaged). The program
allows you to summarize data on a Daily, Weekly or Monthly interval. The report will contain
one column of data for the number of intervals (see below) selected.

Start Date
Enter the start date for which summarization should begin.

Number Of Intervals
Enter the number of days, weeks, or months that you want to summarize data from the
entered start date.

Units
Select the units that you wish to format the summarized values.

Sum All Beampaths Together

Check this selection if you want all data from all beampaths to be summarized together.
Check this selection also to be able to summarize data from Results files whose names do not
fit the Automatic Filename Generation format. See Automatic FileNaming for further details.

Include Low Confidence Data

Check this selection if you want the summarization to include data values that the system has
determined to be of low confidence. If not selected, the summarization process will skip
averaging these values.

Parameters to Display
Select the parameters that are to reported in the output file. Chemical names are

automatically selected.

Weather Units
Select the units that any weather data will be reported in.

File Selection Group
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The dialog provides the capability to select files either manually or automatically for
processing. Automatic file selection will only process those files whose filenames are in the
Automatic File Generation format (see Automatic FileNaming for further details). To process
files which are not in the Automatic File Generation format, you must select the Sum All
Beampaths Together option.

Automatic

Check this selection to allow the tool to select files to process automatically. When this
option is selected the Files / Path button name will change to Path. Press this button to
select the drive and path at which the files to be processed can be found.

Manual

Check this selection to manually select files to process automatically. When this option is
selected the Files / Path button name will change to Files. Press this button to select the
drive, path and files to be processed.

Files / Path
This button will bring up the appropriate dialog to select either files or paths to process
files from. The File selection dialog will allow for the selection of multiple files.

Output Group

Spreadsheet file

Check this selection to have the tool build a spreadsheet compatible file for output. When
opening this file in a spreadsheet application, select the options Delimited file and the Comma
as the delimiter.

Text File
Check this selection to have the tool build a flat ASCII file for output.

Filename
This button will bring up the output file selection dialog. Enter / select the file to save the
summarized data.

Example

In the following example the user selected to perform daily averaging starting on 5/11/97 and
ending a week later on 5/17/97 (7 days). Each beampath will be reported separately and all
parameters except for Standard Deviation of Concentration have been selected for display. He
has selected to have the tool automatically select the proper files to process from the “E” drive and
the path “Test”. The output will consist of 7 tables (1 for each day (Daily summarization)) and be
in a spreadsheet compatible file.
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View Menu

Concentration Units

All non-spectral views provide the capability to change the units that a chemical’s concentration
and standard deviation will be displayed in. The capability is provided by the Concentration
Units command on the View menu. The change will apply only to the selected view or to all
views based on whether Use Global View Options is enabled. You can change the units to any
of the following:

Parts Per Million * Meters (PPM * M)
Parts Per Billion * Meters (PPB * B)

Parts Per Million (PPM)
Parts Per Billion (PPB)
MiclroGrams Per Meters (LWGIM?)
MilliGrams Per Meters (MG/M?)

Detailed Chemical Setup
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The Detailed Chemical Setup command controls the display of detailed chemical setup data on
the Chemical Setup Views. When enabled the system displays detailed chemical setup data.

Detailed Results

The Detailed Results command controls the display of detailed processing results on the
Concentration Text View. When enabled the system displays the detailed processing results.

Display Low Confidence Data

The Display Low Confidence Data command controls the display of data that the system has
deemed to be of marginal data quality as determined by the system’s quality analysis feature.
When enabled the system displays low confidence data at the computed concentration. Disabling
the feature will cause data tagged as Low Confidence to be displayed as “No Data”.

Frame Dialog

The Frame dialog provides the ability to specify the frame to display. If a frame number larger than
the last frame number is entered, the last frame is displayed.

Frame Ed |

Frame to view: |1 2

Cancel

Help

[E=1
[

Numerical Display

The Numerical Display command controls the display of numerical values on the Concentration
Graphic View. When enabled the system displays numerical values.

RMS

The RMS command enables the spectral statistical analysis feature for the Spectral Views .
When enabled the system will activate the RMS control.
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Show Below MDL As Zero

The Show Below MDL As Zero command controls the display of data that the system has
determined to be below a chemical's Minimum Detection Limit (MDL). This command controls the
display of data on the Concentration History Graphic view. When enabled all chemicals whose
concentrations are below its MDL will be displayed as zero. When disabled, chemicals whose
concentration is below its MDL value are displayed as a winged V.

Status Bar

The Status Bar command controls the display of the program’s Status Bar. When enabled the
Status Bar is displayed.

Toolbar

The Toolbar command controls the display of the program’s toolbar. When enabled the Tool Bar
is displayed.

Weather Units

The Weather Units command controls the display of weather data in the system. Weather data
can be displayed in English units ( Farenheight, Inches of Mercury, Miles per Hour) or Metric
(degrees Kelvin, MilliBars, Meters per Second).

Zoom Dialog

The Zoom dialog is used to zoom into specific regions of a spectral display. The dialog provides
a pre-loaded listbox of all of the current analysis regions being processed so as to enable you to
quickly visualize the spectral regions being processed, or you may enter in the Start and End
frequencies manually.

Dialog Options

X Axis group
The X-Axis group is used to manually enter a Start and End frequency to zoom to. Enter both the

start and end frequencies then press the OK button to enable the zoom.

Start
Enter the Start frequency that you wish to zoom to.
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End
Enter the End frequency that you wish to zoom to.

Regions
This listbox contains all the regions that have been specified for processing on the Signal
Processing dialog. Double click on the spectral region of choice to enable the zoom.

Sort By Dialog

Presentation Order

Many of the program's views have the capability to change the order that the chemicals are
shown. This allows you to customize the displays to your particular need. The following views
have this capability:

Concentration Views

Concentration History Text View
Concentration History Graphic View
Spectral Library Search Views

This capability can be accessed via the Sort By command on the View menu. The command will
only be applied to the current selected view. The Sort By command has six options:

1) Sort By Concentration.

2) Alarm Class.

3) Percent Of Trigger.

4) Alphabetical Chemical Name order.

5) Default Chemical Name order.

6) Selected Chemical name order.

7) Concentration/GOF (concentration to goodness of fit ratio)

Sort by Concentration

The Soft by Concentration command will cause the selected view to order the chemicals from
highest (leftmost) to lowest (rightmost) concentrations. Since the concentration of a chemical
may change from frame to frame, the order of chemicals presented may also change to reflect the
new concentration order.

Sort by Alarm Class

The Sort by Alarm Class command will cause the selected view to order the chemicals from the
highest alarm level (Red) to the lowest alarm level (Blue (for below the detection limit)) from left to
right on the view. Since the alarm level of a chemical may change from frame to frame, the order
of chemicals presented may also change to reflect the new Alarm Class order.

Sort by Percent of Trigger
The Sort by Percent of Trigger command will cause the selected view to order the chemicals from
the chemical that is closest (or most over) it's Trigger Alarm value to the chemical that is farthest
from its Trigger Alarm value.

Sort Alphabetically

The Sort Alphabetically command will cause the selected view to order the chemicals displayed
(as modified by those removed from displaying by the Chemical Name Selection dialog) in
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alphabetic name order. This command is listed under the Chemical Name menu item under the
Sort By command on the View menu.

Sort by Default Chemical Name Order

The Sort by Default Chemical Name Order command will cause the selected view to order the
chemicals displayed (as modified by those removed from displaying by the Chemical Name
Selection dialog) in the order they are listed in the Signal Processing Information (SPI) file. This is
the final order the chemicals were selected on the chemical setup dialog. This command is listed
under the Chemical Name menu item under the Sort By command on the View menu.

Sort by Selected Chemical Name

The Sort by Chemical Name command will cause the selected view to order the chemicals in the
name order you provide. You may also delete a chemical from the list to display using this
command. See Chemical Name Selection Dialog for more details.

Sort by Concentration/GOF

The Sort by Concentration/GOF command will cause the selected view to order the chemicals
from the chemical that has the largest absolute value of the concentration to goodness of fit ratio
(left most chemical) to the chemical that has the smallest absolute value of concentration to
goodness of fit ratio (right most chemical). Since the values change from frame to frame, the order
of the chemicals on the display will change accordingly.

Chemical Name Selection Dialog

The Chemical Name Selection dialog provides the capability to select the order that chemicals will
be displayed on the selected view.

Dialog Options

Available Chemical Names

The Available Chemical Names listbox displays the names of chemicals that are not currently
being displayed on the view. This listbox and the Selected Chemical Names listbox will only
include those chemicals that were selected for analysis from the Signal Processing Dialog. You
may select one or more chemicals by using the mouse to highlight the names desired.

Selected Chemical Names

The Selected Chemical Names listbox displays the names of chemicals that are to be displayed
on the view. The order the chemical names appear in is the order that they will appear on the
view. This listbox and the Available Chemical Names listbox will only include those chemicals that
were selected for analysis from the Signal Processing Dialog. You may select one or more
chemicals by using the mouse to highlight the names desired.

Add
The Add button will transfer the chemicals selected in the Available Chemical Name listbox to the
Selected Chemical Names listbox, adding them to the bottom of the list.

Delete
The Delete button will remove the selected chemicals in the Selected Chemical Name listbox and
return them to the Available Chemical Names listbox.

Replace

The Replace button will swap one selected chemical from the Selected Chemical Names listbox
with one selected chemical in the Available Chemical Names listbox.
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Insert Before

The Insert Before button will insert the chemicals selected in the Available Chemical Name listbox
before the selected chemical in the Selected Chemical Names listbox.

Insert After

The Insert After button will insert the chemicals selected in the Available Chemical Name listbox
after the selected chemical in the Selected Chemical Names listbox.

Sort Alphabetically

The Sort Alphabetically button will sort all the names in the Selected Chemical Names listbox
alphabetically.

Sort By Alarm Class

The Sort By Alarm Class selection sorts the Concentration graph from the highest chemical alarm
(Trigger) to the lowest chemical alarm (below MDL) from left to right on the view; chemical name
order is not preserved. The sort is performed without regard to the concentration value of any
particular chemical.

Sort By Concentration

The Sort By Concentration selection sorts the Concentration graph from the largest concentration
to the smallest concentration from left to right on the view; chemical name order is not preserved.
The sort is performed without regard to the alarm level of any particular chemical.

Window Menu

Arrange All Documents Windows Command

The Arrange All Documents Windows command will tile all currently open displays for all open
documents.

Arrange Document Windows Command

The Arrange Document Windows command will tile all currently open displays for the selected
document.

Original Document Windows Command
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The Original Documents Windows command will cause the program to display the original views
displayed for the selected document.

Macros

Macros

The RMMSoft program allows you to execute various commands through the use of a Macro file
(*.MAC). The Macro file is an ASCII file containing the macro commands the user wishes to be
executed. Macro commands are formatted as follows:

CommandName( ParameterO , Parameter1 , ... Parametern);

Parameters are always separated by commas. Macro commands are always terminated with
semicolons. You can include comments in a macro file for documentation purposes. Comments
start with a double forward slash ( // ) and can be placed on any line as long as it is not enclosed
within a CommandName or parameter. Examples of legal comments are as follows:

/I Create a new document and
/I open it in the Process from File mode.

NewProcessFromFile(“C:\RMM\TEST.RLT”, /I Results file for saving data
“CARMM\TEST.DAT”); /I Input Signal File

The following macro commands are available for your use:

ArrangeAllDocumentsWindows
ArrangeDocumentWindows
AssignDCSChannel

Close

Close Window
ConvertResultsToDelimitedAsciiText

DataToSave
Delay

DelayUntil

NewCollectAndProcess
NewCollectWithoutProcessing
NewProcessDataFromFile

Open

Open Window

SetFileChangeSynchronizationTime
SetupAlgorithms
SetupConcentrationAveraging
SetupFtir

SetupSite

Start
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TruncateSavedData

W ait
Macro Parameter Types
Macro Parameter Literal
Character An ASCII character enclosed in single quotes.
For example: ‘E’
Enumeration Name of a pre-defined value.
For example: FramesToSave_All
Float A floating-point number in the form:
(+/-) Integer[ .Integer] [e[+/-] Integer]
For example: -1.7e+12
Integer One or more decimal digits.
String Zero or more characters enclosed in double quotes.

For example: “c:\rmm\test.rit”

ArrangeAllDocumentsWindows

Macro Parameter Types

The ArrangeAllDocumentsWindows command will arrange all currently open displays for all open
documents. The command has no parameters. The format of the command is as follows:

ArrangeAllDocumentsWindows ();

ArrangeDocumentWindows

Macro Parameter Types

The ArrangeDocumentWindows command will arrange all currently open displays for the selected
document. The command has no parameters. The format of the command is as follows:

ArrangeDocumentWindows ();

AssignDCSChannel
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Macro Parameter Types

The AssignDCSChannel command will assign an item to be monitored on the user specified DCS
board and channel number. The format of the command is as follows:

AssignDCSChannel( BoardNumber,
ChannelNumber,

ItemName);
Parameters are:
BoardNumber : One based Integer number of the DCS board for this assignment.
ChannelNumber : One based Integer number of the channel for this assignment.
ItemName : A String that contains the name of the item to monitor.

Close

The Close command closes the currently referenced document. The command has no
parameters and has the format:

Close( );

CloseWindow

Macro Parameter Types

The CloseWindow command will close the window specified by the user. The command has one
parameters. The format of the command is as follows:

CloseWindow (WindowToClose);
Parameters are:

WindowToClose: A String representing the name of the window to close. Valid
selections are:

Concentrations
Concentrations Text
Concentration Averages
Concentration Rose
Concentration History
Concentration History Text
NEA Noise

Emission Rate
Absorbance Spectrum
Transmittance Spectrum
Signal Single Beam Spectrum
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Background Single Beam Spectrum
Signal Interferogram

Background Interferogram

Arbitrary Spectrum

Status

Background Status

Chemical Region Info

Chemical Setup

Concentration Averaging Setup
Adaptive Background Filtering Setup
Alignment

File Header

Positioner

LN2 Status

ConvertResultsToDelimited AsciiText

Macro Parameter Types

The Convert Results To Delimited ASCII Text command will convert a result file to a Delimited
ASCII Text file that can be loaded into any spreadsheet program. The command has two required

parameters and has the format:

ConvertResultsToDelimitedAsciiText(ResultsFileName, ASCIIFileName);

Parameters are:

ResultsFileName:

ASCIIFileName:

For Example:

String specifying the Path and Filename of the input Results file within double
quotes ( e.g. “c:\rmm\test.rit* )

String specifying the Path and Filename of the output delimited ASCII text file
within double quotes ( “)

ConvertResultsToDelimitedAsciiText(“C\RMM\DATA.RLT”, “C:\RMM\ASCIL.TXT");

DataToSave

Macro Parameter Types

The DataToSave command is used to specify the type of data that will be saved and the
filename that the data will be saved to. This macro is used in conjunction with the
NewCollectAndProcess , NewProcessDataFromFile , and NewCollectWithoutProcessing macro
commands. The DataToSave command has the following format:

DataToSave( FileTypef,
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“FileName1”,
FileType2,
“FileName2”,

FileTypen,

“FileNamen”)

Parameters are:

FileType1..n:

FileName1..n:

Delay

An Enumeration indicating the type of data to be saved. Valid selections are:

DataToSave_lInterferogram

DataToSave_BackgroundSingleBeam

DataToSave_SignalSingleBeam
DataToSave_Absorbance
DataToSave_Transmittance

DataToSave_Results

Stores the input Signal spectra as
an Interferogram.

Stores the Background spectra as
a Single Beam spectra.

Stores the input Signal spectra as
a Single Beam spectra.

Stores the input Signal spectra as
a Absorbance spectra.

Stores the input Signal spectra as
a Transmittance spectra.

Stores the Processing results.

A String representing the path and filename of the file into which the selected
data will be saved. If automatic file naming has been enabled for the document,

you must specify a NULL filename (
be automatically generated by the program.

Macro Parameter Types

) for this parameter since a file name will

The Delay command will cause macro execution to delay for the specified period of time. The

command has 3 required parameters and has the format:

Delay(Hours, Minutes, Seconds);

Parameters are:

Hours: An Integer representing the number of Hours to delay.
Minutes: An Integer representing the number of Minutes to delay.
Seconds: An Integer representing the number of Seconds to delay.

For Example:

To delay for 3 hours 30 minutes and 30 seconds the command would be:

Delay(3, 30, 30);
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DelayUntil

Macro Parameter Types

The DelayUntil command will cause macro execution to delay until the specified time.

command has 3 required parameters and has the format:
DelayUntil(Hours, Minutes, Seconds);

Parameters are:

Hours: An Integer representing the Hour number to delay till.
Minutes: An Integer representing the Minutes number to delay till.
Seconds: An Integer representing the Seconds number to delay till.

For Example:
To delay until 11:30 P.M. the command would be:

DelayUntil(23, 30, 0);

NewCollectAndProcess

Macro Parameter Types

The

The NewCollectAndProcess command will create a new document in the Collect and Process
mode. The command has 3 required parameters and 5 optional parameters. The format of the

command is as follows:

NewCollectAndProcess( DataToSave(...),
FramesToSave,
AutoFileNameFlag = False,
FileUpdateFrequency = 0,
FileUpdateFrequencyUnits =
AutomaticFileNameFrequenncyUnits_Frames,

FileNameCustomLetter= “ “,
AutoFileNameDirectory= “ ”);

Parameters are:

DataToSave: A Macro call specifying the types of data to save and their paths and
filenames for data generated by the program. See DataToSave

macro for details.

FramesToSave: An Enumeration value representing the condition for which data will
be saved to file. The condition selected applies to the data on a

frame-by-frame basis. Valid selections are:
FramesToSave_All - Save All
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AutoFileNameFlag:

FileUpdateFrequency:

FileUpdateFrequencyUnits:

FileNameCustomLetter:

AutoFileNameDirectory:

FramesToSave_AboveWarningAlarm - Save above Warning
Level

FramesToSave_AboveTriggerAlarm - Save above Trigger Level
FramesToSave_None - Save nothing

Boolean indicating whether automatic filenaming is activated. This
parameter is optional. Valid selections are:

True - Enable automatic filenaming.

False - Disable automatic filenaming.

The frequency at which the filenames will automatically be changed.
This parameter is optional. Valid selections are 1 - 999 units.

An Enumeration value representing the units for the frequency of
changing the filename. This parameter is optional. Valid selections
are:

AutomaticFileNameFrequencyUnits_Frames
AutomaticFileNameFrequencyUnits_Seconds

A String representing the user selectable custom letter for automatic
filenaming. This parameter is optional. Valid selections are: A-Z.

A String specifying the path and directory to store files generated by
the automatic filenaming capability ( e.g. “C:\RMM” ). This
parameter is optional.

NewCollectWithoutProcessing

Macro Parameter Types

The NewCollectWithoutProcessing command will create a new document in the Collect Without
Processing mode. The command has 2 required parameters and 5 optional parameters. The
format of the command is as follows:

NewCollectWithoutProcessing( DataToSave(...),

Parameters are:

DataToSave:
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FramesToSave,

AutoFileNameFlag = False,
FileUpdateFrequency = 0,
FileUpdateFrequencyUnits =
AutomaticFileNameFrequnencyUnits_Frames,

FileNameCustomLetter = *”,
AutoFileNameDirectory = “*);

A Macro call specifying the types of data to save and their paths and
filenames for data generated by the program. The only valid file
type for the NewCollectW ithoutProcessing command is an
Interferogram (DataToSave_lInterferogram type). See DataToSave
macro for details.



FramesToSave:

AutoFileNameFlag:

FileUpdateFrequency:

FileUpdateFrequencyUnits:

FileNameCustomLetter:

AutoFileNameDirectory:

An Enumeration value representing the condition for which data will

be saved to file. The condition selected applies to the data on a

frame-by-frame basis. Valid selections are:

FramesToSave_All - Save All

FramesToSave_AboveWarningAlarm - Save above Warning
Level

FramesToSave_AboveTriggerAlarm - Save above Trigger Level

FramesToSave_None - Save nothing

Boolean indicating whether automatic filenaming is activated. This
parameter is optional. Valid selections are:

True - Enable automatic filenaming.

False - Disable automatic filenaming.

The frequency at which the filenames will automatically be changed.
This parameter is optional. Valid selections are 1 - 999 units.

An Enumeration value representing the units for the frequency of
changing the filename. This parameter is optional. Valid selections
are:

AutomaticFileNameFrequencyUnits_Frames
AutomaticFileNameFrequencyUnits_Seconds

A String representing the user selectable custom letter for automatic
filenaming. This parameter is optional. Valid selections are: A-Z.

A String specifying the path and directory to store files generated by
the automatic filenaming capability ( e.g. “C:\RMM” ). This
parameter is optional.

NewProcessDataFromFile

Macro Parameter Types

The NewProcessDataFromFile command will create a new document in the Process Data from
File mode. The command has 3 required parameters. The format of the command is as follows:

NewProcessDataFromFile(SignalFileName,

Parameters are:

DataToSave(...),
FramesToSave );

SignalFileName: A String representing the path and filename of the Signal file in which the
input signal data will be read for processing.

DataToSave: A Macro call specifying the types of data to save and their paths and
flenames for data generated by the program. The only valid file type for
the NewCollectWithoutProcessing command is an Interferogram
(DataToSave_Interferogram type). See DataToSave macro for details.

FramesToSave: An Enumeration value representing the condition for which data will be
saved to file. The condition selected applies to the data on a frame-by-
frame basis. Valid selections are:
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FramesToSave_All - Save All

FramesToSave_AboveWarningAlarm - Save above Warning Level
FramesToSave_AboveTriggerAlarm - Save above Trigger Level
FramesToSave_None - Save nothing

Open

Macro Parameter Types

The Open command will create a new document for viewing file data. The command has 1
required parameter. The format of the command is as follows:

Open(FileName);

Parameters are:

FileName: A String representing the path and filename of the file to open.

OpenWindow

Macro Parameter Types

The OpenWindow command will open the window specified by the user. The command has one
parameters. The format of the command is as follows:

OpenWindow (WindowToOpen);
Parameters are:

WindowToOpen: A String representing the name of the window to open. Valid
selections are:

Concentrations
Concentrations Text
Concentration Averages
Concentration Rose
Concentration History
Concentration History Text
NEA Noise

Emission Rate

Absorbance Spectrum
Transmittance Spectrum
Signal Single Beam Spectrum
Background Single Beam Spectrum
Signal Interferogram
Background Interferogram
Arbitrary Spectrum

Status

Background Status
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Chemical Region Info

Chemical Setup

Concentration Averaging Setup
Adaptive Background Filtering Setup
Alignment

File Header

Positioner

LN2 Status

SetFileChangeSynchronizationTime

Macro Parameter Types

The SetFileChangeSynchronizationTime command provides the capability to specify the time to
which all automatically generated files will be synchronized. The program will use the time
provided from this command and the data from the FileUpdateFrequency field from the New
CollectandProcess or NewCollectWithoutProcess macro commands to determine when the
files should be automatically stopped and re-started with a new automatically generated
flename(s). This command is only valid when the Automatic File Naming option is enabled in the
NewCollectAndProcess or NewCollectW ithoutProcessing macro commands and the
FileUpdateFrequencyUnits is not AutomaticFileNameFrequencyUnits_Frames

The SetFileChangeSynchronizationTime command has one required parameters and has the
format:
SetFileChangeSynchronizationTime(SynchronizationTime);
Parameters are:
SynchronizationTime A String indicating the time to which the automatic flename processes

will be synchronized. The time entered is always referenced to the
current day. The time must be in the format:

HH:MM
Where:
HH - is the Hours in 24 hour (Military) time from
00 (12 Midnight) to 23 (11:00 PM).
MM - is the minutes from 00 to 59.
SetupAlgorithms

Macro Parameter Types

The SetupAlgorithms command allows you to select the algorithms and processing parameters
that are to be applied when processing Signal data. The command requires that chemicals
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selected for processing must be in a Signal Processing Information (SPI) file. The Command has

5 required parameters. The format of the command is as follows:

SetupAlgorithms(ComputeSingleBeam,
BackgroundFileName,
SpiFileName);

Parameters are:

ComputeSingleBeam:

BackgroundFileName:

SpiFileName:

A Boolean indicating whether a Single-Beam spectrum should be
computed regardless of the processing algorithms that have been
enabled. Valid selections are:

True - Enable computation of the Single-Beam spectrum.
False - Disable computation of the Single-Beam spectrum.

A String representing the path and filename of the background file to
be used in processing.

A String representing the path and filename of the Signal Processing
Information (SPI) file containing the chemicals that are to be
processed.

SetupConcentrationAveraging

Macro Parameter Types

The SetupConcentrationAveraging command will enable concentration averaging processing.
Each call to SetupConcentration Averaging sets the values for 1 Averaging Window. Since two
Averaging Windows are supported, the command can be called twice. The command has 8
required and 8 optional parameters. The Command has the following format:

SetupConcentrationAveraging(NumberOfintervals,

Parameters are:

NumberOfintervals:

142

AveragingType,

SaveToFile,

SaveFileName,

AveragingTimeSpan1,

AveragingTimeUnits1,

AverageStartTime1,

AverageEndTime1,

AveragingTimeSpan2 =0,

AveragingTimeUnits2 = ConcetrationAveragingUnits_Minutes,
AverageStartTime2 = ConcentrationAveragingTime_00_00,

AverageEndTime2 = ConcentrationAveragingTime_00_00,

AveragingTimeSpan3 =0,

AveragingTimeUnits3 = ConcetrationAveragingUnits_Minutes,
AverageStartTime3 = ConcentrationAveragingTime_00_00,

AverageEndTime3 = ConcentrationAveragingTime_00_00 );

An Integer representing the number of Averaging Intervals stored in
the command. Valid numbers are 0-3.



AveragingType:

SaveToFile:

SaveFileName:

AveragingTimeSpan:

AveragingTimeUnits:

AverageStartTime:

AverageEndTime:

SetupFtir

Macro Parameter Types

An Enumeration indicating the type of averaging to perform. Valid
selections are:

ConcentrationAveragingWindowType_Interval
ConcentrationAveragingWindowType_Continuous

A Boolean indicating whether to save the data to file.
True - Save concentration averages to file.
False - No data is to be saved to file.

A String representing the path and filename of the file into which
concentration averages will be saved. If automatic file naming has
been enabled for the document, this parameter is ignored since a file
name will be generated.

An Integer indicating the time span to perform an average. Valid
selections are dependent upon the units selected. For the units type
Minutes, 5 - 55 minutes with 5-minute increments are valid. For the
unit type Hours, 1 - 24 hours with 1-hour increments are valid.

An Enumeration indicating the units of the averaging time. Valid
selections are:

ConcentrationAveragingUnits_Minutes
ConcentrationAveragingUnits_Hours

An Enumeration indicating the time that Averaging should begin. This
value is only used in Interval Averaging. The enumeral takes the form:

ConcentrationAveragingTime_hh_mm
where:
hh - can be from 00 to 23.

mm - can be either 00 or 30.

An Enumeration indicating the time Averaging should end. This value
is only used in Interval Averaging. The enumeral takes the form:

ConcentrationAveragingTime_hh_mm
where:

hh - can be from 00 to 23.
mm - can be either 00 or 30.

The SetupFtir command provides the capability to set the FTIR configuration commands. The
command has eleven required parameters. The format of the command is as follows:

SetupFtir(CoadditionCount,
Datalnterval,
PathLength,
FtirMode,
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CollectionResolutionCode,
EnableAutomaticStop,
StopAfterCount,
EnableAutomaticGain,

Gain,
Memo,

EnableAlignmentMode);

Parameters are:
CoadditionCount:

Datalnterval:

PathLength:

FtirMode:

CollectionResolution:

EnableAutomaticStop:

StopAfterCount:

EnableAutomaticGain:

Gain:
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An Integer value indicating the number of raw scans to Co-add.

An Integer value indicating the length of time between collections in
seconds.

An Integer value indicating the round trip path from the FTIR to the
Retroreflector in Meters.

An Integer value indicating the mode of the FTIR. Valid selections
are:

0 - Passive Mode

1 - Active Mode

An Enumeration indicating the resolution to process the signal data.
Valid selections are:

HalfWaveNumber - 0.5 wavenumber
OneWaveNumber - 1.0 wavenumber
TwoWaveNumber - 2.0 wavenumber
FourWaveNumber - 4.0 wavenumber
EightWaveNumber - 8.0 wavenumber
SixteenWaveNumber - 16.0 wavenumber
ThirtyTwoWaveNumber - 32.0 wavenumber

A Boolean flag indicating whether a stop condition has been specified
in the next parameter. Valid selections are:

True - To specify a stop condition

False - If you are not specifying a stop condition.

An Integer indicating the number of interferograms to collect prior to
terminating collection.

A Boolean indicating whether the program should automatically
calculate the gain settings. Valid selections are:

True - To enable automatic gain control

False - To disable it automatic gain control.

An Integer value representing the gain setting for the FTIR if automatic
gain control is not enabled. Valid selections are:

1 - 1X gain
2 - 2X gain
4 - 4X gain
8 - 8Xgain

16 - 16X gain
32 - 32X gain
64 - 64X gain
128 - 128X gain



Memo:

EnableAlignmentMode:

SetupSite

Macro Parameter Types

A String containing a line of text that can be stored into the Signal file
for reference. Maximum number of characters that can be stored is
64. Characters must be enclosed by double quotes.

A Boolean indicating whether the data should be calculated in
Alignment mode instead of Normal mode.

True - Setthe FTIR into Alignment mode.

False - Setthe FTIR in Normal mode.

The SetupSite command provides the capability to set the Site configuration commands. The
command has 13 required and 5 optional parameters. The format of the command is as follows:

SetupSite(Retro Location
Location,

City,
State,

Country,

Pressure,

Humidity,

PrecipCode,

Temperature,

WindDirection,

WindSpeed,

OperatorName,
SensorDirection,
CollectWeatherData = False,

UsePositioner

= False,

DestinationAzimuth = 0.0,
DestinationElevation = 0.0

UseLN2Controller

Parameters are:
Retro Location:
Location:

City:

State:

Country:
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= False);

A String representing the name that best describes the location of the
retroreflector where data is being taken. Up to 19 characters can be
entered.

A String representing the name of the site where data is being taken. Up
to 19 characters can be entered.

A String representing the Name of the city at which data is to be taken.
Up to 16 characters .

A String representing the name of the state at which data is to be taken.
Up to a 2-character state abbreviation can be entered.

A String representing the name of the country at which data is to be
taken. Up to a 3-character country abbreviation can be entered.



Pressure:

Humidity:

PrecipCode:

Temperature:
WindDirection:
WindSpeed:

OperatorName:

SensorDirection:

CollectWeatherData:

UsePositioner:

DestinationAzimuth:

DestinationElevation:

UseLN2Controller:
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An Integer indicating the Barometric pressure in HectoPascals
(equivalent to MilliBars).

An Integer indicating the relative humidity as a percent of total saturation.

An Integer indicating the precipitation. Valid selections are:
- No Precipitation
- Light rain

- Moderate rain

- Heavy rain

- Light fog

- Moderate fog

- Heavy fog

- Light snow

- Moderate snow
- Heavy snow

O©oO~NOOOTWN-O0

An Integer indicating the temperature in degrees Kelvin.
An Integer indicating the Wind Direction in degrees.
An Integer indicating the Wind speed in Miles per Hour.

A String representing the name of the user of the system. You can enter
up to 9 characters.

An Integer indicating the bearing that the FTIR is pointing to in integer
degrees from North.

A Boolean indicating whether the RAM 2000 weather station should be
used to collect weather data. This is an optional parameter. If enabled
the parameters Pressure, Humidity, PrecipCode, Temperature,
WindDirection, and WindSpeed are ignored. Valid values are:
True - Enable collection of weather data from the weather station.
False - Disable collection of weather data from the weather station.

A Boolean indicating whether the RAM 2000 positioner system should be
used to direct the FTIR to a retroreflector. If enabled the value of the
parameter SensorDirection is ignored. This is an optional parameter.
Valid values are:

True - Enable controlling the FTIR via the positioner system.

False - Disable controlling the FTIR via the positioner system.

A Float indicating the azimuth (bearing) angle from North to the
retroreflector. This is an optional parameter.

A Float indicating the elevation angle from the Positioner's Zero elevation
marker to the retroreflector. This is an optional parameter.

A Boolean indicating whether the RAM 2000 Liquid Nitrogen controller
system should be used to refill the RAM 2000 FTIR dewar.



Start

The Start command begins execution of the program in the mode specified previously via either
the NewCollectAndProcess, NewCollectWithoutProcess or NewProcessFromFile commands.
The Start command has no parameters and has the format:

Start( );

TruncateSavedData
Macro Parameter Types
The TruncateSavedData command allows the user to specify the frequency regions to truncate all
spectra to prior to saving to file. The command has 2 required parameters and has the format:

TruncateSavedData(StartFrequency,
StopFrequency );

Parameters are:

StartFrequency A Float indicating the starting frequency of the data to save.
StopFrequency A Float indicating the ending frequency of the data to save.
Wait

The Wait command delays execution of subsequent macro commands until such time as
processing of the current document completes. The Wait command has no parameters and has
the format:

Wait( );

Macro Examples

Two Position Collection Macro Example

The following is an example of a macro file that will:

1. Collect and process data from 2 retroreflectors with a single FTIR using the positioner
system.

2. Collect Weather data while processing.

3. Perform concentration averaging for both documents (using both averaging windows).

Il
/I Two position collect and process macro with weather data collection.
1

1
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/I *** Document Number 1 - BallPark Retroreflector leg ***

Il
Il
/I Create a document for the BallPark retro reflector.
Il
NewCollectAndProcess (
DataToSave(DataToSave_Interferogram, /I Save Interferograms
/I Null since using automatic file naming
DataToSave_Results, /I Save Results
"), /I Null since using automatic file naming
FramesToSave_All, /I File save option
True, /I Enable automatic file naming
86400, /I Automatic file name change

/I frequency (once a day)
AutomaticFileNameFrequencyUnits_Seconds, // Automatic file name change
/I frequency units

"B", /I Automatic file name custom letter
"C:\RMM\BALLPARK"); /I Automatic file name directory
Il
/I Synchronize files to 12:00 Noon.
I

SetFileNameSynchronizationTime(“12:00”);

Il

/I Set up the FTIR for the BallPark document.

Il

SetupFtir (160, /I Number of scans to coadd

0, /I Collection start interval
500, /I Round trip path length (meters)
0, /I FTIR mode
HalfWaveNumber, /I Collection resolution
False, /I Disable automatic stop
0, /I Stop after count
True, /I Enable automatic gain
0, /I Manual gain value
"BallPark", /I Interferogram file memo
False); /I Disable alignment mode

Il

/I Set up the site information for the BallPark document.

Il

SetupSite (“BallPark Retro” /I Retro location name

"Any Where", /Il Location
"Your Town", /I City
"NY", /I State
"USA", /I Country
0.0, /I Barometric pressure ( 0 since we will use )
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0, /I Humidity ( the weather station ).
0, /I Precipitation code
0, /I Temperature
0, /l Wind direction
0, /I Wind speed
"Operator", /I Operator's name
0, /I Fixed sensor direction (0 since we will )
True, /I Collect weather data (use the positioner)
True, /I Use positioner
-70.258, /I Destination azimuth (Ballpark Retro)
0.008); /I Destination elevation
Il
/I Set up signal processing algorithms for the BallPark document.
Il
SetupAlgorithms (
True, /I Signal single beam requested
"C\RMM\BALLPARK\597BP.bgd", // Background file
"C:\RMM\NALLPARK\BP.SPI"); /I Signal processing info file
Il
/I Set up concentration averaging for the BallPark document.
Il
SetupConcentrationAveraging (
1, /I Number of averaging intervals
ConcentrationAveragingWindowType_Continuous, /I Concentration averaging type
True, /I Save averaging data to file
"FILE1", /I Save file path (ignored, automatic)
15, /I Averaging interval time
ConcentrationAveragingUnits_Minutes, /I Averaging interval units
ConcentrationAveragingTime_00_00, /I Interval start time (not used )
/I ( for continuous averaging)
ConcentrationAveragingTime_00_00); /I Interval end time (not used )

/I ( for continuous averaging)

SetupConcentrationAveraging (

1, /I Number of averaging intervals
ConcentrationAveragingWindowType_Continuous, /I Concentration averaging type
True, /I Save averaging data to file
"FILE2", /I Save file path (ignored, automatic)
24, /I Averaging interval time
ConcentrationAveragingUnits_Hours, /I Averaging interval units
ConcentrationAveragingTime_00_00, /I 'Interval start time (not used )

/I ( for continuous averaging)
ConcentrationAveragingTime_00_00); /I Interval end time (not used )

/I ( for continuous averaging)

1

*kk

/I *** Document Number 2 - School Retroreflector leg

1
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1

/I Create a document for the School retro reflector.

1

NewCollectAndProcess (

1

/I Synchronize files to 12:00 Noon.

1

1

/I Set up the FTIR for the School document.

1

1

DataToSave(DataToSave_Absorbance,

DataToSave_Results,

"),

FramesToSave_All,

/I Save Absorbances

/I Null since using automatic file naming
/I Save Results

/I Null since using automatic file naming

/I File save option

True, /I Enable automatic file naming

86400, /I Automatic file name change
/I frequency (once a day)

AutomaticFileNameFrequencyUnits_Seconds, /I Automatic file name change
/I frequency units

"S", /I Automatic file name custom letter

"C\RMM\SCHOOL”);

/I Automatic file name directory

SetFileNameSynchronizationTime(“12:00”);

SetupFtir (160,
0,
215,
0,
HalfWaveNumber,
False,
0,
True,
0,
"School",
False);

/I Number of scans to coadd
/I Collection start interval

/I Round trip path length (meters)
/I FTIR mode

/I Collection resolution

/I Disable automatic stop

/I Stop after count

/Il Enable automatic gain

/I Manual gain value

/I Interferogram file memo

/I Disable alignment mode

/I Set up the site information for the School document.

1

SetupSite (“School Yard Retro”
"Any Where",
"Your Town",
"NY",
"USA",
0.0,
0,
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/I School Yard Retro Name
/I Location

/I City

/I State

/I Country

/I Barometric pressure ( 0 since we will use)

/I Humidity (weather station )



cocoo

perator",
0,
True,
True,
52.453,
0.097);

1

/I Precipitation code

/I Temperature

/I Wind direction

/I Wind speed

/I Operator's name

/I Fixed sensor direction (0 since we will )
/I Collect weather data  ( use the positioner)
/I Use positioner

/I Destination azimuth

/I Destination elevation

/I Set up signal processing algorithms for the warehouse document.

1

SetupAlgorithms (
True,
"C:\RMM\SCHOOL\School.bgd",
"CARMM\SCHOOL\School.SPI");

/I Signal single beam requested
/I Background file
/I Signal processing info file

Il
/I Set up concentration averaging for the School document.
Il

Il

/I Concentration Averaging Window 1

I

SetupConcentrationAveraging (
1,

/I Number of averaging intervals

ConcentrationAveragingWindowType_Continuous, // Concentration averaging type

True,

"FILE3",

15,
ConcentrationAveragingUnits_Minutes,
ConcentrationAveragingTime_00_00,

ConcentrationAveragingTime_00_00);

I

/I Save averaging data to file
/I Save file path (ignored )

/I Averaging interval time

/I Averaging interval units

/I Interval start time (not used
/I for continuous averaging)
/I Interval end time (not used
/I for continuous averaging)

/I Concentration Averaging Window 2
I

SetupConcentrationAveraging (
1,

/I Number of averaging intervals

ConcentrationAveragingWindowType_Continuous, // Concentration averaging type

True,

"FILE4",

24,
ConcentrationAveragingUnits_Hours,
ConcentrationAveragingTime_00_00,

ConcentrationAveragingTime_00_00);
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/I Save averaging data to file
/I Save file path (ignored)

/I Averaging interval time

/I Averaging interval units

/I Interval start time (not used
/I for continuous averaging)
/I Interval end time (not used
/I for continuous averaging)



Il
/I Start collecting and processing.
Il

Start ();

ArrangeAllDocumentsWindows();

Other Dialogs

Ambiguous Time Zone Dialog
The ambiguous time zone dialog is displayed when, during a Daily, Weekly, Monthly Summary,
multiple results files are used and the results files contain data from more than one time zone.

The dialog shows each results file selected and the corresponding time zone for that results file.
Select the time zone to use for the summary from the combo box.

Ambiguous Time Zone

The zelected files contain data from different bime zones:

aai

R ezulks File | Time Lone -

C:ARkb SafthTesth TimedoneEazternDaylightTo...  [GMT-05:00] Eastern Time [US & Canada) Cancel
C:ABkdbd Safth Testh Times onetE azternDaylightwit...  [GMT-05:00] Eastern Time [US & Canada)
CARMMSoftsTesth TimeZoneE astermStandardyy...  [GMT-05:00] Eastern Time [US & Canada) Help
CARMMSoftsTesth Timeone\E asternStandardT...  [GMT-05:00] Eastern Time [US & Canada) .

C:5Rkb Safth T esth T imes oneE aztern.rit G T-05:00] Eastern Time [US & Canada)

CARMMSoftsTesth TimeZoneHawai With TziFr...  Unknown Time Zone

ARk Safth T esth T imes oneHawai 'with Tzirk (G T-10:00) Hawaii

CARMMSofts T esth TimeZonetH awaiia rlt [GMT-05:00] Eaztern Time [US & Canada]
E:I'xHMMSu:nft'xTest'\TimeZn:nne'xlsrael With Tzirlk [GMT+02:00] [zrael | _|;|

4 ]

Select the time zone to uze for the summan:

[GMT-05:00] Eaztemn Time [US &

File Selection Dialog

Dialog Options

File Name

Select the desired file from the File Name listbox. You may also type the path and filename
directly into the edit control.

List Files of Type

Select the file type (by filename extension) from the drop down list. Only files of the selected type

will be shown in the File Name listbox.

Directories

152



Select the directory that you require by clicking on the appropriate folder. The directory and path
selected will be listed above the Directory listbox.

Drives
Select the drive that contains the reference file.

Future Scan Time Warning Dialog

The Future Scan Time Warning dialog is displayed when a file is opened that contains a scan time
that is in the future. Such a time is an indication of a possibly corrupted file. Sometimes the
warning is displayed for files that originated from other systems and/or software applications. The
warning can be ignored and the file can be used normally if desired.

Dialog Options

Never show this warning again for any document

To suppress all future scan time warnings for all documents check this check box. Once checked
and OK is clicked, the warning dialog will never be displayed. To enable the future scan time
warnings again uncheck the Options —» Suppress Future Scan Time Warnings menu item.

System Diagnostics and Alarms

System Diagnostics and Alarms Overview

The RAM 2000 system provides a comprehensive set of diagnostics and alarms to aid in the use
of the system. The Diagnostics and alarms cover everything from the FTIR to the Computer
System. Diagnostics and alarms can be manually adjusted to fit the requirements of your site.

System Diagnostics

The RAM 2000 System monitors the performance of the system and provides positive indications
of the system status. System diagnostics include:

Data Quality Indicator

The Data Quality Indicator graphically displays to the user the condition of the data being obtained
from the FTIR and, indirectly, that of the FTIR itself. The Data Quality Indicator is located on the
Status View. The Data Quality Indicator test consists of:

NEA Noise Measurement

The Noise Equivalent Absorbance (NEA) Noise Measurement measures the amount of
system noise that is present in a quiescent areas of the infrared spectrum and automatically
evaluates the performance of the system.
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Hardware Status Indicators

The Hardware Status Indicators graphically displays to the user the condition of hardware
components of the system. The status of the Meteorological Station, Positioner System and the
LN2 Refill system are displayed on the Status Bar. The panes on the status bar indicate the
following data items:

Pane Number Used for
1 Indicates the current state of commands for the system. When the program
is waiting for commands, this pane will state “Ready”.

2 User messages.

3 Provides a Red, Yellow, Green indication of the status of the LN2 Refill
system. Moving the mouse over the pane will cause a Pop-Up window to be
displayed that will provide textual information on the hardware status.

4 Provides a Red, Yellow, Green indication of the status of the Positioner
system. Moving the mouse over the pane will cause a Pop-Up window to be
displayed that will provide textual information on the hardware status.

5 Provides a Red, Yellow, Green indication of the status of the Weather
Station. Moving the mouse over the pane will cause a Pop-Up window to be
displayed that will provide textual information on the hardware status

When in Remote Viewer mode viewing multiple RAM 2000 systems panes 3 - 5 will display the
highest hardware alarm status of all systems being viewed. The system also provides Hardware
pop-up displays to provide more detailed information on the hardware components of the system.

The LN2 Refill Status Pop-up displays information concerning the status of the LN2 refill system.
The Pop-up displays the state of the LN2 refill system and, if a fault has occurred, the condition
causing the fault. The LN2 Status pop-up can be displayed by placing the cursor over the Status
bar pane for the LN2 status.

The Positioner Status Pop-up displays information concerning the status of the Positioner system.
The Pop-up displays the state of the Positioner system and, if a fault has occurred, the condition
causing the fault. The Positioner Status pop-up can be displayed by placing the cursor over the
Status bar pane for the Positioner status.

The Weather Station Status Pop-up displays information concerning the status of the Weather
Station system. The Pop-up displays the state of the Weather Station system and, if a fault has
occurred, the condition causing the fault. The Weather Station Status pop-up can be displayed by
placing the cursor over the Status bar pane for the Weather Station status.

FTIR Scan indicator

The FTIR has an external scan indicator that indicates the condition of the FTIR moving mirror.

Gas Calibration

154



The RAM 2000 system provides the user with a 15cm Gas Cell in the beampath to allow the
accurate measurement of a gas at a known concentration. By comparing the known
concentration of the gas being flowed into the gas cell to the value computed by the RMMSoft
program, the user can validate the accuracy of the gases being measured in the atmosphere.

Log File

The RAM 2000 system provides the capability to store all system messages to a Log file. This log
file provides a complete picture of events that have occurred, allowing the user to review events
that have occurred.

Discard Files

Interferograms that are obtained through the FTIR are subject to a number of data validity
checks by the RMMSoft program. The program automatically discards interferograms that do
not pass the data validity checks. The RAM 2000 system provides the capability to store
Interferograms that it has rejected for processing due to them being deemed to be poor into a
Discard file . The system also provides the specific reason for rejection in a Discard Reason
Files . These files can then be used to determine the cause and corrective action required to
improve system performance.

System Alarms

The RAM 2000 System provides a comprehensive set of alarms to ensure the user is alerted
quickly to system situations. Alarms include both visual and audible alarms. For many of the
alarms, the user can disable the audible, visual or both alarm indications. System Alarms Include:

Beam Block

The RAM 2000 system monitors the returned IR power from the retroreflector. If the power drops
too low due to an obstruction, the system will display a Beam Block alarm. The Beam Block alarm
is both a visual and audible alarm. The Beam Block alarm will indicate to the user the
retroreflector that is being blocked. The Beam Block alarm is self-clearing when the beam block
has been removed.

Detected Chemicals

The Detected Chemicals alarm occurs whenever a chemical is found to be above its Minimum
Detection Level. The Detected Chemicals alarm is both an audible and visual alarm. The audible
alarm consists of a short system beep.

Chemical Concentration Above Warning Level

The Chemical Concentration Above Warning Level alarm occurs whenever a chemical is found to

be above its user entered Warning Level. The Detected Chemicals alarm is both an audible and
visual alarm. The audible alarm consists of a moderate length system beep.
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Chemical Concentration Above Trigger Level

The Chemical Concentration Above Trigger Level alarm occurs whenever a chemical is found to
be above its user entered Trigger Level. The Detected Chemicals alarm is both an audible and
visual alarm. The audible alarm consists of a long system beep.

Disk Drive Space Low

The Disk Drive Space Low alarm occurs whenever the free space on the disk drive that contains
the RAM 2000 data falls below 10%. The Disk Drive Space Low alarm is both an audible and
visual alarm. The audible alarm consists of a long system beep.

Disk Drive Full

The Disk Drive Full alarm occurs whenever there is not enough disk space to write RAM 2000
data. The Disk Drive Full alarm is both an audible and visual alarm. The audible alarm consists of

a long system beep. When the Disk Drive Full alarm occurs, RAM 2000 operations will continue
unaffected except for that saving of data, which will be suspended until disk space is available.

Troubleshooting

Troubleshooting

This section discusses various common problems encountered when using RMMSoft, why they
occur and how they may be corrected.

Concentration Values Are Zero

Symptom

All concentration values on all displays show a value of 0.0.
Discussion

The most common reason for all concentration values to be displayed as zero is that the
Concentration Units selection that is in effect uses the path length to divide the path averaged
concentration. If the path length is zero then all concentration values are displayed as zero.

Resolution(s)

e Set the path length for the data being viewed to the correct value using the Edit — Processing
Source Parameters menu item to display the property sheet containing the Non-Spectral
Parameters Dialog dialog, select the Non Spectral tab and enter the round trip path length.

e Change the concentration units using the View — Concentration Units menu item to either
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PPM*Meters or PPB*Meters. These concentration units do not use the path length.
e For future collections, make sure to set the round trip path length on the FTIR Setup dialog.

Technical Support

Technical Support

If you have a problem that you can not resolve with the use of the system documentation, you can
call AIL Systems for technical support at 1-800-264-7477. Please indicate that your question is in
regard to the RAM 2000 system.
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